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About this information product

...............................................................................................................................................................................................................................................................

Purpose This document contains all WaveStar™ DACS 4/4/1 post-installation
provisioning procedures.

What you need to know

You should have a basic understanding of Synchronous Digital
Hierarchy (SDH) signalling before you attempt to use any of the
procedures in this guide.

Reason for reissue The following new features were added in Release 3.0 of WaveStar
DACS 4/4/1:

• Sub-Network Connection Protection (SNCP)

• Performance monitoring for lower order paths

The following new features were added in Release 3.1 of WaveStar
DACS 4/4/1:

• Data Communication Network (DCN) and Data Communication
Channel (DCC) features. These were not available in Release 3.0,
and the new information only applies to Release 3.1.

Safety labels Some tasks contain an admonishment symbol. This symbol is used to
draw attention to important information about the task. The symbol
appears in the following form:

....................................................................................................................................................................................................................................
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CAUTION
Indicates a hazard that will or can cause minor personal
injury or property damage if not avoided.

Intended audience The following is a list of customers who will use this guide:

• Equipment engineers, including outside plant engineers

• Installation, operation, and maintenance personnel

• Switching office personnel

• System administrators

• Technical support personnel

• Training personnel

The following is a list of Lucent Technologies personnel who will use
this guide:

• Developers

• System engineers

• System testers

• Sales support personnel

• Installation and engineering personnel

• Technical Support Organization

• Training personnel

Conventions used The following conventions are used in this guide:

• Keys that you press are shown as ENTER.

• Text that is displayed on the screen is shown as
Unit provisioned and initialised.

• Text that you enter is shown as pboot 0 0.

• Punctuation (such as periods and commas) are omitted when the
user could mistake them as input. For example; Press ENTER

• Braces {} specify a range of possible entries, such as PSA-{4–11,
4–19}.

• Words that require emphasis are shown as emphasis.

Related documentation The WaveStar DACS 4/4/1 set of documents includes the following:

Provisioning guide About this information product
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Document title Ordering number

WaveStar DACS 4/4/1
Application and Planning Guide

365-367-500

WaveStar DACS 4/4/1
Maintenance Guide

365-367-513

WaveStar DACS 4/4/1 Quick
Reference Card

365-367-503

Integrated Transport Management
Sub-network Controller
(ITM-SC) Sub-network
Provisioning Guide (SPG) for
WaveStar DACS 4/4/1

190–223–151

Related training Lucent Technologies provides the following WaveStar DACS 4/4/1
training courses:

• DG3404 — Overview

• TR3562 — Administration, Provisioning, and Maintenance

For up-to-date training information, see http://www.lucent-product-
training.com/SabaWeb.

How to order The ordering number for this document is 365-367-512.

If you order by mail, address your request to:

Lucent Technologies Customer Information Center

Attention: Order Entry Section

2855 N. Franklin Road

P.O. Box 19901

Indianapolis, Indiana, U.S.A. 46219

If you order by phone from the United States, call:

1-888-582-3688

FAX: +1-800-566-9568

If you order by phone from outside the United States, call:

+1-317-322-6416

FAX: +1-317-322-6699

A check, money order, purchase order number, or charge number
VISA bank card, American Express card services, or MasterCard bank
card is required with all orders. Make checks payable to Lucent
Technologies.
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1 Product description

Overview
....................................................................................................................................................................................................................................

Purpose “Product description” provides a high-level description of the
WaveStar™ DACS 4/4/1.

Organisation “Product description” is organised as follows:

• “System description” (1-2)

• “Equipment description” (1-10)
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System description

Overview
....................................................................................................................................................................................................................................

Purpose This section provides a high-level description of the system.

Organisation This section is organised as follows:

• “System description” (1-3)

• “System capacity” (1-5)

• “Control system” (1-6)

• “System interfaces” (1-8)

• “Synchronisation and timing” (1-9)

Product description
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System description
....................................................................................................................................................................................................................................

Functional description The system is a large-capacity cross-connect system that provides
flexible bandwidth management in a Synchronous Digital Hierarchy
(SDH) environment. The system can be equipped with various
transmission interfaces, and supports cross connections at broadband
and wideband rates.

The system has a nonblocking, full-broadcast cross-connect matrix.
The cross-connect matrix is compatible with both American National
Standards Institute (ANSI) and International Telecommunications
Union (ITU) transmission standards and is capable of cross connecting
all tributaries defined by them.

The cross-connect matrix and all internal transmission paths are fully
protected by a 2:8 protection architecture. This architecture provides
triple protection, resulting in very high availability. High availability is
important, because a large cross-connect system carries an immense
amount of traffic.

System description Product description
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The following illustration shows a block diagram of the system.
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System capacity
....................................................................................................................................................................................................................................

Available system
configurations

The system can be configured for a maximum capacity of either 256
STM-1 equivalents or 512 STM-1 equivalents. The system capacity
determines the number of port subracks that can be provisioned.

Differences between 256
and 512 systems

The differences between 256 and 512 STM-1 equivalent systems are
as follows:

• A 256 STM-1 equivalent system can have a maximum of eight
port subracks.

• A 512 STM-1 equivalent system can have a maximum of 16 port
subracks.

Displaying the maximum
system capacity

To display the maximum system capacity, go to Help > About....

System description Product description
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Control system
....................................................................................................................................................................................................................................

Overview System coordination and control is carried out by the Main Controller,
the subrack controllers, and the board controllers.

Illustration The following illustration shows a block diagram of the control
structure.

Main Controller The Main Controller (MC) provides local and remote interfaces for
operations, administration, maintenance, and provisioning. The MC
accepts commands from these interfaces and translates them into
equipment level instructions that are sent to the subrack controllers.

New software releases can be loaded onto the MC without
interrupting service.

A duplicated MC is available. The primary purpose of a duplicated
MC is to increase system availability. The second (standby) MC takes
control of the system if the active MC fails.

Subrack controllers Subrack controllers route messages to and from the Main Controller
and the board controllers.

Main Control LAN

Main Controller

Operation,
Administration,
Maintenance,
& Provisioning

Interface

Subrack
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Matrix
and

Sync.
Subrack

Subrack
Controller

Port
Subrack

Subrack
Controller

Port
Subrack

Subrack
Controller

Port
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Board controllers Board controllers perform control processing for most types of units.
Functions performed by board controllers include executing
commands received from subrack controllers and sending maintenance
or performance data to subrack controllers.

System description
Control system
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System interfaces
....................................................................................................................................................................................................................................

Network interfaces This release provides the following Synchronous Digital Hierarchy
(SDH) network interfaces:

• STM-16 long-haul optical designed to ITU specifications

• STM-4 short-haul optical designed to ITU specifications

• STM-1 long-haul optical designed to ITU specifications

• STM-1 short-haul optical designed to ITU specifications

• STM-1 short-haul optical designed to Nippon Telegraph and
Telephone (NTT) specifications

• STM-1 electrical

1:8 equipment protection is available for STM-1 electrical interfaces.
1+1 Multiplex Section Protection (MSP) and Sub-Network Connection
Protection (SNCP) are available for all transmission interfaces.

OAM&P interfaces Operations, Administration, Maintenance, and Provisioning (OAM&P)
activities can be performed locally from a PC with XC-CIT
application software, from a remote V.28 dial-up connection, or from
a remote network or element management system. All OAM&P
connections use Transmission Control Protocol/Internet Protocol
(TCP/IP).

System description Product description
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Synchronisation and timing
....................................................................................................................................................................................................................................

Synchronisation and
timing capabilities

The system has duplicated synchronisation and timing hardware that
provides the following capabilities:

• The System Timing Unit (STU) has an ITU G.812 Type I clock
with holdover mode.

• System clock input references can be derived from transmission
ports, including ports that are provisioned for MSP or SNCP, or
from external references (station clock inputs).

• External references can be derived from 2048 kHz inputs or from
64 kHz composite clock inputs.

• Reference source and timing mode selection are based on
user-assigned priorities.

• System timing is distributed to transmission hardware within the
system.

• Each STU has a 2048 kHz station clock output port that can be
used as a timing source for other equipment.

• When no faults are present, user-initiated protection switching of
the synchronisation and timing hardware is glitchless.

System description Product description
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Equipment description

Overview
....................................................................................................................................................................................................................................

Purpose This section describes the system racks, subracks, and units.

Organisation This section is organised as follows:

• “Equipment terms” (1-11)

• “Matrix and Synchronisation rack” (1-12)

• “Matrix and Synchronisation subrack” (1-13)

• “Bit Slice Switch Unit (BSSU)” (1-15)

• “Matrix and Control rack” (1-16)

• “Main Controller subrack” (1-17)

• “User Panel” (1-20)

• “Alarm Connector Panel (ACP)” (1-22)

• “Fan Connector Panel (FCP)” (1-25)

• “Port rack” (1-27)

• “Port Subrack A (PSA)” (1-28)

• “Port Subrack C (PSC)” (1-30)

• “Port rack fan tray connector panel” (1-32)

Product description
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Equipment terms
....................................................................................................................................................................................................................................

List of terms Rack A rack is a mechanical assembly that houses the system
equipment. A rack can be equipped with one or two subracks. All
racks conform to European Telecommunications Standards
Institute (ETSI) equipment practices for transmission products.

Subrack A subrack is a mechanical assembly that houses plug-in
units, also referred to as circuit packs. All subracks conform to
ETSI equipment practices for transmission products. All subracks
have a midplane that interconnects the units in the subrack and
partitions the subrack into front and rear sections. A unit plugs
into either the front or the back of a subrack.

Unit A unit contains the circuitry for the system. It plugs into
either the front or the back of a subrack. A unit is also called a
plug-in, a circuit pack, or a pack.

Equipment description Product description
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Matrix and Synchronisation rack
....................................................................................................................................................................................................................................

Description The Matrix and Synchronisation rack is an ETSI standard rack that
houses the Matrix and Synchronisation subrack and five Bit Slice
Switch Units (cross-connect matrix components).

Illustration The following illustration shows a front view of the Matrix and
Synchronisation rack with the doors removed.

Legend:

1. Matrix and Synchronisation subrack with duplicated Matrix
Control and Synchronisation hardware

2. Bit Slice Switch Units (BSSUs)

1

2

Equipment description Product description
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Matrix and Synchronisation subrack
....................................................................................................................................................................................................................................

Description The Matrix and Synchronisation subrack has two shelves with front
and rear sections that are partitioned for plug-in units (circuit packs).
Each shelf is equipped with the same set of matrix control and
synchronisation and timing hardware. The units plug into a midplane
that separates the front and rear sections and provides the
interconnections between units.

Illustration, front view The following illustration shows a front view of the Matrix and
Synchronisation subrack.

Units, front of subrack The following units plug into the front of the Matrix and
Synchronisation subrack:

• The System Timing Unit (STU) provides system timing and
synchronisation.

• The Bit Slice Controller (BSC) works with the STU to provide
timing signals for internal transmission paths. The BSC also
provides control information for the Bit Slice Switch Units
(BSSUs).

• The Subrack Controller (SRC) routes messages back and forth
from the Main Controller to the units in the Matrix and
Synchronisation subrack.
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Illustration, rear view The following illustration shows a rear view of the Matrix and
Synchronisation subrack.

Units, back of subrack The following units plug into the back of the Matrix and
Synchronisation subrack:

• The Power Terminal Module (PTM) filters incoming station
power from two separate power sources and distributes it across
the midplane.

• The Optical Link Unit (OLU) is part of the internal transmission
path. It provides interfaces for the optical-fibre cables that carry
transmission data between the BSCs and the BSSUs. The OLU
also provides interfaces for the optical-fibre cables that carry
timing information between the duplicated BSCs in the Matrix
and Synchronisation subrack.
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Bit Slice Switch Unit (BSSU)
....................................................................................................................................................................................................................................

Description The Bit Slice Switch Units (BSSUs) are cross-connect matrix
components. The system has ten BSSUs. Five BSSUs are located in
the bottom of the Matrix and Synchronisation rack, and five BSSUs
are located in the bottom of the Matrix and Control rack.

Equipment description Product description
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Matrix and Control rack
....................................................................................................................................................................................................................................

Description The Matrix and Control rack is an ETSI standard rack that houses the
Main Controller subrack, User Panel, and five BSSUs (cross-connect
matrix components).

Illustration The following illustration shows a front view of the Matrix and
Control rack with the doors removed.

Legend:

1. Main Controller (MC) subrack with a duplicated Main Controller

2. User Panel

3. Bit Slice Switch Units (BSSUs)
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Main Controller subrack
....................................................................................................................................................................................................................................

Description The Main Controller (MC) subrack has a card cage, a fan tray, and a
power supply. The card cage has front and rear sections that are
partitioned for plug-in units and transition modules. The units and
transition modules plug into a midplane that separates the front and
rear sections of the card cage and provides the interconnections
between units and transition modules.

A duplicated MC is available. When the MC is duplicated, the system
automatically switches to the standby MC if the active MC fails.

Illustration, front view The following illustration shows a front view of the Main Controller
subrack with a duplicated MC.

Legend:

1. Power button for the working MC

2. Working MC

3. Power button for the protection MC

4. Magneto Optical (MO) disk drive

5. Protection MC (shaded area)

6. Fan tray

7. Power supply
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Units, front of subrack The following units plug into the front of the Main Controller
subrack:

• The Main Processor Unit (MPU) provides the central processing
function, which includes control of the ARU, LHU, and MSU.

• The Mass Storage Unit (MSU) contains a fixed-medium hard
disk drive and a removable-medium optical disk drive.

Illustration, rear view The following illustration shows a rear view of the Main Controller
subrack with a duplicated MC.

Legend:

1. Protection MC (shaded area)

2. Working MC

3. ARU

4. Serial TM

5. SCSI TM

6. LHU

7. NIC TM

8. Fans and power supply
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Units, back of subrack The following units and transition modules (TMs) plug into the back
of the Main Controller subrack:

• The Alarm Relay Unit (ARU) provides interfaces to system alarm
indicators, a network interface to the LHU, and a narrow Small
Computer System Interface-2 (SCSI-2) to the MSU.

• The LHUs provide the hub ports for system LAN connections.

• The Network Interface Chip (NIC) Transition Module provides
LAN access to the MPU.

• The Small Computer System Interface (SCSI) Transition Module
provides a narrow SCSI-2 interface between the MPU and the
MSU.

• The Serial Transition Module provides serial I/O access to the
MPU.

Equipment description
Main Controller subrack
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User Panel
....................................................................................................................................................................................................................................

Description The User Panel is located below the Main Controller subrack. The
User Panel provides general system status and alarm information.

Illustration The following illustration shows a front view of the User Panel.

Components The User Panel has the following alarm indicators, switches, and
connectors:

• The POWER LED is not used in this release.

• PROMPT is a red LED that indicates that an alarm classified as
prompt exists in the system.

• DEFERRED is a red LED that indicates that an alarm classified
as deferred exists in the system.

• INFORMATION is a yellow LED that indicates that an alarm
classified as information exists in the system.

• The ABNORMAL LED is not used in this release.
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• SUPPRESSED and DISCONNECT are push-button switches that
enable users to suppress or disconnect alarm indications. The
yellow LED next to the SUPPRESSED switch indicates that
alarm indications are suppressed. The yellow LED next to the
DISCONNECT switch indicates that alarm indications are
disconnected.

• WS1 and WS2 are V.28 DCE 8-pin modular connectors. WS1 is
used to connect a terminal or a modem to the working Main
Controller for local or remote operations, administration,
maintenance, and provisioning activities. WS2 is used to connect
a terminal or a modem to the protection Main Controller for local
or remote operations, administration, maintenance, and
provisioning activities. WS2 can be used only if the system has a
duplicated Main Controller.

Equipment description
User Panel

Product description
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Alarm Connector Panel (ACP)
....................................................................................................................................................................................................................................

Description The Alarm Connector Panel (ACP) is located on the back of the User
Panel. The ACP has connectors for alarm-related cables.

The ACP provides alarm signal routing from the ARU to the
following:

• User Panel

• Other system and customer-provided and designed alarm panels

Illustration The following illustration shows a front view of the Alarm Connector
Panel.

Components The Alarm Connector Panel has the following components:

• ARU-RELAY 1 is a DB-9 female connector. The other end of the
cable that attaches to this connector attaches to the connector
labeled ALM RMT on the ARU in Main Controller 1 (MC-1).
This interface carries station alarm signals from the ARU to the
ACP.

• ARU-RELAY 2 is a DB-9 female connector. The other end of the
cable that attaches to this connector attaches to the connector
labeled ALM RMT on the ARU in MC-2. This interface carries
station alarm signals from the ARU to the ACP. The
ARU-RELAY 2 connector is used only if the system has a
duplicated MC.

• ARU-ALT 1 is a DB-9 female connector. The other end of the
cable that attaches to this connector attaches to the connector
labeled ALM/IO on the ARU in MC-1. This interface carries
User Panel alarm signals, for example, system-level Prompt,
Deferred, and Information alarm signals, from the ARU to the
ACP.

STATION ALARM

EOS 1 EOS 2

ARU-RELAY 1

ARU-RELAY 2 ARU-ALT 2

ARU-ALT 1

ARU-ALARM 2

ARU-ALARM 1

RACK TOP 1

RACK TOP 2

MISC DISCRETES

USER PANEL
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• The ARU-ALT 2 is a DB-9 female connector. The other end of
the cable that attaches to this connector attaches to the connector
labeled ALM/IO on the ARU in MC-2. This interface carries
User Panel alarm signals, for example, system-level Prompt,
Deferred, and Information alarm signals, from the ARU to the
ACP. The ARU-ALT 2 connector is used only if the system has a
duplicated MC.

• ARU-ALARM 1 is a DB-37 female connector. The other end of
the cable that attaches to this connector attaches to the connector
labeled ALARM/IO on the ARU in MC-1. This interface carries
Rack Top, End-Of-Suite, and Miscellaneous Discrete alarm
signals from the ARU to the ACP.

• ARU-ALARM 2 is a DB-37 female connector. The other end of
the cable that attaches to this connector attaches to the connector
labeled ALARM/IO on the ARU in MC-2. This interface carries
Rack Top, End-Of-Suite, and Miscellaneous Discrete alarm
signals from the ARU to the ACP. The ARU-ALARM 2
connector is used only if the system has a duplicated MC.

• STATION ALARM is a DB-15 female connector. This connector
provides an interface for customer–provided and designed station
alarm indicators.

• EOS 1 is a DB-9 female connector. This connector provides an
interface for customer-provided and designed End-of-Suite alarm
indicators.

• EOS 2 is a DB-9 female connector. This connector provides an
interface for customer-provided and designed End-of-Suite alarm
indicators. The EOS 2 connector is used only if the system has a
duplicated MC.

• RACK TOP 1 is a DB-9 female connector. This connector
provides an interface for the rack-top alarm indicators on the
Matrix and Control rack, and a power sense lead that indicates
loss of input power to the MC.

• RACK TOP 2 is a DB-9 female connector. This connector
provides an interface for the rack-top alarm indicators on the
Matrix and Control rack, and a power sense lead that indicates
loss of input power to the MC. The RACK TOP 2 connector is
used only if the system has a duplicated MC.

Equipment description
Alarm Connector Panel (ACP)

Product description
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• MISC DISCRETES is a DB-25 female connector. The other end
of the cable that attaches to this connector attaches to the
connector labeled MD OUT on the FCP. This connector provides
an interface for miscellaneous customer-provided and designed
alarm indicators or other applications.

• USER PANEL is a DB-15 female connector. The other end of the
cable that attaches to this connector is permanently connected to
the User Panel.

Equipment description
Alarm Connector Panel (ACP)

Product description
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Fan Connector Panel (FCP)
....................................................................................................................................................................................................................................

Description The Fan Connector Panel (FCP) is located on the back of the User
Panel. The FCP has connectors for alarm-related cables, and routes
alarm signals from fan trays in port racks equipped with PSC subracks
and from customer-provided and designed alarm panels to the ACP.

Illustration The following illustration shows a front view of the Fan Connector
Panel.

Components The Fan Connector Panel has the following components:

• MD OUT is a DB-25 female connector. The other end of the
cable that attaches to this connector attaches to the connector
labeled MISC DISCRETES on the ACP. This connector provides
an interface from miscellaneous customer-provided and designed
alarm indicators or other applications to the ACP.

• MD IN is a DB-25 female connector. The other end of the cable
that attaches to this connector attaches to customer-provided and
designed alarm indicators or other applications. This connector
provides an interface for miscellaneous customer-provided and
designed alarm indicators or other applications.

• MDI 1 through 4 are DB-9 female connectors. The other end of
the cable that attaches to each of these connectors attaches to the
connector labeled ALM on the fan tray connector panel in each
port rack that is equipped with a PSC subrack. This interface
carries alarm signals from the port rack fan tray to the FCP.

MDI

1

2

3

4

MD

OUT IN
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Bit Slice Switch Unit (BSSU)
....................................................................................................................................................................................................................................

Description The Bit Slice Switch Units (BSSUs) are cross-connect matrix
components. The system has ten BSSUs. Five BSSUs are located in
the bottom of the Matrix and Synchronisation rack, and five BSSUs
are located in the bottom of the Matrix and Control rack.

Equipment description Product description
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Port rack
....................................................................................................................................................................................................................................

Description The port rack is an ETSI standard rack. It can be equipped with one
or two PSA subracks, one or two PSC subracks, or one PSA subrack
and one PSC subrack. The PSB subrack, for STM-0 interfaces, has
been discontinued.

Port racks that are equipped with one or two PSC subracks are also
equipped with a fan tray, heat duct, and bottom filter tray. The fan
tray is located in the middle of the port rack and contains six fans, fan
filters, and a connector panel. Refer to “Port rack fan tray connector
panel” (1-32) for a description of the fan tray connector panel.

When a port rack is equipped with only one PSC subrack, the subrack
must be located in the bottom of the port rack.

Illustration The following illustration shows a front view of a port rack with the
doors removed. The port rack is equipped with two PSC subracks.

Legend:

1. Power and fuse panel

2. PSC subrack

3. Heat duct

4. Fan tray and filters

5. Bottom filter tray
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Port Subrack A (PSA)
....................................................................................................................................................................................................................................

Description The Port Subrack A (PSA) has front and rear sections that are
partitioned for plug-in units. The PSA can be equipped with any
combination of STM-1 port units and interface units. The units plug
into a midplane that separates the front and rear sections and provides
the interconnections between units.

Illustration, front view The following illustration shows a front view of the PSA subrack.

Units, front of subrack The following units plug into the front of the PSA subrack:

• STM-1 Port Unit (STM-1) — The STM-1 port unit provides four
STM-1 (155.52 Mbps) ports. The STM-1 P is the protection unit
for a shelf that is configured for 1:8 equipment protection.

• Digital Timing Unit (DTU) — The DTU provides timing for the
transmission units in the subrack. The DTU is always duplicated.

• Subrack Controller (SRC) — The SRC routes messages back and
forth from the Main Controller to the units in the port subrack.
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Illustration, rear view The following illustration shows a rear view of the PSA subrack.

Units, back of subrack The following units plug into the back of the PSA subrack:

• Power Terminal Module (PTM) — The PTM filters incoming
station power from two separate power sources and distributes it
across the midplane.

• Bit Slice Interface Unit (BSIU) — The BSIU is part of the
transmission path. It transports data between the BSSUs
(cross-connect matrix components) and the port units. The BSIU
also monitors the transmission data and provides automatic
protection switching for hardware failures.

• STM-1 Interface Unit (IU) — The STM-1 interface unit provides
the SDH Physical Interface (SPI) function for STM-1 electrical
and optical signals. All STM-1 interface units work with the
STM-1 port unit.
The following STM-1 IUs are available:

- STM-1 electrical interface unit

- STM-1 short-haul optical interface unit designed to ITU
specifications

- STM-1 long-haul optical interface unit designed to ITU
specifications

- STM-1 short-haul optical interface unit designed to Nippon
Telegraph and Telephone (NTT) specifications
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Port Subrack C (PSC)
....................................................................................................................................................................................................................................

Description The Port Subrack C (PSC) has front and rear sections that are
partitioned for plug-in units. The PSC can be equipped with STM-16
or STM-4 port units. For this release, a PSC cannot be equipped with
a combination of STM-16 and STM-4 port units. The units plug into a
midplane that separates the front and rear sections and provides the
interconnections between units.

Illustration, front view The following illustration shows a front view of the PSC subrack.

Units, front of subrack The following units plug into the front of the PSC subrack:

• STM-16 Port Unit (STM-16) — The STM-16 port unit has one
STM-16 port. The STM-16 port provides 2.5 Gbit/s transmission.

• STM-4 Port Unit (STM-4) — The STM-4 port unit has four
STM-4 ports. Each STM-4 port provides 622 Mbit/s
transmission.

• Digital Timing Unit (DTU) — The DTU provides timing for the
transmission units in the subrack. The DTU is always duplicated.

• Subrack Controller (SRC) — The SRC routes messages back and
forth from the Main Controller to the units in the port subrack.
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Illustration, rear view The following illustration shows a rear view of the PSC subrack.

Units, back of subrack The following units plug into the back of the PSC subrack:

• Power Terminal Module (PTM) — The PTM filters incoming
station power from two separate power sources and distributes it
across the midplane.

• Bit Slice Interface Unit (BSIU) 128 — The BSIU128 is part of
the internal transmission path. It transports data between the
BSSUs (cross-connect matrix components) and the port units.
The BSIU128 also monitors the transmission data and provides
Automatic Protection Switching for hardware failures. The
BSIU128s in the PSC subrack can transport twice the bandwidth,
up to 128 STM-1 equivalents, compared to the BSIUs in the PSA
subrack, which can transport up to 64 STM-1 equivalents.
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Port rack fan tray connector panel
....................................................................................................................................................................................................................................

Description The fan tray connector panel is located on the back of the fan tray in
port racks that are equipped with a PSC subrack.

Components The port rack fan tray connector panel has the following components:

• ALM is a DB-9 female connector. The other end of the cable that
attaches to this connector attaches to one of the Miscellaneous
Discrete Input (MDI) connectors on the Fan Connector Panel
(FCP). This interface carries alarm signals from the port rack fan
tray to the FCP.

• PWR is a DB-3 male connector. The PWR connector terminates
the cable that provides duplicated –48 volt power to the port rack
fan tray.

• The FAIL LED is a red LED that lights when one or more fans
in the port rack fan tray fail.

Equipment description Product description
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2 About the user interface

Overview
....................................................................................................................................................................................................................................

Purpose “About the user interface” describes the user interface. The user
interface is used to perform operations, administration, maintenance,
and provisioning tasks on the Digital Access and Cross-connect
System (DACS).

What you need to know A basic knowledge of Microsoft Windows NT® is assumed.

Getting started To log on to the network element (DACS), you will need a valid user
ID and password for both the PC and the DACS.

Organisation “About the user interface” is organised as follows:

• “About the user-interface PC” (2-2)

• “Logging on” (2-4)

• “Logging off” (2-6)

• “Structure of the user interface” (2-8)

• “About the main application window” (2-10)

• “About query results windows” (2-14)

• “Updating data from a query results window” (2-16)

• “Button descriptions” (2-17)

• “Key descriptions” (2-20)

• “About system messages” (2-22)

• “About Help” (2-23)
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About the user-interface PC
....................................................................................................................................................................................................................................

General information about
the PC

A Personal Computer (PC) running the user interface application
software is required to perform operations, administration,
maintenance, or provisioning tasks on the system. The PC is also
called a Craft Interface Terminal (CIT). The user interface application
software, called XC-CIT, provides a point-and-click graphical user
interface. You point and click to select values or options, then point
and click to apply them.

XC-CIT works best when the PC does not have other software
installed.

Booting the PC You can boot the PC with or without a link to the system. If you boot
a PC with an active link to the system, it will not affect service.
However, booting will cause the link to the system to be dropped. You
must log back on to the system to reestablish the link.

Number of user interface
sessions

Up to six user interface sessions can be connected to one DACS
system at the same time. All six user interface sessions can be running
on one PC, or there can be up to six local and/or remote PCs.

Other users logging on to
the system

PCs already logged on to the system will not be affected by a new
user logging on to the system.

About connecting a PC to
more than one DACS

If the PCs are on a LAN that has more than one DACS, each PC can
connect to more than one DACS. To connect to more than one DACS,
a PC must have XC-CIT application software for each DACS.

Link failure message The system displays a failure message if the link between a PC and a
DACS fails. You must log back on to the system to reestablish the
link.

Socket failure message The system displays a failure message if a communication error is
detected. If the socket failure message displays, check the TCP/IP
connection and parameters.

About the user interface
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Date and time
synchronisation warning

The system displays the following warning if the PC date and time is
more than 10 seconds different from the system (Main Controller)
date and time.

If you click Yes, the Date and Time Administration window appears,
and you can change the PC date and time or the system date and
time.

If you click No, the warning window closes, and the PC and system
date and time remain unchanged.

About the user-interface PC About the user interface
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Logging on
....................................................................................................................................................................................................................................

Login window

Field descriptions The Login window has the following fields.

Field Description

Login ID The Login ID is a unique user login identification
that must have from two to eight letters or
numbers. The first character must be a letter, and
at least one character must be a lowercase letter.
A default login ID is provided for the system
administrator. Only the system administrator can
add or remove a login ID.

Password The password must have from four to eight
characters. There are no restrictions on what
characters you can use in the password.

Network
Element

The Network Element field must contain a
network element name or an IP address.

• If a network element name has been
provisioned, use the name of the network
element.

• If a network element name has not been
provisioned, use the IP address.

Procedure ............................................................................................................................................................

1 Enter your login ID.

............................................................................................................................................................

2 Enter your password.

............................................................................................................................................................

3 Enter the appropriate network element.

About the user interface
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............................................................................................................................................................

4 Click Connect.

Logging on About the user interface
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Logging off
....................................................................................................................................................................................................................................

Log off the system There are two ways to log off the system:

• Click the X in the upper right-hand corner of the user-interface
window.

• Go to File > Exit.

The system will display a confirmation window.

Respond to the confirmation by clicking the appropriate button.

About the user interface
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Displaying the name of the system that the PC is connected to
....................................................................................................................................................................................................................................

Display PC connected to
name

To display the name of the system that the PC is connected to, go to
Help > About....

About the user interface
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Structure of the user interface
....................................................................................................................................................................................................................................

File, Provision, and Alarms
menus

The following graphic shows the arrangement of the File, Provision,
and Alarms menus.

Signal Monitoring

Port Monitoring

SNCP Group

MSP Group

TCA Control

Count Control
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Station Clock

System Clock

System ID

Insert AIS

Connect Roll
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Exit
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Protection Switching...

Transmission...

Equipment...

Monitoring Control...

Cross Connects...

Synchronization and Timing...

Alarm Settings...
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Severity Levels

Alarm Suppress Control

Alarms View Current Alarms

Station Alarm ControlDisplay Alarm Panel

Station Alarm Control...

View Current Alarms...

EOW / User Channel
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Low Order Path
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Reports, Protection,
Maintenance, Utilities, and

Help menus

The following graphic shows the arrangement of the Reports,
Protection, Maintenance, Utilities, and Help menus.

Reports

Defects...

User Transactions...

Performance Monitoring...

Autonomous Messages...

Defects

User Transactions

Performance Monitoring

Autonomous Messages

Utilities

Date & Time Administration...

Login Administration...

Change Password...

Backup Database

Fibre Assignments...

Autonomous Message Indicator...

Date and Time Administration

Login Administration

Change Password

Autonomous Message Indicator

Fibre Assignments

Help

About

Help Topics

Automatic Laser Shutdown

Maintenance

Background Tests...

View Test Results...

Execute Tests...

Clear Test History Records...

Unit Control

Subrack Control

Button Tests

LED Tests

Alarm Indicator Tests

Diagnostic Tests

View Test Results

Background Tests

Clear Test History

Controller Maintenance...

Automatic Laser Shutdown

Protection

Transmission...

Equipment...

STM1 1:8

DTU

Matrix Slice

MS Control

Protection Switch - Transmission - MSP

MC Control

Protection Switch - Transmission - SNCP
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About the main application window
....................................................................................................................................................................................................................................

Description The main application window contains a title bar, a menu bar, and a
toolbar.

Menu bar

The menu bar contains the menus that open the windows that you use
for provisioning and maintaining the system. The menu bar appears at
the top of the application window directly below the title bar.

Item Function

File The File menu provides access to the Exit function.

Provision The Provision menu provides access to the parts of
the system that require provisioning.

Alarms The Alarms menu provides access to the windows
from which you can perform alarm-related tasks
other than alarm provisioning.

About the user interface
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Item Function

Reports The Reports menu provides access to the windows
from which you can display or print various reports.

The following reports are located elsewhere in the
user interface:

• To display and print current alarms, go to Alarms
> View Current Alarms.

• To display and print diagnostic test results, go to
Maintenance > View Test Results.

Protection The Protection menu provides access to the windows
from which you can perform protection switch
requests and display protection switch-related
information. To provision protection switching
groups and Wait-To-Restore timers, go to Provision
> Protection Switching.

Maintenance The Maintenance menu provides access to the
windows from which you can perform
maintenance-related tasks.

Utilities The Utilities menu provides access to the windows
from which you can perform general system-related
tasks.

About the main application window About the user interface
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Item Function

Help The Help menu provides access to Help Topics and
the About… window.

Toolbar

The toolbar is located directly beneath the menu bar. It provides quick
access to frequently-used windows.

Button Function

Cross-connect provisioning
button

The Cross-connect provisioning
button opens to the Cross
Connect window.

Monitoring control provisioning
button

The Monitoring control
provisioning button opens to the
Port Monitoring window.

Equipment provisioning button The Equipment provisioning
button opens to the Rack
window.

Transmission provisioning button The Transmission provisioning
button opens to the Port window.

Performance monitoring
provisioning button

The Performance monitoring
provisioning button opens to the
Count Control window.

View current alarms button The View current alarms button
opens to the View Current
Alarms window.

Autonomous messages report
button

The Autonomous messages report
button opens to the Reports —
Autonomous Messages window.

About the main application window About the user interface

....................................................................................................................................................................................................................................

2 - 1 2 Lucent Technologies 365–367–512
Issue 2, July 2002



Button Function

Performance monitoring report
button

The Performance monitoring
report button opens to the
Reports — Performance
Monitoring window.

About the main application window About the user interface

....................................................................................................................................................................................................................................

365–367–512
Issue 2, July 2002

Lucent Technologies 2 - 1 3



About query results windows
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of a query results
window.

Important! The data displayed on this screen may not be typical.

Sorting query records Double-clicking on a column heading in a query results window sorts
the information in that column either numerically or alphabetically.

Query results menu bar

The query results menu bar is displayed across the top of the query
results window.

Item Function

File The File menu provides access to the menu list items
for saving to a file and printing.

About the user interface

....................................................................................................................................................................................................................................

2 - 1 4 Lucent Technologies 365–367–512
Issue 2, July 2002



Item Function

Edit The Edit menu provides access to the menu list items
Update and Find.

• Use Update to replace the data in the window from
which the query was performed with data from a
record that you select from the query results
window. This is useful when you want to change
the query results data without having to enter the
information in the original window.
For more information, see “Updating data from a
query results window” (2-16).

• Use Find to locate a specific record in the query
results.

Help The Help menu provides access to help for query
results windows.

About query results windows About the user interface
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Updating data from a query results window
....................................................................................................................................................................................................................................

Procedure Do the following when you want to change the query results data
without having to enter the information in the original query
results window.
............................................................................................................................................................

1 Perform a query.

............................................................................................................................................................

2 Do any of the following:

• Highlight a record and press the update button at the bottom of
the window.

• Highlight a record and select Update from Edit > Update.

• Double-click on the record.

About the user interface
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Button descriptions
....................................................................................................................................................................................................................................

Button descriptions The following section describes the buttons that may appear at the
bottom of the user interface windows.

Button Function

Apply The Apply button changes or creates a database
record.

Autonomous
Events

The Autonomous Events button opens the
Autonomous Messages window.

Cancel Test The Cancel Test button cancels the selected
background test.

Change The Change button changes a database record.

Clear The Clear button clears the fields and restores the
window to its original state.

Clear AIS The Clear AIS button removes AIS (Alarm
Indication Signal) on an entity.

Clear Records The Clear Records button clears the records for
the specified tests.

Close The Close button closes the window.

Connect The Connect button on the Cross Connect window
creates a cross connect.

The Connect button on the Login window
establishes a connection to a local or remote
network element.

Connect Station
Alarms

The Connect Station Alarms button connects the
station alarm indicators so that they will light or
sound when a station alarm is active.

Create The Create button creates a record in the database.

Current Alarms The Current Alarms button opens the View
Current Alarms window.

Delete The Delete button deletes one or more database
records.

Disconnect The Disconnect button removes a cross connect.

Disconnect
Station Alarms

The Disconnect Station Alarms button disconnects
station alarm indicators. Pressing the Disconnect
Station Alarms button will not affect LED
indicators on units and station alarm indicators
that cannot be disconnected.

Execute The Execute button initiates a test.

About the user interface
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Button Function

Help The Help button opens a screen-related help topic
window.

Initialise The Initialise button initialises a unit controller.

Insert AIS The Insert AIS button inserts AIS (Alarm
Indication Signal) on an entity.

Manual Restart The Manual Restart button restarts a laser that the
system has previously shutdown by performing a
2-second transmission test. If there are no
problems, the signal is restored.

Manual Restart
for Test

The Manual Restart for Test button restarts a laser
that the system has previously shutdown by
performing a 90-second transmission test. If there
are no problems, the signal is restored.

Monitoring
Control…

The Monitoring Control… button opens the
Monitoring Control window.

Print The Print button opens the Microsoft Windows
NT® print dialog box.

Protection
Switch Control

The Protection Switch Control button opens the
Matrix Control window.

Query The Query button requests information from the
system database.

Query Active The Query Active button queries the active STU.

Query From ID The Query From ID button queries the From ID
address for the source of the cross-connect data.

Query NE
Date/Time

The Query NE Date/Time button queries the
network element date and time, and uses it to
overwrite the Date and Time fields on the Date
and Time Administration window.

Query PC
Date/Time

The Query PC Date/Time button queries the
personal computer date and time, and uses it to
overwrite the Date and Time fields on the Date
and Time Administration window.

Query Port From the Automatic Laser Shutdown window, the
Query Port button opens the Port window, which
can be used to enable or disable the automatic
laser shutdown feature.

Query Standby The Query Standby button queries the standby
STU.

Query To ID The Query To ID button queries the To ID address
for the destination of the cross-connect data.

Button descriptions About the user interface
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Button Function

Remove The Remove button removes an MPU or SRC
from service.

Restore The Restore button restores an SRC to service.

Restore All The Restore All button restores all alarm
severities to their default values.

Roll The Roll button rolls a cross connect.

Save Error
Message

The Save Error Message button saves the error
message to a common file on the PC.

Set NE
Date/Time

The Set NE Date/Time button changes the date
and time for the network element to the values
displayed in the Date and Time fields on the Date
and Time Administration window.

Set PC
Date/Time

The Set PC Date/Time button changes the date
and time on the PC to the values displayed in the
Date and Time fields on the Date and Time
Administration window.

Subrack
Degrade Inhibit

The Subrack Degrade Inhibit button opens the
Subrack window, which can be used to enable or
disable the Degrade Inhibit feature.

Suppress
Station Alarms

The Suppress Station Alarms button causes a
system-wide temporary suppression of current
station alarm indicators. Pressing the Suppress
Station Alarms button will not affect LED
indicators on units and station alarm indicators
that cannot be suppressed, nor will it affect
indicators for future alarms.

Update The Update button replaces the data in the
window from which the query was performed with
data from a record that you select from the query
results window.

View Results The View Results button displays the requested
test results.

WTR Timer The WTR Timer button opens the Wait To Restore
Timer window.

Button descriptions About the user interface
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Key descriptions
....................................................................................................................................................................................................................................

Keys used for shortcuts Shortcut keys are combinations of keys that you press to perform an
action that you would otherwise perform with the mouse. As in other
Microsoft Windows NT® applications, shortcut keys are a combination
of the ALT key and the underlined letter associated with a menu or
menu item.

Example

Pressing ALT + P opens the Provision menu.

Keys used for editing For windows that permit data entry, an Edit menu with cut, copy, and
paste functions is available. You can also perform these editing
functions by using the following keys.

Key Function

CTRL+X Removes the selected information

CTRL+C Copies the selected information

CTRL+V Pastes the cut or copied information into the
selected input field

Keys used for navigation Navigation in the user interface is accomplished primarily by clicking,
double-clicking, and scrolling with a mouse. You can also use the
following keys for navigation.

Key Moves the cursor

Left arrow Left one field or subfield

Right arrow Right one field or subfield

Up arrow Up one item in a drop list or field

Down arrow Down one item in a drop list or field

Home To the beginning of items in a drop list

About the user interface
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Key Moves the cursor

End To the end of items in a drop list

Page Up Up one screen

Page Down Down one screen

Tab To the next field or command button

Shift Tab To the previous field or command button

Key descriptions About the user interface

....................................................................................................................................................................................................................................

365–367–512
Issue 2, July 2002

Lucent Technologies 2 - 2 1



About system messages
....................................................................................................................................................................................................................................

General system messages A message window may appear when you are performing provisioning
and maintenance tasks. You can get help for a system message by
clicking the Help button on the system message window. The help
associated with a system message explains why this message has
occurred and suggests corrective actions.

Time-out message The system displays a time-out message if your request cannot be
processed in a reasonable amount of time. If you get a time-out
message, wait a few minutes, then try the request again.

About the user interface
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About Help
....................................................................................................................................................................................................................................

Help Topics Selecting Help Topics from the Help menu opens the help system.
The help system and the paper documentation are almost identical
because they are derived from the same source. The help system
works best if you have Microsoft Internet Explorer® 4.0 or later
installed on your PC.

About… Selecting About… from the Help menu opens a window that contains
information about the current software version and the maximum
system capacity.

Accessing Help There are two ways to access the help system:

• Click on the Help button from any user interface window to
display a help topic that is specific to that window.

• Go to Help > Help Topics.

The Help Topics window The following illustration shows the Help Topics window.

The Help Topics window has a toolbar, navigation pane, and topic
pane.

The Help toolbar The Help toolbar has the following buttons.

About the user interface
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Button Function

Hide If the navigation pane is open, clicking the Hide
button closes the pane. If the navigation pane is
closed, clicking the Hide button opens the pane.

Back Clicking the Back button opens the previously
viewed help topic in the topic pane.

Print Clicking the Print button opens a dialog box from
which you choose whether to print the selected
topic (the topic currently displayed in the topic
panel), or if a heading is selected in the
navigation pane, the selected heading and all
subtopics.

Options Clicking the Options button opens a menu that
contains the following items:

• Hide Tabs — performs the same function as
the Hide button.

• Back — performs the same function as the
Back button.

• Stop — stops a web page from opening. This
help system does not have links to internet
web pages.

• Refresh — refreshes the topic that appears in
the topic pane.

• Internet Options — opens a dialog box from
which you can set various options for Internet
Explorer.

• Print — performs the same function as the
Print button.

• Search Highlight On/Off— turns on or off the
Search Highlight function. The Search
Highlight function highlights the word or
words that you search for using the Search
tab.

The navigation pane The navigation pane has the following tabs that help you find the
appropriate help topic.

About Help About the user interface
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Tab Function

Contents The Contents tab displays an expandable list of
help topics. Items in the list that can be expanded
have a book icon and a plus sign to the left of the
item. To expand an item, click on the plus sign, or
double-click on the item. To select a help topic,
click on an item in the list. The selected help
topic appears in the topic pane.

Index The Index tab displays a list of index entries. To
select a help topic, click on an item in the list, or
type a word into the text box above the list and
press ENTER when the desired index entry is
highlighted. The selected help topic appears in the
topic pane.

Search The Search tab lets you search for one or more
words that appear in the help topics. To search for
a word, type the word to search for and press
ENTER. A list of help topics that contain the
search word appears. To select a help topic,
double-click on an item in the list. The selected
help topic appears in the topic pane.

The topic pane The topic pane displays the selected help topic.

About Help About the user interface
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3 About equipment and signal
addresses

Overview
....................................................................................................................................................................................................................................

Purpose “About equipment and signal addresses” contains general information
about equipment and signal addresses that appear on the user
interface.

Organisation “About equipment and signal addresses” is organised as follows:

• “About entity addresses” (3-2)

• “About physical layer addresses” (3-3)

• “About signal layer addresses” (3-4)

• “Wildcard addresses” (3-9)

• “256 and 512 addressing” (3-10)

• “MC entity addresses” (3-11)

• “MS entity addresses” (3-12)

• “PSA entity addresses” (3-13)

• “PSC entity addresses” (3-14)

• “Equipment protection group addresses” (3-16)

• “MSP addresses” (3-17)

• “RT addresses” (3-18)

• “Fibre addresses” (3-19)
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About entity addresses
....................................................................................................................................................................................................................................

Description of physical
and signal layers

The entity address consists of two parts: a physical layer and a signal
layer. In the following example, the physical layer is labelled Port ID,
and the signal layer is labelled Signal ID.

About equipment and signal addresses
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About physical layer addresses
....................................................................................................................................................................................................................................

About the physical layer The physical layer is part of the entity address; it describes the
physical location of the equipment. On most user-interface windows,
the physical layer is labelled Port ID, but depending on the context of
the window, this field can also be labelled Subrack ID, Unit ID, MSP
ID, MSP Group ID, or Protection Group ID.

The physical layer consists of up to five fields:

• subrack

• (subrack) number

• unit

• (unit) number

• port

About equipment and signal addresses
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About signal layer addresses
....................................................................................................................................................................................................................................

About the signal layer The signal layer is part of the entity address; it describes the structure
of a Synchronous Digital Hierarchy (SDH) signal. The signal layer is
always labelled Signal ID on the user interface.

The signal layer consists of the following fields:

• AUG4 number

• AUG1 number

• AU type

• TUG3 value

• TUG2 value

• TU12 value

Table of signal layer
addresses

The following table shows the valid signal type and entity ID
combinations for specifying multiplexing.

Signal
Type

Entity ID

AU-4-4c PSC-s-STM16-u-p-ALL 1

PSC-s-STM16-u-p-AUG4#{1-4}-AU4_4c

PSC-s-STM4-u-p-AUG4#1-AU4_4c

AU-4 PSA-s-STM1-u-p-AUG1#1-AU4

PSC-s-STM16-u-p-ALL

PSC-s-STM16-u-p-AUG4#{1-4}-ALL

PSC-s-STM16-u-p-AUG4#{1-4}-AUG1#{1-4}-AU4

PSC-s-STM4-u-p-AUG4#1-ALL

PSC-s-STM4-u-p-AUG4#1-AUG1#{1-4}-ALL

PSC-s-STM4-u-p-AUG4#1-AUG1#{1-4}-AU4

AU-3 PSA-s-STM1-u-p-AUG1#1-ALL

PSC-s-STM16-u-p-ALL

PSC-s-STM16-u-p-AUG4#{1-4}-ALL

PSC-s-STM16-u-p-AUG4#{1-4}-AUG1#{1-4}-ALL

PSC-s-STM4-u-p-AUG4#1-ALL

PSC-s-STM4-u-p-AUG4#1-AUG1#{1-4}-ALL

About equipment and signal addresses
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Signal
Type

Entity ID

TU-3 PSA-s-STM1-u-p-AUG1#1-AU4-ALL[-ALL] 2

PSA-s-STM1-u-p-AUG1#1-ALL-TUG3#{1-3}-ALL 3

PSA-s-STM1-u-p-AUG1#1-ALL-TUG3#{1-3}-TU3 3

PSC-s-STM16-u-p-ALL

PSC-s-STM16-u-p-AUG4#{1-4}-ALL[-ALL]

PSC-s-STM16-u-p-AUG4#{1-4}-AUG1#{1-4}-ALL

PSC-s-STM16-u-p-AUG4#{1-4}-AUG1#{1-4}-AU4-
ALL

PSC-s-STM16-u-p-AUG4#{1-4}-AUG1#{1-4}-AU4-
TUG3#{1-3}-ALL 3

PSC-s-STM16-u-p-AUG4#{1-4}-AUG1#{1-4}-AU4-
TUG3#{1-3}-TU3 3

PSC-s-STM4-u-p-AUG4#1-ALL

PSC-s-STM4-u-p-AUG4#1-AUG1#{1-4}-ALL

PSC-s-STM4-u-p-AUG4#1-AUG1#{1-4}-AU4

PSC-s-STM4-u-p-AUG4#1-AUG1#{1-4}-AU4-
TUG3#{1-3}-ALL 3

PSC-s-STM4-u-p-AUG4#1-AUG1#{1-4}-AU4-
TUG3#{1-3}-TU3 3

About signal layer addresses About equipment and signal addresses
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Signal
Type

Entity ID

TU-12 PSA-s-STM1-u-p-AUG1#1-AU4-ALL[-ALL][-ALL] 2

PSA-s-STM1-u-p-AUG1#1-AU4-TUG3#{1-3}-ALL[-
ALL] 3

PSC-s-STM16-u-p-ALL

PSC-s-STM16-u-p-AUG4#{1-4}-ALL[-ALL]

PSC-s-STM16-u-p-AUG4#{1-4}-AUG1#{1-4}-ALL

PSC-s-STM16-u-p-AUG4#{1-4}-AUG1#{1-4}-AU4-
ALL

PSC-s-STM16-u-p-AUG4#{1-4}-AUG1#{1-4}-AU4-
TUG3#{1-3}-ALL 3

PSC-s-STM16-u-p-AUG4#{1-4}-AUG1#{1-4}-AU4-
TUG3#{1-3}-ALL[-ALL] 3

PSC-s-STM4-u-p-AUG4#1-ALL

PSC-s-STM4-u-p-AUG4#1-AUG1#{1-4}-ALL

PSC-s-STM4-u-p-AUG4#1-AUG1#{1-4}-AU4

PSC-s-STM4-u-p-AUG4#1-AUG1#{1-4}-AU4-
TUG3#{1-3}-ALL 3

PSC-s-STM4-u-p-AUG4#1-AUG1#{1-4}-AU4-
TUG3#{1-3}-ALL[-ALL] 3

Notes:

1. s = subrack number, u = unit number, p = port number

2. The square brackets indicate values that the system adds automatically.
When you specify the value ALL for a field in the entity ID, the
system automatically enters the value ALL for all subsequent fields in
the entity ID.

3. These forms cannot be used when changing from AU4 clear channel
(not TUG structured), because they do not specify how the other two
TUG3s are to be multiplexed. For an STM-1 that is already TUG
structured within the AU-4, any of the forms can be used, but only the
form that specifies all TUG3s can be used when changing from AU-4
clear channel.
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Illustration of signal layer
addresses

VC-4VC-3

TU12#1
TU12#2
TU12#3

Broadband

Wideband
TUG3#1
TUG3#2
TUG3#3

TUG2#1
TUG2#2
TUG2#3
TUG2#4
TUG2#5
TUG2#6
TUG2#7

AUG1 number

AU type

TUG3 value

TUG2 value

TU12 value

AUG4 number

STM-1

AUG1#1

TU-3

STM-16

AUG4#1
AUG4#2
AUG4#3
AUG4#4

AUG1#1
AUG1#2
AUG1#3
AUG1#4

AU-4
AU3#1
AU3#2
AU3#3

AU4-4C

AUG4#1

STM-4

VC-3

VC-12

VC-4-4C
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Graphical representation
of wideband signal

The following illustration shows a graphical representation of a
wideband signal.
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Wildcard addresses
....................................................................................................................................................................................................................................

About wildcards Rather than entering entity addresses individually, you can use a
wildcard to specify a range of addresses. To use a wildcard, select the
value ALL for any field in the entity address. The system
automatically assigns all subsequent entity address fields the value
ALL.

Examples The following are examples of entity addresses that use wildcards:

• MS-3-BSSU-ALL queries all the BSSUs on the MS-3 subrack.

• PSC-4-ALL-ALL-ALL queries all units, unit numbers, and ports
on subrack PSC-4.

• ALL-ALL-ALL-ALL-ALL queries all units, unit numbers, and
ports in all subracks in the system.
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256 and 512 addressing
....................................................................................................................................................................................................................................

Differences between 256
and 512

On the user-interface windows, the port subracks on a 256 STM-1
equivalent system are numbered 4–11. The port subracks on a 512
STM-1 equivalent system are numbered 4–19.

Example

The following table describes the differences between the addressing
on a 256 system and a 512 system.

System
capacity

Address example

256 PSA-{4–11}-STM1-1

512 PSA-{4–19}-STM1-1

Related topic For more information about 256 and 512 configurations, see “System
capacity” (1-5).
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MC entity addresses
....................................................................................................................................................................................................................................

Table of MC entity
addresses

The following table shows the entity addresses for the Main
Controller (MC) subrack.

Subrack
type

Subrack
number

Unit type Unit
number

Port
number

MC 1, 2 MPU 1 N/A

MSU 1 N/A

LHU 1, 2 1–12

ARU 1 N/A

PSP 1 N/A
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MS entity addresses
....................................................................................................................................................................................................................................

Table of MS entity
addresses

The following table shows the entity addresses for the Matrix and
Synchronisation (MS) subrack.

Subrack Unit type Unit number Port number

MS-3 SRC 1, 2 N/A

BSC 1, 2 N/A

OLU 1–4 BSFI{1–5}

BSSU 1–10 ECI{1–16},
BSFI{W, P}

STU 1, 2 N/A
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PSA entity addresses
....................................................................................................................................................................................................................................

Table of PSA entity
addresses for the Physical

ID

The following table shows the entity addresses for the Physical ID of
a Port Subrack A (PSA).

Subrack
type

Subrack
number

Unit type Unit
number

Port
number

PSA 4–11 or
4–19

SRC 1 N/A

DTU 1, 2 N/A

BSIU 1–10 ECI {1, 2}

STM1 1–9, 11–19 1–4

GRP1,
GRP2

N/A

MSP1,
MSP3,
MSP5,
MSP7,
MSP11,
MSP13,
MSP15,
MSP17

1–4

IU 1–8, 11–18 1–4

Table of PSA entity
addresses for the Signal ID

The following table shows the entity addresses for the Signal ID of a
Port Subrack A (PSA). In a PSA subrack, you can provision a Signal
ID only for STM-1 ports.

AUG1 AU TUG3 TUG2 TU12

AUG1#1 AU4 N/A N/A N/A

TUG3#1,
TUG3#2,
TUG3#3

TUG2#1,
TUG2#2,
TUG2#3,
TUG2#4,
TUG2#5,
TUG2#6,
TUG2#7

TU12#1,
TU12#2,
TU12#3

TU3 N/A

AU3#1,
AU3#2,
AU3#3

N/A N/A N/A

About equipment and signal addresses
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PSC entity addresses
....................................................................................................................................................................................................................................

Table of PSC entity
addresses for the Physical

ID

The following table shows the entity addresses for the Physical ID of
a Port Subrack C (PSC).

Subrack
type

Subrack
number

Unit type Unit
number

Port
number

PSC 4–11 or
4–19

SRC 1 N/A

DTU 1, 2 N/A

BSIU 1–10 ECI {1, 2}

STM16 1–8 1

MSP1,
MSP3,
MSP5,
MSP7

1

STM4 1–8 1–4

MSP1,
MSP3,
MSP5,
MSP7

1–4

Table of STM-16 entity
addresses for the Signal ID

The following table shows the STM-16 entity addresses for the Signal
ID of a Port Subrack C (PSC).

AUG4 AUG1 AU TUG3 TUG2 TU12

AUG4#1,
AUG4#2,
AUG4#3,
AUG4#4

N/A AU4_4c N/A N/A N/A

AUG1#1,
AUG1#2,
AUG1#3,
AUG1#4

AU4 N/A N/A N/A

TUG3#1,
TUG3#2,
TUG3#3

TUG2#1,
TUG2#2,
TUG2#3,
TUG2#4,
TUG2#5,
TUG2#6,
TUG2#7

TU12#1,
TU12#2,
TU12#3

TU3 N/A

N/A AU3#1,
AU3#2,
AU3#3

N/A N/A N/A

Table of STM-4 entity
addresses for the Signal ID

The following table shows the STM-4 entity addresses for the Signal
ID of a Port Subrack C (PSC).
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AUG4 AUG1 AU TUG3 TUG2 TU12

AUG4#1 N/A AU4_4c N/A N/A N/A

AUG1#1,
AUG1#2,
AUG1#3,
AUG1#4

AU4 N/A N/A N/A

TUG3#1,
TUG3#2,
TUG3#3

TUG2#1,
TUG2#2,
TUG2#3,
TUG2#4,
TUG2#5,
TUG2#6,
TUG2#7

TU12#1,
TU12#2,
TU12#3

TU3 N/A

N/A AU3#1,
AU3#2,
AU3#3

N/A N/A N/A

PSC entity addresses About equipment and signal addresses
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Equipment protection group addresses
....................................................................................................................................................................................................................................

About equipment
protection group

addresses

The user interface uses GRP addresses to refer to entities that belong
to equipment protection groups. The GRP address refers to both the
working and protection units in an equipment protection group.

GRP address table The following table lists GRP addresses.

Subrack and unit Group

MS-3-SRC-{1, 2} GRP

MS-3-BSSU-{1–10} GRP

PSA-{4–11, 4–19}-DTU-{1, 2} GRP

PSA-{4–11, 4–19}-STM1-{1–9} GRP1

PSA-{4–11, 4–19}-STM1-{11–19} GRP2

PSC-{4–11, 4–19}-DTU-(1, 2) GRP

Example of a GRP address The following is an example of a protection group:

• MS-3-SRC-1 = working unit

• MS-3-SRC-2 = protection unit

• MS-3-SRC-GRP = both the working and protection units
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MSP addresses
....................................................................................................................................................................................................................................

About MSP addresses A Multiplex Section Protection (MSP) group is a pair of STM-1,
STM-4, or STM-16 ports that are provisioned for MSP. The user
interface uses MSP addresses to refer to entities that belong to MSP
protection groups. The MSP in the address refers to both the working
and protection ports in an MSP protection group.

MSP address table The following table lists MSP addresses.

Subrack and unit Group Port

PSA-{4–11, 4–19}-STM1 MSP{1, 3, 5, 7, 9, 11, 13, 15, 17} 1–4

PSC-{4–11, 4–19}-{STM16, STM4} MSP{1, 3, 5, 7} 1

Example of an MSP
address

The following is an example of an MSP protection group:

• PSA-1-STM1-1-1 = working port

• PSA-1-STM1-2-1 = protection port

• PSA-1-STM1-MSP1-1 = both the working and protection ports

About equipment and signal addresses
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RT addresses
....................................................................................................................................................................................................................................

About RT addresses Certain types of alarms display a rack-top (RT) entity address. The
following illustration describes the rack-top address.

Port number and aux1
table

The following table describes the port number and aux1 values.

Port number Aux1

1 = rack-top battery input 1 = battery input A

2 = battery input B

2 = rack-top fuse array 1 = fuse 1

2 = fuse 2

MC-1-RT-1-{1, 2}-{1, 2}

aux1
port number
unit number
rack-top number
subrack number
subrack

About equipment and signal addresses
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Fibre addresses
....................................................................................................................................................................................................................................

About fibre addresses Fibre addresses are displayed after a query from the View Current
Alarms window, Alarms > View Current Alarms, for the following
alarms:

• CABLEcEQ

• CABLEcTIM

• INTFcEQ

You can also enter fibre addresses from the Fibre Assignments
window, Utilities > Fibre Assignments.

The following table displays all possible fibre addresses.

Subrack
type

Subrack
number

Unit
type

Unit
number

Port number

MS 3 OLU 1–4 BSFI{1–5}

BSSU 1–10 BSFI{W, P}

PSA 4–11 or
4–19

BSIU 1–10 ECI{1, 2}

PSC 4–11 or
4–19

BSIU 1–10 ECI{1–4}

Example of a fibre
address

The following illustration shows the physical port associated with the
fibre address MS-3-OLU-3-BSFI2.

Legend:

1. Port 2 (BSFI2) on OLU-3

1

OLU-3

T
R

1/
6

T
R

2/
7

T
R

3/
8

T
R

4/
9

T
R

5/
10

T
R

X
-C

O
U

P
LE

O
LU
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4 Cross connects

Overview
....................................................................................................................................................................................................................................

Purpose “Cross connects” contains the following information:

• General information about cross connects

• Descriptions of the windows that are used to provision cross
connects

• Step-by-step procedures for provisioning cross connects

Organisation The organisation is as follows:

• “Background information” (4-2)

• “Cross Connect window and procedures” (4-5)

• “Connect Roll window and procedures” (4-15)

• “Insert AIS window and procedures” (4-32)

....................................................................................................................................................................................................................................
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Background information

Overview
....................................................................................................................................................................................................................................

Purpose This section provides the background information about cross
connects.

Organisation This section is organised as follows:

• “Cross-connect tasks” (4-3)

• “Cross-connect terms” (4-4)

Cross connects
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Cross-connect tasks
....................................................................................................................................................................................................................................

Tasks performed on the
Cross Connect window

Use the Cross Connect window to do the following tasks:

• Query cross connects

• Connect or disconnect cross connects

• Add or remove multi-point cross connects

• Connect or disconnect loopback cross connects

• Establish or disconnect MONE, MONF, and MONEF test-access
connections

• Establish or disconnect LOOPE and LOOPF test-access
connections

Tasks performed on the
Connect Roll window

Use the Connect Roll window to do the following tasks:

• Perform a bidirectional roll of a bidirectional cross connect

• Perform a unidirectional roll of a unidirectional cross connect

• Establish or disconnect SPLTE and SPLTF test-access
connections

Tasks performed on both
the Cross Connect and
Connect Roll windows

Use the Cross Connect and Connect Roll windows to do the following
tasks:

• Perform a unidirectional roll of a unidirectional cross connect

• Perform a unidirectional roll of a bidirectional cross connect

• Perform a bidirectional roll of a bidirectional cross connect

• Roll service in a network with no active service

• Roll service in a network with active service

• Establish or disconnect SPLTA, SPLTB, SPLTAB, and SPLTEF
test-access connections

Tasks performed on the
Insert AIS window

Use the Insert AIS window to insert or clear Alarm Indication Signal
(AIS) on the output port of any cross connect.

Background information Cross connects
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Cross-connect terms
....................................................................................................................................................................................................................................

List of terms Bidirectional Bidirectional, or two-way cross connects connect
two ports so they can communicate in two directions.

Bridge cross connect A bridge cross connect is another name for
a multi-point cross connect.

Broadcast cross connect A broadcast cross connect is another
name for a multi-point cross connect.

Cross connects Cross connects are the hardware and software
used to connect line-terminating equipment, multiplexers, and
other equipment.

Loopback cross connect A loopback cross connect is a special
unidirectional cross connect that sends the signal from an input
port back to the output port. Loopback cross connects are
typically used to isolate trouble on the port units during
installation.

Multi-point cross connect Multi-point cross connects have the
following characteristics:

• Connect a single input to two or more outputs

• Provide bridging for restoration, testing, or broadcast

• Can be from any input to any available output signal

• Created using the “Uni-Directional” option on the Cross Connect
window

• Can be disconnected in any order

• Can be added to any existing service whether originally created
as unidirectional or bidirectional

• Were previously called bridge and broadcast cross connects

Rollover (Roll) A roll is used to replace the input of an existing
cross connect. All outputs specified in the original connection are
moved to the new input. You can roll a unidirectional cross
connect, one or both directions of a bidirectional cross connect,
or a multi-point cross connection. When performing a roll, you
can specify a specific output or all multi-point outputs.

Unidirectional A unidirectional, or one-way cross connect
connects two ports so that they can communicate in one
direction. Even though most cross connects are bidirectional, the
system also allows cross connects in only one transmission
direction between all port combinations. Unidirectional cross
connects are used mostly for test access.

Background information Cross connects
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Cross Connect window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose The Cross Connect window is used to query and provision
unidirectional, bidirectional, and multi-point cross connections.

Window location Provision > Cross Connects > Cross Connect

Organisation This section is organised as follows:

• “Cross Connect window description” (4-6)

• “Querying cross connects” (4-8)

• “Cross-connect query results” (4-9)

• “Connecting or disconnecting cross connects” (4-10)

• “Adding or removing multi-points to an existing cross connect”
(4-11)

• “Connecting or disconnecting a loopback cross connect” (4-13)

Cross connects
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Cross Connect window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Cross Connect window.

Field descriptions The Cross Connect window has the following fields.

Field name Description

Cross Connect
Type

The Cross Connect Type specifies the type of
cross connect you want to connect or disconnect
as bidirectional or unidirectional.

Bi-Directional Bidirectional, or two-way cross connects connect
two ports so they can communicate in two
directions.

A

A

B

B

Cross Connect window and procedures Cross connects
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Field name Description

Uni-Directional A unidirectional, or one-way cross connect
connects two ports so that they can communicate
in one direction.

A B

Even though most cross connects are bidirectional,
the system also allows cross connects in only one
transmission direction between all port
combinations. Unidirectional cross connects are
used mostly for test access.

Loopback and multi-point cross connects are
special types of unidirectional cross connects. For
more information about these cross connects, see
“List of terms” (4-4) .

Signal Type The Signal Type field specifies the signal level for
cross-connect signal provisioning as AU4_4c,
AU4, AU3, TU3, or TU12. To query more than
one cross-connect signal type, you can specify
ALL.

From ID The From ID fields specify the Port ID and Signal
ID addresses of the input port.

To ID The To ID fields specify the Port ID and Signal
ID addresses of the output port.

Port ID The Port ID fields specify the physical location of
the equipment.

Signal ID The Signal ID fields specify the signal level of
the address that you want to query or provision.
The options available for Signal ID depend on the
Signal Type.

For a description of the Signal ID options, see
“About signal layer addresses” (3-4).

Related topic For more information about windows, see “About the main
application window” (2-10).

Cross Connect window and procedures
Cross Connect window description

Cross connects
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Querying cross connects
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Cross Connect window at Provision > Cross Connects >
Cross Connect.

............................................................................................................................................................

2 Click Bi-Directional or Uni-Directional in the Cross Connect Type
field.

............................................................................................................................................................

3 Select a value for the Signal Type field.

Select the value ALL to query all signal types.

............................................................................................................................................................

4 Select values for either the From ID fields or the To ID fields.

Select the value ALL in the From ID or To ID fields to query more
than one subrack.

............................................................................................................................................................

5 Click Query From ID or Query To ID.

Cross Connect window and procedures Cross connects
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Cross-connect query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results
from the Cross Connect window.

Important! The data displayed on this screen may not be typical.

Bidirectional cross connects

Bidirectional cross connects are displayed twice. Each end has its own
record that is displayed as From Port ID and From Signal ID.

Results field descriptions The following information appears in the Cross Connects Query
Results window.

Column Description

From Port ID Displays the physical address of the input port.

From Signal ID Displays the signal address of the input port.

To Port ID Displays the physical address of the output port.

To Signal ID Displays the signal address of the output port.

AIS Signal Displays the Alarm Indication Signal (AIS) status
of the To Signal ID as one of the following:

• Clear — the cross connect does not have AIS
provisioned

• Set — the cross connect has AIS provisioned

Related topic For more information about windows, see “About the main
application window” (2-10).

Cross Connect window and procedures Cross connects
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Connecting or disconnecting cross connects
....................................................................................................................................................................................................................................

Gathering information Do the following before connecting a cross connect.
............................................................................................................................................................

1 Verify that the subrack is provisioned by querying the subrack at
Provision > Equipment > Subrack.

............................................................................................................................................................

2 Verify that the signal is provisioned by querying the signal type at
Provision > Transmission > Signal Type.

Procedure ............................................................................................................................................................

1 Go to the Cross Connect window at Provision > Cross Connects >
Cross Connect.

............................................................................................................................................................

2 Click Bi-Directional or Uni-Directional in the Cross Connect Type
field.

............................................................................................................................................................

3 Select a value for the Signal Type field.

............................................................................................................................................................

4 Select the Port ID and the Signal ID for the following:

• From ID input port (A)

• To ID output port (B)

............................................................................................................................................................

5 Click Connect or Disconnect.

A

A

B

B

Bidirectional Unidirectional

A B

Cross Connect window and procedures Cross connects
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Adding or removing multi-points to an existing cross connect
....................................................................................................................................................................................................................................

Purpose The following procedure describes how to add or remove multi-points
to an existing cross connect.

Before you begin Verify that the cross connect is provisioned by querying the cross
connect at Provision > Cross Connects > Cross Connect.

Procedure ............................................................................................................................................................

1 Go to the Cross Connect window at Provision > Cross Connects >
Cross Connect.

............................................................................................................................................................

2 Click Uni-Directional in the Cross Connect Type field.

............................................................................................................................................................

3 Select a value for the Signal Type field.

............................................................................................................................................................

4 Select the Port ID and the Signal ID for the following:

• From ID input port (A)

• To ID output port (C)

............................................................................................................................................................

5 Click Connect or Disconnect.

A B

C

If existing cross connect
is unidirectional(A -> B)

If existing cross connect
is bidirectional(A -> B)

BA

A B

C

Cross Connect window and procedures Cross connects
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............................................................................................................................................................

6 Repeat Steps 4 and 5 to add or remove additional output ports.

A B

C

D

If existing cross connect
is unidirectional

From A To C
To D

(A -> B)

From A

B

C

BA
D

A

If existing cross connect
(A -> B) is bidirectional

From A To C
From B To D

Cross Connect window and procedures
Adding or removing multi-points to an
existing cross connect

Cross connects
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Connecting or disconnecting a loopback cross connect
....................................................................................................................................................................................................................................

Purpose Use this procedure to connect or disconnect a loopback cross connect.
Loopback cross connects are typically used to isolate trouble on the
port units during installation.

Procedure ............................................................................................................................................................

1 Go to the Cross Connect window at Provision > Cross Connects >
Cross Connect.

............................................................................................................................................................

2 Click Uni-Directional in the Cross Connect Type field.

............................................................................................................................................................

3 Select a value for the Signal Type field.

............................................................................................................................................................

4 Select the From ID address in the Port ID and the Signal ID fields.

............................................................................................................................................................

5 Select the To ID address in the Port ID and the Signal ID fields using
the identical address you used for the From ID.

Result:

............................................................................................................................................................

6 Click Connect or Disconnect.

A

A

Cross Connect window and procedures Cross connects
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Related topic

To insert Alarm Indication Signal (AIS) on this loopback cross
connect, go to Provision > Cross Connects > Insert AIS.

Cross Connect window and procedures
Connecting or disconnecting a loopback
cross connect

Cross connects
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Connect Roll window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose The Connect Roll window is used to provision rolls on cross
connects.

Window location Provision > Cross Connects > Connect Roll

Organisation This section is organised as follows:

• “Connect Roll window description” (4-16)

• “Doing a unidirectional roll of a unidirectional cross connect”
(4-19)

• “Doing a unidirectional roll of a bidirectional cross connect”
(4-20)

• “Doing a bidirectional roll of a bidirectional cross connect”
(4-23)

• “Rolling service in a network with no active service” (4-24)

• “Rolling service in a network with active service” (4-27)

Cross connects
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Connect Roll window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Connect Roll window.

Field descriptions The Connect Roll window has the following fields.

Field name Description

Cross Connect
Type

The Cross Connect Type field specifies the type of
cross connect you want to roll as either
unidirectional or bidirectional.

Bi-Directional A bidirectional roll of a bidirectional cross
connect replaces one two-way port with another
two-way port at one end of a connection. Use this
type of roll only if the cross connect you are
rolling is not carrying traffic.

D

D

A
D

D

B

B

BA
A B

A

For more information, see “Rolling service in a
network with no active service” (4-24).

Connect Roll window and procedures Cross connects
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Field name Description

Uni-Directional A unidirectional roll of a unidirectional cross
connect replaces one input with another. This type
of roll is accomplished in one step.

A B

D

A B

D

A unidirectional roll of a bidirectional cross
connect replaces one two-way port with another
two-way port at one end of a connection. Since
this type of roll minimises traffic interruption, use
this option when the cross connect you are rolling
is carrying traffic.

A
A
D
D

B
B

Connect
Bridge A

A

D
D

B

B

A
A
D
D

B
B

A
A
D
D

B
B

Roll

Disconnect
Bridge B

B

B
B

A
A
D
D

A
A
D
D

For more information, see “Rolling service in a
network with active service” (4-27).

Signal Type The Signal Type field specifies the signal level for
cross-connect signal provisioning as AU4_4c,
AU4, AU3, TU3, or TU12.

From ID The From ID fields specify the Port ID and Signal
ID addresses of the input port.

To ID The To ID fields specify the Port ID and Signal
ID addresses of the output port. When you select
ALL in this field, the system will simultaneously
roll all of the multi-point outputs connected to
this input.

New From ID The New From ID fields specify the address of
the new input port. When rolling a cross connect,
the new input port is the port to which the
original input port is moved.

Port ID The Port ID fields specify the physical location of
the entity.

Connect Roll window and procedures
Connect Roll window description

Cross connects
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Field name Description

Signal ID The Signal ID field specifies the signal level of
the address that you want to provision. The
options available for Signal ID depend on the
Signal Type.

For a description of the Signal ID options, see
“About signal layer addresses” (3-4).

Related topic For more information about windows, see “About the main
application window” (2-10).

Connect Roll window and procedures
Connect Roll window description

Cross connects
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Doing a unidirectional roll of a unidirectional cross connect
....................................................................................................................................................................................................................................

Purpose Use this procedure to replace the input of a unidirectional cross
connect with another.

Bridged unidirectional rolls You can also use the following procedure to perform a bridged
unidirectional roll. It is not necessary to specify the bridge because it
already exists.

Procedure ............................................................................................................................................................

1 Go to the Connect Roll window at Provision > Cross Connects >
Connect Roll.

............................................................................................................................................................

2 Click Uni-Directional in the Cross Connect Type field.

............................................................................................................................................................

3 Select a value for the Signal Type field.

............................................................................................................................................................

4 Select the Port ID and the Signal ID for the following:

• From ID input port (A)

• To ID output port (B)

• New From ID port (D)

............................................................................................................................................................

5 Click Roll.

A B

D

A B

D

Connect Roll window and procedures Cross connects
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Doing a unidirectional roll of a bidirectional cross connect
....................................................................................................................................................................................................................................

Purpose Use this procedure to replace one bidirectional port with another
bidirectional port at one end of a cross connect. Use this method
when the cross connect is carrying traffic.

Related topic

If the cross connect is not carrying traffic, see “Doing a bidirectional
roll of a bidirectional cross connect” (4-23).

Procedure overview The following is a list showing the entire procedure for performing a
unidirectional roll of a bidirectional cross connect:

• “Establish a bridge” (4-20)

• “Perform a unidirectional roll” (4-21)

• “Disconnect the old connection” (4-21)

Establish a bridge Establish a bridge from B to D on the B-to-A connection as
follows:
............................................................................................................................................................

1 Go to the Cross Connect window at Provision > Cross Connects >
Cross Connect.

............................................................................................................................................................

2 Click Uni-Directional in the Cross Connect Type field.

............................................................................................................................................................

3 Select a value for the Signal Type field.

............................................................................................................................................................

4 Select the Port ID and the Signal ID for the following:

• From ID input port (B)

• To ID output port (D)
Select ALL for multi-point cross connects.

............................................................................................................................................................

5 Click Connect.

A
A
D
D

B
B

Connect
Bridge A

A

D
D

B

B

Connect Roll window and procedures Cross connects
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Perform a unidirectional
roll

Perform a unidirectional roll from A to D on the A-to-B
connection as follows:
............................................................................................................................................................

1 Go to the Connect Roll window at Provision > Cross Connects >
Connect Roll.

............................................................................................................................................................

2 Click Uni-Directional in the Cross Connect Type field.

............................................................................................................................................................

3 Select a value for the Signal Type field.

............................................................................................................................................................

4 Select the Port ID and the Signal ID for the following:

• From ID input port (A)

• To ID output port (B)
Select ALL for multi-point cross connects.

• New From ID port (D)

............................................................................................................................................................

5 Click Roll.

Disconnect the old
connection

Disconnect the B-to-A connection as follows:

............................................................................................................................................................

1 Go to the Cross Connect window at Provision > Cross Connects >
Cross Connect.

............................................................................................................................................................

2 Click Uni-Directional in the Cross Connect Type field.

............................................................................................................................................................

3 Select a value for the Signal Type field.

A
A
D
D

B
B

A
A
D
D

B
B

Roll

Connect Roll window and procedures
Doing a unidirectional roll of a bidirectional
cross connect

Cross connects
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............................................................................................................................................................

4 Select the Port ID and the Signal ID for the following:

• From ID input port (B)

• To ID output port (A)
Select ALL for multi-point cross connects.

............................................................................................................................................................

5 Click Disconnect.

Disconnect
Bridge B

B

B
B

A
A
D
D

A
A
D
D

Connect Roll window and procedures
Doing a unidirectional roll of a bidirectional
cross connect

Cross connects
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Doing a bidirectional roll of a bidirectional cross connect
....................................................................................................................................................................................................................................

Purpose Use this procedure to replace one bidirectional port with another
bidirectional port at one end of a cross connect. Use this method
when the cross connect is not carrying traffic.

Related topic

If the cross connect is carrying traffic, see “Doing a unidirectional roll
of a bidirectional cross connect” (4-20).

Procedure ............................................................................................................................................................

1 Go to the Connect Roll window at Provision > Cross Connects >
Connect Roll.

............................................................................................................................................................

2 Click Bi-Directional in the Cross Connect Type field.

............................................................................................................................................................

3 Select a value for the Signal Type field.

............................................................................................................................................................

4 Select the Port ID and the Signal ID for the following:

• From ID input port (A)

• To ID output port (B)
Select ALL for multi-point cross connects.

• New From ID port (D)

............................................................................................................................................................

5 Click Roll.

D

D

A
D

D

B

B

BA
A B

A
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Rolling service in a network with no active service
....................................................................................................................................................................................................................................

Purpose Typically, service is moved from one facility to another by rolling the
service from the old facility to the new facility at the cross connects
on each end. One way of doing this is to do a bidirectional roll of a
bidirectional cross connect at each end. Use this method when there is
no service carried over the facility.

Procedure overview The following is a list showing the entire procedure for rolling service
in a network with no active service:

• “Perform a bidirectional roll at DACS 1” (4-24)

• “Perform a bidirectional roll at DACS 2” (4-25)

CAUTION
The method used in the following procedure causes service
interruption. If service is carried over the facility, see
“Rolling service in a network with active service” (4-27).

Perform a bidirectional roll
at DACS 1

Perform a bidirectional roll of a bidirectional cross connect at
one end using the following procedure:
............................................................................................................................................................

1 Go to the Connect Roll window at Provision > Cross Connects >
Connect Roll.

............................................................................................................................................................

2 Click Bi-Directional in the Cross Connect Type field.

............................................................................................................................................................

3 Select a value for the Signal Type field.

............................................................................................................................................................

4 Select the Port ID and the Signal ID for the following:

• From ID input port (B)

• To ID output port (A)

Connect Roll window and procedures Cross connects
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• New From ID port (E)

Legend:

1. DACS 1

2. DACS 2

3. Facility X

4. Facility Y

............................................................................................................................................................

5 Click Roll.

Perform a bidirectional roll
at DACS 2

Do a bidirectional roll of a bidirectional cross connect at the
other end using the following procedure:
............................................................................................................................................................

1 Go to the Connect Roll window at Provision > Cross Connects >
Connect Roll.

............................................................................................................................................................

2 Click Bi-Directional in the Cross Connect Type field.

............................................................................................................................................................

3 Select a value for the Signal Type field.

A
A

B
B

E

E

D
D

C
C

F

F

A
A

B
B

E

E

D
D

C
C

F

F

1 2

4

4

21

3

3

Connect Roll window and procedures
Rolling service in a network with no active
service
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............................................................................................................................................................

4 Select the Port ID and the Signal ID for the following:

• From ID input port (C)

• To ID output port (D)

• New From ID port (F)

Legend:

1. DACS 1

2. DACS 2

3. Facility X

4. Facility Y

............................................................................................................................................................

5 Click Roll.
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Rolling service in a network with active service
....................................................................................................................................................................................................................................

Purpose To move active service from one facility to another, do a
unidirectional roll of a bidirectional cross connect at DACS 1 and
DACS 2.

Procedure overview The following is a list showing the entire procedure for rolling service
in a network with active service:

• “Establish a bridge cross connect” (4-27)

• “Perform a unidirectional roll” (4-28)

• “Disconnect the ports” (4-30)

Establish a bridge cross
connect

Set up a bridge to the new facility in the send direction on each
end by doing the following:
............................................................................................................................................................

1 Go to the Cross Connect window at Provision > Cross Connects >
Cross Connect.

............................................................................................................................................................

2 Click Uni-Directional in the Cross Connect Type field.

............................................................................................................................................................

3 Select a value for the Signal Type field.

............................................................................................................................................................

4 Select the Port ID and the Signal ID for the following:

• From ID input port (A)

• To ID output port (E)

............................................................................................................................................................

5 Click Connect.

............................................................................................................................................................

6 Return to the Cross Connect window.

............................................................................................................................................................

7 Click Uni-Directional in the Cross Connect Type field.

............................................................................................................................................................

8 Select a value for the Signal Type field.

............................................................................................................................................................

9 Select the Port ID and the Signal ID for the following:

• From ID input port (D)

Connect Roll window and procedures Cross connects
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• To ID output port (F)

Legend:

1. DACS 1

2. DACS 2

3. Facility X

4. Facility Y

............................................................................................................................................................

10 Click Connect.

Perform a unidirectional
roll

Do a unidirectional roll of the inputs on each end using the
following procedure:
............................................................................................................................................................

1 Go to the Connect Roll window at Provision > Cross Connects >
Connect Roll.

............................................................................................................................................................

2 Click Uni-Directional in the Cross Connect Type field.

............................................................................................................................................................

3 Select a value for the Signal Type field.
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............................................................................................................................................................

4 Select the Port ID and the Signal ID for the following:

• From ID input port (B)

• To ID output port (A)

• New From ID port (E)

............................................................................................................................................................

5 Click Roll.

............................................................................................................................................................

6 Return to the Connect Roll window.

............................................................................................................................................................

7 Click Uni-Directional in the Cross Connect Type field.

............................................................................................................................................................

8 Select a value for the Signal Type field.

............................................................................................................................................................

9 Select the Port ID and the Signal ID for the following:

• From ID input port (C)

• To ID output port (D)

• New From ID port (F)
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E

D

D

C

C

F

F

A
A

B

B

E

E

D
D

C
C

F

F

1

1

2

2

4

4

3

3

Connect Roll window and procedures
Rolling service in a network with active
service

Cross connects

....................................................................................................................................................................................................................................

365–367–512
Issue 2, July 2002

Lucent Technologies 4 - 2 9



Legend:

1. DACS 1

2. DACS 2

3. Facility X

4. Facility Y

............................................................................................................................................................

10 Click Roll.

Disconnect the ports Disconnect ports B and C from the bridge connections on each
end by doing the following:
............................................................................................................................................................

1 Go to the Cross Connect window at Provision > Cross Connects >
Cross Connect.

............................................................................................................................................................

2 Click Uni-Directional in the Cross Connect Type field.

............................................................................................................................................................

3 Select a value for the Signal Type field.

............................................................................................................................................................

4 Select the Port ID and the Signal ID for the following:

• From ID input port (A)

• To ID output port (B)

............................................................................................................................................................

5 Click Disconnect.

............................................................................................................................................................

6 Return to the Cross Connect window.

............................................................................................................................................................

7 Click Uni-Directional in the Cross Connect Type field.

............................................................................................................................................................

8 Select a value for the Signal Type field.

............................................................................................................................................................

9 Select the Port ID and the Signal ID for the following:

• From ID input port (D)

Connect Roll window and procedures
Rolling service in a network with active
service
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• To ID output port (C)

Legend:

1. DACS 1

2. DACS 2

3. Facility X

4. Facility Y

............................................................................................................................................................

10 Click Disconnect.
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Insert AIS window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose The Insert AIS window is used to insert or clear Alarm Indication
Signal (AIS) on a provisioned cross connect.

Window location Provision > Cross Connects > Insert AIS

Organisation This section is organised as follows:

• “Insert AIS window description” (4-33)

• “Querying AIS” (4-35)

• “Provisioning AIS” (4-36)

Cross connects
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Insert AIS window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Insert AIS window.

Field descriptions The Insert AIS window has the following fields.

Field name Description

Signal Type The Signal Type field specifies the signal level for
cross-connect signal provisioning as AU4_4c,
AU4, AU3, TU3, or TU12.

To ID The To ID fields specify the Port ID and Signal
ID addresses for the output port of a provisioned
cross connect.

Port ID The Port ID field specifies the physical location
of the output port.

Signal ID The Signal ID field specifies the signal level of
the address that you want to provision. The
options available for Signal ID depend on the
Signal Type.

For a description of the Signal ID options, see
“About signal layer addresses” (3-4).

Insert AIS window and procedures Cross connects
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Related topic For more information about windows, see “About the main
application window” (2-10).

Insert AIS window and procedures
Insert AIS window description
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Querying AIS
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Use the Cross Connect window to query the Alarm Indication Signal
(AIS) status for the output port (To ID) of a provisioned cross
connect.

Reference:

Go to Provision > Cross Connects > Cross Connect.

Insert AIS window and procedures Cross connects
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Provisioning AIS
....................................................................................................................................................................................................................................

Before you begin Do the following before inserting AIS:

• Query the signal at Provision > Cross Connects > Cross
Connectand verify that the signal is cross connected.

• You cannot insert AIS on signals that are provisioned as
supervisory unequipped. Query the signal at Provision >
Transmission > High Order Path and verify that the signal is
provisioned as “Normal”.

Procedure ............................................................................................................................................................

1 Go to the Insert AIS window at Provision > Cross Connects > Insert
AIS.

............................................................................................................................................................

2 Select a value for the Signal Type field.

............................................................................................................................................................

3 Select the Port ID and the Signal ID for the To ID output port.

............................................................................................................................................................

4 Click Insert AIS or Clear AIS.

Insert AIS window and procedures Cross connects
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5 Monitoring control

Overview
....................................................................................................................................................................................................................................

Purpose “Monitoring control” contains the following information:

• General information about provisioning monitoring control and
alarm reporting

• Descriptions of the windows that are used to provision
monitoring control and alarm reporting

• Step-by-step procedures for provisioning the following:

- Monitoring control for transmission ports and for each signal
layer within an STM-N signal

- Alarm Indication Signal (AIS) and Remote Defect Indication
(RDI) alarm reporting for each signal layer within an
STM-N signal

Organisation The organisation is as follows:

• “Background information” (5-2)

• “Port Monitoring window and procedures” (5-6)

• “Signal Monitoring window and procedures” (5-12)
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Background information

Overview
....................................................................................................................................................................................................................................

Purpose This section contains background information about provisioning
monitoring control.

Organisation This section is organised as follows:

• “General information about monitoring control” (5-3)

• “The monitoring control provisioning process” (5-5)

Monitoring control
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General information about monitoring control
....................................................................................................................................................................................................................................

What is monitoring
control?

The system can be provisioned to monitor transmission ports and
signals for defects and failures, and to report alarm conditions. Each
transmission port and each signal layer within an STM-N signal can
be provisioned as monitored or as not monitored. The following table
shows the alarm conditions that are monitored if the corresponding
layer is provisioned as monitored.

Layer Alarm

Port STMcLOS — Loss of incoming STM Signal

RS RScLOF — Loss of STM Frame

MS MScDEG — Multiplex Section Degraded bit error
rate

MScFOP — Multiplex Section Failure Of Protocol

AU AUcLOP — Administrative Unit Loss Of Pointer

HP HPcDEG — Higher order Path Degraded bit error
rate

HPcPLM — Higher order Path Payload Label
Mismatch

HPcTIM — Higher order Path Trace Identifier
Mismatch

HPcUNEQ — Higher order Path Unequipped

TUcLOP — Tributary Unit Loss Of Pointer

TU TUcLOM — Tributary Unit Loss Of Multiframe

LP LPcDEG — Lower order Path Degraded bit error
rate

LPcTIM — Lower order Path Trace Identifier
Mismatch

LPcUNEQ — Lower order Path Unequipped

AIS and RDI alarm
reporting

The system monitors transmission defects and reports Alarm
Indication Signal (AIS) and Remote Defect Indication (RDI) alarms
only if the following provisioning tasks have been performed:

• The appropriate signal layers are provisioned as monitored
(MON).

• AIS and RDI alarm reporting are enabled for the appropriate
signal layers.

The following table shows the signal layers for which the reporting of
AIS, RDI, or both can be enabled or disabled.

Background information Monitoring control
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Layer Alarm

MS MScAIS

MScRDI

AU AUcAIS

HP HPcRDI

TU TUcAIS

LP LPcRDI

Background information
General information about monitoring
control

Monitoring control
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The monitoring control provisioning process
....................................................................................................................................................................................................................................

Definition Monitoring control provisioning is the process of specifying the ports
and SDH signal layers for which you want alarms and defects
reported.

Provisioning monitoring
control

To provision monitoring control, do the following:

............................................................................................................................................................

1 Use the Port Monitoring window to query and provision a monitoring
mode for transmission ports.

............................................................................................................................................................

2 Use the Signal Monitoring window to query and provision a
monitoring mode for transmission signal layers.

............................................................................................................................................................

3 Use the Signal Monitoring window to query and provision AIS or
RDI alarm reporting for transmission signal layers.

Background information Monitoring control
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Port Monitoring window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the Port Monitoring window to query and provision the
monitoring control mode for a port.

Window location Provision > Monitoring Control > Port Monitoring

Organisation This section is organised as follows:

• “Port Monitoring window description” (5-7)

• “Querying port monitoring” (5-9)

• “Port Monitoring query results” (5-10)

• “Assigning port monitoring” (5-11)

Monitoring control
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Port Monitoring window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Port Monitoring window.

Field descriptions The Port Monitoring window has the following fields.

Field name Description

Port ID The Port ID fields specify the physical location of
a port.

For a description of the Port ID options, see
“About physical layer addresses” (3-3).

MON Selecting the MON field turns on alarm and
defect monitoring and reporting for the specified
port.

NMON Selecting the NMON field turns off alarm and
defect monitoring and reporting for the specified
port. No transmission alarms or defects will be
reported for a port with a monitoring mode of
NMON.

NMON is the default value for monitoring mode.

Port Monitoring window and procedures Monitoring control
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Field name Description

AUTO Selecting the AUTO field turns on automatic
alarm and defect monitoring and reporting for the
specified port. With automatic monitoring, the
port remains in NMON (not monitored) mode
until a valid signal is received for a predetermined
amount of time, then the port changes
automatically to MON (monitored) mode. The
amount of time that a valid signal must be
received is set by the pre-service timer value.

For a description of the pre-service timer, see
“Pre-Service Timer ” (12-13).

Related topic For more information about windows, see “About the main
application window” (2-10).

Port Monitoring window and procedures
Port Monitoring window description

Monitoring control
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Querying port monitoring
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Port Monitoring window at Provision > Monitoring Control
> Port Monitoring.

............................................................................................................................................................

2 Select the Port ID.

Reference:

For more information about Port IDs, see “About physical layer
addresses” (3-3).

............................................................................................................................................................

3 Click Query.

Port Monitoring window and procedures Monitoring control
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Port Monitoring query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results for
the Port Monitoring window.

Important! The data displayed on this screen may not be typical.

Results field descriptions The following information appears in the Port Monitoring Query
Results window.

Column Description

Port ID Displays the physical location of the port.

Mode Displays the monitoring mode for the port.
The values are as follows:

• Monitored

• Not Monitored

Related topic For more information about windows, see “About the main
application window” (2-10).

Port Monitoring window and procedures Monitoring control
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Assigning port monitoring
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Port Monitoring window at Provision > Monitoring Control
> Port Monitoring.

............................................................................................................................................................

2 Select the Port ID.

Reference:

For more information about Port IDs, see “About physical layer
addresses” (3-3).

............................................................................................................................................................

3 Select one of the following values for the monitoring control mode:

• MON

• NMON

• AUTO

............................................................................................................................................................

4 Click Apply.

Port Monitoring window and procedures Monitoring control
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Signal Monitoring window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the Signal Monitoring window to do the following:

• Query and provision alarm and defect monitoring for a signal
layer.

• Enable or disable AIS or RDI alarm reporting for a signal layer.

Window location Provision > Monitoring Control > Signal Monitoring

Organisation This section is organised as follows:

• “Signal Monitoring window description” (5-13)

• “Querying signal monitoring and alarm reporting” (5-15)

• “Signal Monitoring query results” (5-16)

• “Assigning RS and MS signal monitoring” (5-18)

• “Assigning AU, HP, TU, and LP signal monitoring” (5-19)

• “Turning AIS or RDI alarm reporting on or off” (5-20)

Monitoring control
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Signal Monitoring window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Signal Monitoring window.

Field descriptions The Signal Monitoring window has the following fields.

Field name Description

Port ID The Port ID fields specify the physical location of
a port.

For a description of the Port ID options, see
“About physical layer addresses” (3-3).

Signal ID The Signal ID field specifies the multiplexing
structure for a signal that you want to query or
provision.

For a description of the Signal ID options, see
“About signal layer addresses” (3-4).

Signal Monitoring window and procedures Monitoring control
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Field name Description

Layer The Layer field specifies the SDH signal layer for
provisioning layer monitoring and alarm reporting.
The valid values for the Layer field depend on the
Signal ID that you specify. The following values
may appear:

• RS — Regenerator Section

• MS — Multiplex Section

• AU — Administrative Unit

• HP — Higher order Path

• TU — Tributary Unit

• LP — Lower order Path

MON Selecting the MON field turns on alarm and
defect monitoring and reporting for the specified
signal layer.

NMON Selecting the NMON field turns off alarm and
defect monitoring and reporting for the specified
signal layer. No transmission alarms or defects
will be reported for a signal layer with a
monitoring mode of NMON.

NMON is the default value for layer monitoring.

AIS Active Selecting the AIS Active field enables the
reporting of AIS alarms for the specified SDH
signal layer.

AIS Inactive Selecting the AIS Inactive field disables the
reporting of AIS alarms for the specified SDH
signal layer.

AIS Inactive is the default value for layer alarm
reporting.

RDI Active Selecting the RDI Active field enables the
reporting of RDI alarms for the specified SDH
signal layer.

RDI Active is the default value for layer alarm
reporting.

RDI Inactive Selecting the RDI Inactive field disables the
reporting of RDI alarms for the specified SDH
signal layer.

Related topic For more information about windows, see “About the main
application window” (2-10).

Signal Monitoring window and procedures
Signal Monitoring window description
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Querying signal monitoring and alarm reporting
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Signal Monitoring window at Provision > Monitoring
Control > Signal Monitoring.

............................................................................................................................................................

2 Select the Port ID and the Signal ID.

............................................................................................................................................................

3 Click Query.

Signal Monitoring window and procedures Monitoring control
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Signal Monitoring query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results for
the Signal Monitoring window.

Important! The data displayed on this screen may not be typical.

Results field descriptions The following information appears in the Signal Monitoring Query
Results window.

Column Description

Port ID Displays the physical location of the port.

Signal ID Displays the signal address.

SDH Layer Displays the SDH signal layer associated with the
Signal ID.
The values are as follows:

• RS — Regenerator Section

• MS — Multiplex Section

• AU — Administrative Unit

• HP — Higher order Path

• TU — Tributary Unit

• LP — Lower order Path

All Alarms Displays the monitoring status for all alarms.
The values are as follows:

• Monitored

• Not Monitored

AIS Only Displays the monitoring status for the AIS alarm.
The values are as follows:

• Monitored

• Not Monitored

Signal Monitoring window and procedures Monitoring control
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Column Description

RDI Only Displays the monitoring status for the RDI alarm.
The values are as follows:

• Monitored

• Not Monitored

Related topic For more information about windows, see “About the main
application window” (2-10).

Signal Monitoring window and procedures
Signal Monitoring query results
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Assigning RS and MS signal monitoring
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Signal Monitoring window at Provision > Monitoring
Control > Signal Monitoring.

............................................................................................................................................................

2 Select the Port ID.

............................................................................................................................................................

3 Select RS or MS for the Layer field in Layer Monitoring.

............................................................................................................................................................

4 Select one of the following values:

• MON

• NMON

............................................................................................................................................................

5 Click Apply.

Signal Monitoring window and procedures Monitoring control
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Assigning AU, HP, TU, and LP signal monitoring
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Signal Monitoring window at Provision > Monitoring
Control > Signal Monitoring.

............................................................................................................................................................

2 Select the Port ID and the Signal ID.

............................................................................................................................................................

3 Select a value for the Layer field in Layer Monitoring.

............................................................................................................................................................

4 Select one of the following values:

• MON

• NMON

............................................................................................................................................................

5 Click Apply.

Signal Monitoring window and procedures Monitoring control
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Turning AIS or RDI alarm reporting on or off
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Signal Monitoring window at Provision > Monitoring
Control > Signal Monitoring.

............................................................................................................................................................

2 Select the Port ID and the Signal ID.

............................................................................................................................................................

3 Select a value for the Layer field in Layer Alarm Reporting.

............................................................................................................................................................

4 Select one of the following values:

• Either AIS Active or AIS Inactive

• Either RDI Active or RDI Inactive

............................................................................................................................................................

5 Click Apply.

Signal Monitoring window and procedures Monitoring control
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6 Equipment

Overview
....................................................................................................................................................................................................................................

Purpose “Equipment” contains the following information:

• General information about equipment provisioning

• Descriptions of the windows that are used to provision equipment

• Step-by-step procedures for provisioning racks, subracks, and
units

Organisation The organisation is as follows:

• “Background information” (6-2)

• “Rack window and procedures” (6-14)

• “Subrack window and procedures” (6-22)

• “Unit window and procedures” (6-35)
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Background information

Overview
....................................................................................................................................................................................................................................

Purpose This section contains background information about equipment
provisioning.

Organisation This section is organised as follows:

• “General information about equipment provisioning” (6-3)

• “Subrack degrade inhibit” (6-5)

• “MCLAN hub ports” (6-4)

• “About deleting units” (6-6)

• “The equipment provisioning process” (6-7)

• “Single-fibre PSA port subrack configurations” (6-9)

• “Dual-fibre PSA port subrack configurations” (6-10)

• “Single-fibre PSC port subrack configurations” (6-11)

• “Dual-fibre PSC port subrack configurations” (6-12)

• “Quad-fibre PSC port subrack configurations” (6-13)

Equipment
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General information about equipment provisioning
....................................................................................................................................................................................................................................

Definition Equipment provisioning is the process of specifying the configuration
of the system equipment. This includes specifying where equipment
racks are located in the office, where a port subrack is located in an
equipment rack, and the configuration of port subracks.

Equipment you can
provision

You can provision only port racks, port subracks, and port units.

About provisioning the
MC rack and the MS rack

The system provisions the subracks and units in the Matrix and
Control (MC) rack and in the Matrix and Synchronisation (MS) rack
when the system is installed. You cannot change the configuration of
this equipment.

Interface mixing Interface mixing allows the flexible assignment of different
transmission interface types and different types of protection in a PSA
subrack.

For more information about this feature, see one of the following
topics:

• “Single-fibre PSA port subrack configurations” (6-9)

• “Dual-fibre PSA port subrack configurations” (6-10)

Background information Equipment
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MCLAN hub ports
....................................................................................................................................................................................................................................

MCLAN hub port
assignments

The following table displays the MCLAN hub port assignments. The
MCLAN hub ports do not need to be provisioned. The system
automatically assigns a hub port when a subrack is created.

Port
number

Is assigned to...

1 MC working

2 MC protection

3 MS working

4 MS protection

5 PSA-4 or PSC-4

6 PSA-5 or PSC-5

7 PSA-6 or PSC-6

8 PSA-7 or PSC-7

9 PSA-8 or PSC-8

10 PSA-9 or PSC-9

11 PSA-10 or PSC-10

12 PSA-11 or PSC-11

13 PSA-12 or PSC-12

14 PSA-13 or PSC-13

15 PSA-14 or PSC-14

16 PSA-15 or PSC-15

17 PSA-16 or PSC-16

18 PSA-17 or PSC-17

19 PSA-18 or PSC-18

20 PSA-19 or PSC-19

Background information Equipment
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Subrack degrade inhibit
....................................................................................................................................................................................................................................

What is subrack degrade
inhibit?

The Subrack window has a Degrade Inhibit field. If checked
(enabled), the Degrade Inhibit option inhibits matrix slice protection
switching for the specified port subrack. If the field is unchecked
(blank), the Degrade Inhibit option is disabled.

Why inhibit matrix slice
protection switching?

Matrix slice protection is equipment protection for the cross-connect
matrix and internal transmission paths. The matrix and internal
transmission paths are composed of ten sets of components, called
slices. Under normal circumstances, slices one through eight, the
working slices, carry all system traffic. Slices nine and ten provide
protection. A protection slice can substitute for one of the working
slices or for the other protection slice if there is an equipment failure.

When a subrack is created, the Degrade Inhibit option is automatically
set to enabled. This prevents the subrack provisioning process from
causing a matrix slice protection switch.

Background information Equipment
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About deleting units
....................................................................................................................................................................................................................................

About provisioning a unit
after deleting it

A unit is provisioned automatically when you insert it into a port
subrack. Port units are the only units you can delete from the system
database. Deleting a unit makes it nonoperational until it is
reprovisioned by physically removing it from the subrack and
re-inserting it or by initialising the unit.

Related topics

Use the following windows to initialise a unit:

• To initialise an SRC, use the Subrack Control window at
Maintenance > Controller Maintenance > Subrack Control.

• To intialise any other unit, use the Unit Control window at
Maintenance > Controller Maintenance > Unit Control.

About deleting units that
are part of an equipment

protection group

To delete a unit that is part of an equipment protection group, the
following conditions must be true:

• If the unit is the protection unit of a 1:8 equipment protection
group, the unit cannot be active.

• If the unit is a working unit of a 1:8 equipment protection group,
the unit must be active.

Related topic

To query STM-1 1:8 protection groups and perform protection switch
requests, use the STM1 1:8 window at Protection > Equipment >
STM1 1:8.

What happens when you
delete a port unit?

When you delete port units, the following will occur:

• If there is a corresponding Interface Unit (IU), the IU is also
deleted.

• For an STM-1 protection unit, the equipment protection group is
also deleted.

• All port parameters are reset to the default values.

Related topic For more information about deleting equipment, see “The process for
deleting units” (6-7).

Background information Equipment
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The equipment provisioning process
....................................................................................................................................................................................................................................

The process for adding a
subrack to an existing rack

To add a subrack to an existing rack, do the following:

............................................................................................................................................................

1 Use the Subrack window to query and provision port subracks.

............................................................................................................................................................

2 Insert port and interface units into the subracks.

The process for adding
units to an existing rack

and subrack

To add units to an existing rack and subrack, do the following:

............................................................................................................................................................

1 Insert port and interface units into the subracks.

The process for deleting
units

To delete units, do the following:

............................................................................................................................................................

1 Find and delete any unit-related provisioning, such as a line-timing
reference or an MSP protection group.

Reference:

For more information, see “Before deleting a unit” (6-40).

............................................................................................................................................................

2 Use the Unit window to delete units.

Reference:

Use the Unit window at Provision > Equipment > Unit.

The process for deleting
subracks and racks

To delete subracks, do the following:

............................................................................................................................................................

1 Find and delete any unit-related provisioning, such as a line-timing
reference or an MSP protection group.

Reference:

For more information, see “Before deleting a unit” (6-40).

............................................................................................................................................................

2 Use the Unit window to delete units.

Reference:

Go to Provision > Equipment > Unit.

............................................................................................................................................................

3 Use the Subrack window to delete subracks.

Background information Equipment
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Reference:

Go to Provision > Equipment > Subrack.

............................................................................................................................................................

4 Use the Rack window to delete racks.

Reference:

Go to Provision > Equipment > Rack.

Background information
The equipment provisioning process

Equipment
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Single-fibre PSA port subrack configurations
....................................................................................................................................................................................................................................

About single-fibre PSA
configurations

The single-fibre Port Subrack A (PSA) configuration supports up to 32
STM-1 equivalents and is best suited for Multiplex Section Protection
(MSP). You can equip a single-fibre PSA subrack with STM-1 port
units and any combination of optical or electrical interface units.

The port units can be configured in any of the following ways:

• Unprotected

• 1:8 equipment protection

• MSP

• Both 1:8 equipment protection and MSP

MSP and single-fibre PSA
configurations

MSP can be assigned to a pair of ports on adjacent port units. The
working port is on an odd-numbered port unit, and the protection port
is the port with the same number on the even-numbered port unit to
the right of the working port. ITU MSP, ANSI MSP, or NTT MSP can
be used on any combination of STM-1 port units and electrical or
optical interface units.

Since the even-numbered port units are always designated as the
protection ports in an MSP group, and since single-fibre PSA subracks
were designed to be used with MSP, bandwidth is not allocated to the
even-numbered port units in a single-fibre PSA subrack. Consequently,
you can provision cross connections only for ports on odd-numbered
port units in a single-fibre PSA subrack.

Equipment protection You can configure 1:8 equipment protection on a per-shelf basis. The
system automatically creates an equipment protection group when an
STM-1 port unit is inserted into slot 9 (upper shelf) or slot 19 (lower
shelf). The protection unit can substitute for any port unit that has an
electrical interface unit (IU) and is not provisioned for MSP.
Even-numbered port units with electrical IUs will be protected, even
though they do not carry traffic.

Related topics For more information, see one of the following topics:

• “General information about MSP” (9-5)

• “Creating a single-fibre subrack” (6-30)

Background information Equipment

....................................................................................................................................................................................................................................
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Dual-fibre PSA port subrack configurations
....................................................................................................................................................................................................................................

About dual-fibre PSA
configurations

The dual-fibre PSA subrack configuration supports up to 64 STM-1
equivalents and is best suited for 1:8 equipment protection or for
unprotected port units. You can equip a dual-fibre PSA subrack with
STM-1 port units and any combination of optical or electrical
interface units.

MSP and dual-fibre PSA
configurations

You can provision Multiplex Section Protection (MSP) in a dual-fibre
subrack, but the overall system bandwidth will be reduced. Bandwidth
is reduced because MSP uses two physical ports, but carries the
bandwidth of one port.

Equipment protection Because the dual-fibre subrack is designed to be used with 1:8
equipment protection or unprotected port units, bandwidth is allocated
to all port units in the subrack except port units 9 and 19, which are
used for 1:8 equipment protection.

You can configure 1:8 equipment protection on a per-shelf basis. The
system automatically creates an equipment protection group when an
STM-1 port unit is inserted into slot 9 (upper shelf) or slot 19 (lower
shelf). The protection unit can substitute for any port unit that has an
electrical interface unit and is not provisioned for MSP.

Related topics For more information, see one of the following topics:

• “General information about MSP” (9-5)

• “Creating a dual-fibre PSA subrack” (6-30)

Background information Equipment
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Single-fibre PSC port subrack configurations
....................................................................................................................................................................................................................................

About single-fibre PSC
configurations

The single-fibre Port Subrack C (PSC) configuration supports up to 32
STM-1 equivalents. It can be equipped with STM-4 or STM-16 port
units. You cannot mix STM-16 and STM-4 port units in the same
subrack. You can equip a single-fibre PSC subrack with up to 8
STM-16 interfaces or up to 32 STM-4 interfaces.

Because bandwidth is allocated only to port units 1 and 3 in a
single-fibre PSC subrack, it is best suited for applications that require
only a small number of STM-16 or STM-4 interfaces.

MSP and single-fibre PSC
configurations

MSP can be assigned to a pair of ports on adjacent port units. The
working port is on an odd-numbered port unit, and the protection port
is the port with the same number on the even-numbered port unit to
the right of the working port. ITU MSP or ANSI MSP can be used on
STM-16 or STM-4 ports.

No bandwidth is allocated to port units 2, 4, 5, 6, 7, and 8 in the
single-fibre PSC configuration and, therefore, cross connects cannot
be provisioned on these port units. Port units 5 and 6, or 7 and 8 can
support other port functions such as line timing references or
supervisory unequipped signal generation.

Equipment protection You cannot use 1:8 equipment protection in a single-fibre PSC
subrack.

Related topics For more information, see one of the following topics:

• “General information about MSP” (9-5)

• “Creating a single-fibre subrack” (6-30)

Background information Equipment
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Dual-fibre PSC port subrack configurations
....................................................................................................................................................................................................................................

About dual-fibre PSC
configurations

The dual-fibre PSC subrack configuration supports up to 64 STM-1
equivalents. It can be equipped with STM-4 or STM-16 port units.
You cannot mix STM-16 and STM-4 port units in the same subrack.
You can equip a dual-fibre PSC subrack with up to 8 STM-16
interfaces or up to 32 STM-4 interfaces.

The dual-fibre PSC subrack is best suited for Multiplex Section
Protection (MSP), because bandwidth is allocated only to the
odd-numbered port units. Port units in a dual-fibre PSC subrack can
be unprotected. However, because bandwidth is not allocated to the
even-numbered ports units, cross connects can be provisioned only for
ports on odd-numbered port units.

MSP and dual-fibre PSC
configurations

MSP can be assigned to a pair of ports on adjacent port units. The
working port is on an odd-numbered port unit, and the protection port
is the port with the same number on the even-numbered port unit to
the right of the working port. ITU MSP or ANSI MSP can be used on
STM-16 or STM-4 ports.

Since the even-numbered port units are always designated as the
protection ports in an MSP group, and since dual-fibre PSC subracks
were designed to be used with MSP, bandwidth is not allocated to the
even-numbered port units in a dual-fibre PSC subrack. Consequently,
you can provision cross connections only for ports on odd-numbered
port units in a dual-fibre PSC subrack.

Equipment protection You cannot use 1:8 equipment protection in a dual-fibre PSC subrack.

Related topics For more information, see one of the following topics:

• “General information about MSP” (9-5)

• “Creating a dual-fibre PSC subrack” (6-31)

Background information Equipment
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Quad-fibre PSC port subrack configurations
....................................................................................................................................................................................................................................

About quad-fibre PSC
configurations

The quad-fibre PSC subrack configuration supports up to 128 STM-1
equivalents. It can be equipped with STM-4 or STM-16 port units.
You cannot mix STM-16 and STM-4 port units in the same subrack.
You can equip a quad-fibre PSC subrack with up to eight STM-16 or
eight STM-4 port units.

The quad-fibre PSC subrack is best suited for unprotected port units,
because bandwidth is allocated to all port units in the subrack.

MSP and quad-fibre PSC
configurations

You can provision Multiplex Section Protection (MSP) in a quad-fibre
subrack, but the overall system bandwidth will be reduced. Bandwidth
is reduced because MSP uses two physical ports, but carries the
bandwidth of one port.

Related topics For more information, see one of the following topics:

• “General information about MSP” (9-5)

• “Creating a quad-fibre PSC subrack” (6-31)

Background information Equipment
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Rack window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the Rack window to query and provision equipment racks. You
cannot create or delete the Main Controller and
Matrix/Synchronisation racks (racks 1 and 2); you can change only
the rack location. You can create, delete, or change port racks (racks 3
through 99).

Window location Provision > Equipment > Rack

Organisation This section is organised as follows:

• “Rack window description” (6-15)

• “Querying a rack” (6-16)

• “Rack query results” (6-17)

• “Creating a rack” (6-19)

• “Changing a rack” (6-20)

• “Deleting a rack” (6-21)

Equipment

....................................................................................................................................................................................................................................
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Rack window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Rack window.

Field descriptions The Rack window has the following fields.

Field name Description

Rack ID The Rack ID field specifies the identification
number for an equipment rack. The Rack ID must
be unique, and it is required to create a rack.
Once a rack is created, the Rack ID cannot be
changed.
The following values are available:

• 1 — Main Controller and part of Matrix and
Synchronisation rack

• 2 — Matrix and Synchronisation rack

• 3–99 — Port rack

Rack Location The Rack Location field specifies the location of
an equipment rack in the office. This field is
optional when creating a rack and does not affect
the operation of the system.

This field accepts up to 12 alphanumeric
characters. The characters , ; : # { } space are not
allowed.

Related topic For general information about windows, see “About the main
application window” (2-10).

Rack window and procedures Equipment
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Querying a rack
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Rack window at Provision > Equipment > Rack.

............................................................................................................................................................

2 Select All Racks or a specific Rack ID.

............................................................................................................................................................

3 Click Query.

Rack window and procedures Equipment
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Rack query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration as an example of query results for an
All Racks query on the Rack window.

Important! The data displayed on this screen may not be typical.

Results field descriptions The Rack Query Results window has the following fields.

Column Description

Rack ID Displays the identification number for an
equipment rack.
The following values are available:

• 1 — Main Controller and part of Matrix and
Synchronisation rack

• 2 — Matrix and Synchronisation rack

• 3–99 — Port rack

Rack Location Displays the location of an equipment rack in the
office, as provisioned by the user.

Subrack ID Displays the identification number for each
subrack in a rack.

Subrack Type Displays one of the following values:

• MC — Main Controller subrack

• MS — Matrix and Synchronisation subrack

• PSA — Port subrack A

• PSC — Port subrack C

Rack window and procedures Equipment
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Column Description

Subrack
Position

Displays one of the following values:

• Top — Port and Main Controller subracks

• Bottom — Port subracks

• All — Matrix and Synchronisation subracks

Related topic For general information about windows, see “About the main
application window” (2-10).

Rack window and procedures
Rack query results

Equipment
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Creating a rack
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Rack window at Provision > Equipment > Rack.

............................................................................................................................................................

2 Select the Rack ID.

............................................................................................................................................................

3 Specify a Rack Location (optional).

............................................................................................................................................................

4 Click Create.

Rack window and procedures Equipment
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Changing a rack
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Rack window at Provision > Equipment > Rack.

............................................................................................................................................................

2 Select the Rack ID.

............................................................................................................................................................

3 Specify a Rack Location.

............................................................................................................................................................

4 Click Change.

Rack window and procedures Equipment
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Deleting a rack
....................................................................................................................................................................................................................................

Before you begin You can delete only port racks that do not have a subrack provisioned.

Procedure ............................................................................................................................................................

1 Go to the Rack window at Provision > Equipment > Rack.

............................................................................................................................................................

2 Query the rack that you want to delete.

..........................................................................................................................................................

3 Are subracks provisioned?

If Then

Subracks are provisioned. Go to the Subrack window and
delete the subracks.

Subracks are not provisioned, or
after the subracks are deleted.

Go to the next step.

............................................................................................................................................................

4 Select the Rack ID.

............................................................................................................................................................

5 Click Delete.

Rack window and procedures Equipment
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Subrack window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the Subrack window to query subracks and to provision port
subracks. You can also use this window to provision the optical-fibre
connections for each port subrack.

When creating a port subrack, you can provision the default
multiplexing structure as either AU4 or TU12.

Window location Provision > Equipment > Subrack

Organisation This section is organised as follows:

• “Subrack window description” (6-23)

• “Querying a subrack” (6-26)

• “Subrack query results” (6-27)

• “Creating a subrack” (6-30)

• “Deleting a subrack” (6-32)

• “Enabling or disabling degrade inhibit for a subrack” (6-34)

Equipment

....................................................................................................................................................................................................................................
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Subrack window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Subrack window.

Field descriptions The Subrack window has the following fields.

Field name Description

Subrack ID The Subrack ID fields specify the subrack
identification number.

To create a subrack, you must specify a unique
Subrack ID.

Degrade Inhibit If checked, the Degrade Inhibit field inhibits
matrix slice protection switching for the specified
port subrack. If unchecked, matrix slice protection
switching is allowed.

For more information about this feature, see
“Subrack degrade inhibit” (6-5).

Rack ID The Rack ID field specifies the identification
number for an equipment rack. The Rack ID is
required to create a subrack.
The following values are available:

• 1 — Main Controller and part of the Matrix
and Synchronisation rack

• 2 — Matrix and Synchronisation rack

• 3–99 — Port rack

Subrack window and procedures Equipment
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Field name Description

Subrack
Configuration

The Subrack Configuration field specifies the
configuration of a port subrack.
The following values are available:

• Single Fibre — PSA or PSC

• Dual Fibre — PSA or PSC

• Quad Fibre — PSC only

Subrack
Position

The Subrack Position field specifies the position
of a subrack in an equipment rack. A port rack
can be equipped with two port (PSA or PSC)
subracks. A port subrack can be installed in the
top or bottom half of a port rack.
The values are as follows:

• Top — Port subracks

• Bottom — Port subracks

• All — MC and MS subracks

Fibre 1 The Fibre 1 field specifies the first optical-fibre
connection from the BSIUs to ports on the
BSSUs. All fibres between the BSIUs and BSSUs
for a given port subrack will go to the same
BSSU port number on each of the BSSUs. You
must select a value for the Fibre 1 field for all
port subrack configurations.
The following values are available:

• 1–8 for a 256 system

• 1–16 for a 512 system

Fibre 2 The Fibre 2 field specifies the second optical-fibre
connection from the BSIUs to ports on the
BSSUs. All fibres between the BSIUs and BSSUs
for a given port subrack will go to the same
BSSU port number on each of the BSSUs. You
must select a value for the Fibre 2 field for
dual-fibre and quad-fibre subrack configurations.
The following values are available:

• 1–8, NONE for a 256 system

• 1–16, NONE for a 512 system

Subrack window and procedures
Subrack window description

Equipment
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Field name Description

Fibre 3 The Fibre 3 field specifies the third optical-fibre
connection from the BSIUs to ports on the
BSSUs. All fibres between the BSIUs and BSSUs
for a given port subrack will go to the same
BSSU port number on each of the BSSUs. You
must select a value for the Fibre 3 field for
quad-fibre subrack configurations.
The following values are available:

• 1–8, NONE for a 256 system

• 1–16, NONE for a 512 system

Fibre 4 The Fibre 4 field specifies the fourth optical-fibre
connection from the BSIUs to ports on the
BSSUs. All fibres between the BSIUs and BSSUs
for a given port subrack will go to the same
BSSU port number on each of the BSSUs. You
must select a value for the Fibre 4 field for
quad-fibre subrack configurations.
The following values are available:

• 1–8, NONE for a 256 system

• 1–16, NONE for a 512 system

Default
Multiplexing

The Default Multiplexing field specifies the
default multiplexing structure that will be assigned
to port units when they are inserted into the
subrack. If necessary, you can change a port’s
default multiplexing structure after you insert a
port unit into the subrack.
The following values are available for the port
subracks:

• AU4

• TU12 (default)

Related topics For more information, see one of the following topics:

• “Single-fibre PSA port subrack configurations” (6-9)

• “Dual-fibre PSA port subrack configurations” (6-10)

• “Single-fibre PSC port subrack configurations” (6-11)

• “Dual-fibre PSC port subrack configurations” (6-12)

• “Quad-fibre PSC port subrack configurations” (6-13)

• For general information about windows, see “About the main
application window” (2-10).

Subrack window and procedures
Subrack window description
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Querying a subrack
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Subrack window at Provision > Equipment > Subrack.

..........................................................................................................................................................

2 Do you want to query all subracks or a specific subrack?

If Then

You want to query all subracks Select the ALL value for the
Subrack field.

You want to query a specific
subrack

Select a value other than ALL
for the Subrack and Number
fields.

............................................................................................................................................................

3 Click Query.

Subrack window and procedures Equipment
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Subrack query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results for
the Subrack window.

Important! The data displayed on this screen may not be typical.

Results field descriptions The Subrack Query Results window has the following fields.

Column Description

Rack ID The Rack ID field displays the identification
number for an equipment rack.
The following values are available:

• 1 — Main Controller and part of Matrix and
Synchronisation rack

• 2 — Matrix and Synchronisation rack

• 3–99 — Port rack

Subrack ID The Subrack ID field displays the identification
number for each subrack in a rack.
The following values are available:

• 1 — Working Main Controller subrack

• 2 — Protection Main Controller subrack

• 3 — Matrix and Synchronisation subrack

• 4–11 — port subrack on a 256 system

• 4–19 — port subrack on a 512 system

Subrack Type The Subrack Type field displays one of the
following values:

• MC — Main Controller subrack

• MS — Matrix and Synchronisation subrack

• PSA — Port Subrack A

• PSC — Port Subrack C

Subrack window and procedures Equipment
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Column Description

Subrack
Position

The Subrack Position field displays one of the
following values:

• Top — Port or Main Controller subracks

• Bottom — Port subracks

• All — Matrix/Synchronisation subrack

Subrack
Configuration

The Subrack Configuration field displays one of
the following values:

• STM16 - Single Fibre (PSC subracks)

• STM16 - Dual Fibre (PSC subracks)

• STM16 - Quad Fibre (PSC subracks)

• STM4 - Single Fibre (PSC subracks)

• STM4 - Dual Fibre (PSC subracks)

• STM4 - Quad Fibre (PSC subracks)

• STM1 - Single Fibre (PSA subracks)

• STM1 - Dual Fibre (PSA subracks)

• Blank (Main Controller and Matrix/
Synchronisation subracks)

Fibre 1 The Fibre 1 field displays the Fibre 1 value as
one of the following:

• 1–8 for port subracks on a 256 system

• 1–16 for port subracks on a 512 system

• Blank for Main Controller subracks and
Matrix/Synchronisation subracks

Fibre 2 The Fibre 2 field displays the Fibre 2 value as
one of the following:

• 1–8 for dual-fibre port subracks on a 256
system

• 1–16 for dual-fibre port subracks on a 512
system

• Blank for single-fibre port subracks, Main
Controller subracks, and Matrix/
Synchronisation subracks

Subrack window and procedures
Subrack query results

Equipment
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Column Description

Fibre 3 The Fibre 3 field displays the Fibre 3 value as
one of the following:

• 1–8 for quad-fibre port subracks on a 256
system

• 1–16 for quad-fibre port subracks on a 512
system

• Blank for single-fibre and dual-fibre port
subracks, Main Controller subracks, and
Matrix/Synchronisation subracks

Fibre 4 The Fibre 4 field displays the Fibre 4 value as
one of the following:

• 1–8 for quad-fibre port subracks on a 256
system

• 1–16 for quad-fibre port subracks on a 512
system

• Blank for single-fibre and dual-fibre port
subracks, Main Controller subracks, and
Matrix/Synchronisation subracks

Inhibit Status The Inhibit Status field displays the degrade
inhibit status for the subrack (Inhibit or Allowed).

Multiplexing The Multiplexing field displays the default
multiplexing structure for port subracks (AU4 or
TU12).

Related topic For general information about windows, see “About the main
application window” (2-10).

Subrack window and procedures
Subrack query results

Equipment
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Creating a subrack
....................................................................................................................................................................................................................................

Before you begin Do the following before creating a subrack:

• Verify that the rack that houses the subrack is provisioned. Use
the Rack window at Provision > Equipment > Rack to query the
rack.

• Verify that the MCLAN port is not connected to any device,
including a valid device, such as an SRC.

Creating a single-fibre
subrack

............................................................................................................................................................

1 Go to the Subrack window at Provision > Equipment > Subrack.

............................................................................................................................................................

2 Select values for the Subrack ID and Rack ID fields.

............................................................................................................................................................

3 Select Single Fibre for the Subrack Configuration field.

............................................................................................................................................................

4 Select values for the Subrack Position, Fibre 1, and Default
Multiplexing fields.

............................................................................................................................................................

5 Click Create.

Creating a dual-fibre PSA
subrack

............................................................................................................................................................

1 Go to the Subrack window at Provision > Equipment > Subrack.

............................................................................................................................................................

2 Select values for the Subrack ID and Rack ID fields.

............................................................................................................................................................

3 Select Dual Fibre for the Subrack Configuration field.

............................................................................................................................................................

4 Select values for the Subrack Position, Fibre 1, Fibre 2, and Default
Multiplexing fields.

............................................................................................................................................................

5 Click Create.

Subrack window and procedures Equipment
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Creating a dual-fibre PSC
subrack

............................................................................................................................................................

1 Go to the Subrack window at Provision > Equipment > Subrack.

............................................................................................................................................................

2 Select values for the Subrack ID and Rack ID fields.

............................................................................................................................................................

3 Select Dual Fibre for the Subrack Configuration field.

............................................................................................................................................................

4 Select values for the Subrack Position, Fibre 1, Fibre 3, and Default
Multiplexing fields.

............................................................................................................................................................

5 Click Create.

Creating a quad-fibre PSC
subrack

............................................................................................................................................................

1 Go to the Subrack window at Provision > Equipment > Subrack.

............................................................................................................................................................

2 Select values for the Subrack ID and Rack ID fields.

............................................................................................................................................................

3 Select Quad Fibre for the Subrack Configuration field.

............................................................................................................................................................

4 Select values for the Subrack Position, Fibre 1, Fibre 2, Fibre 3, Fibre
4, and Default Multiplexing fields.

............................................................................................................................................................

5 Click Create.

Subrack window and procedures
Creating a subrack
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Deleting a subrack
....................................................................................................................................................................................................................................

Before deleting a subrack Do the following before deleting a subrack:
............................................................................................................................................................

1 Verify that diagnostic tests are not running on the subrack.

Reference:

To query any tests in progress or to cancel tests, go to
Maintenance > Background Tests.

............................................................................................................................................................

2 Delete any line-timing references on the subrack.

Reference:

Use the System Clock window at Provision > Synchronisation
and Timing > System Clock.

............................................................................................................................................................

3 Delete any Multiplex Section Protection (MSP) groups on the subrack.

Reference:

Use the MSP Group window at Provision > Protection Switch >
MSP Group.

............................................................................................................................................................

4 Delete any cross connections on the subrack.

Reference:

Use the Cross Connect window at Provision > Cross Connects
> Cross Connect.

............................................................................................................................................................

5 Remove the subrack controller from service.

Reference:

Use the Subrack Control window at Maintenance > Controller
Maintenance > Subrack Control.

Subrack window and procedures Equipment
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Procedure ............................................................................................................................................................

1 Go to the Subrack window at Provision > Equipment > Subrack.

............................................................................................................................................................

2 Select the Subrack ID.

............................................................................................................................................................

3 Click Delete.

Subrack window and procedures
Deleting a subrack
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Enabling or disabling degrade inhibit for a subrack
....................................................................................................................................................................................................................................

Before you begin Before you can enable or disable the Degrade Inhibit option, the port
subrack must be provisioned (created).

Procedure ............................................................................................................................................................

1 Go to the Subrack window at Provision > Equipment > Subrack.

............................................................................................................................................................

2 Select the Subrack ID.

............................................................................................................................................................

3 Select Degrade Inhibit (a check mark means enable degrade inhibit).

............................................................................................................................................................

4 Click Apply.

Subrack window and procedures Equipment
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Unit window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose The Unit window is used to query units or to delete port units from a
subrack.

Window location Provision > Equipment > Unit

Organisation This section is organised as follows:

• “Unit window description” (6-36)

• “Querying a unit” (6-37)

• “Unit query results” (6-38)

• “Deleting a unit” (6-40)

Equipment

....................................................................................................................................................................................................................................
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Unit window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Unit window.

Field descriptions The Unit window has the following fields.

Field name Description

Unit ID The Unit ID fields specify the unit identification
number.

For a description of the Unit ID options, see
“About physical layer addresses” (3-3).

Related topic For general information about windows, see “About the main
application window” (2-10).

Unit window and procedures Equipment

....................................................................................................................................................................................................................................

6 - 3 6 Lucent Technologies 365–367–512
Issue 2, July 2002



Querying a unit
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Unit window at Provision > Equipment > Unit.

..........................................................................................................................................................

2 Do you want to query all units or a specific unit?

If Then

You want to query all units in a
subrack.

Select the ALL value for the
Unit field.

You want to query a specific
unit.

Select a value other than ALL
for the Unit and Number fields.

............................................................................................................................................................

3 Click Query.

Result:

This query may fail if a diagnostic test that has a high loop
count is running on the Main Controller subrack. Wait until the
diagnostic test completes before querying again.

Unit window and procedures Equipment
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Unit query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results for
the Unit window.

Important! The data displayed on this screen may not be typical.

Results field descriptions The Unit Query Results window has the following fields.

Column Description

Unit ID Displays the identification number of a unit.

For a description of the Unit IDs, see “About
physical layer addresses” (3-3).

Unit Status Displays one of the following:

• Not-required unit, needs to be initialised.

• Unit is being initialised.

• Attempt to initialise unit has failed.

• Unit provisioned and initialised.

• Required unit not present.

• Wrong unit in slot. Population of slot is not
required.

• Wrong unit in slot. Population of slot is
required.

• Unit deleted but physically present and DB
record present.

• Controller unit out-of-service.

• Unit undergoing maintenance procedures.

Unit window and procedures Equipment
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Column Description

Apparatus Code Displays the apparatus code of a unit.

Serial Number Displays the serial number of a unit.

Series and
Vintage

Displays the series and vintage of a unit.

Unit Qualifier

A port IU that is provisioned,
but has not been inserted in
the subrack

NONE

A port IU that is provisioned
and inserted in the subrack

An STU with a
G.812 Type VI clock

2 Mhz Station Clock Input

64 Khz Station Clock Input

For The screen displays

All other units No value

Electrical
Optical NTT
Optical ITU

An STU with a
G.812 Type I clock

2 Mhz Station Clock Input
G.812 Type I

64 Khz Station Clock Input
G.812 Type I

An STM16 optical port unit 1310nm Long Haul

An STM4 optical port unit 1310nm Short Haul

A BSIU128 128 STM1 Capacity Matrix

Optical S-1.1 (STM-4)
Optical L-1.2 (STM-16)

Related topics For more information, see any of the following topics:

• For general information about windows, see “About the main
application window” (2-10).

• For more information about the unit status, see the Controller
maintenance chapter in the Maintenance guide, 365-367-513.

Unit window and procedures
Unit query results
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Deleting a unit
....................................................................................................................................................................................................................................

Purpose Use the following procedure only when you physically remove a port
unit and plan to leave that slot empty. This procedure will remove the
unit from the database.

Before deleting a unit Do the following before deleting a unit:
............................................................................................................................................................

1 Verify that diagnostic tests are not running on the unit.

Reference:

To query any tests in progress or to cancel tests, use the
Background Tests window at Maintenance > Background Tests.

............................................................................................................................................................

2 Delete any line-timing references on the unit.

Reference:

Use the System Clock window at Provision > Synchronisation
and Timing > System Clock.

............................................................................................................................................................

3 Delete any Multiplex Section Protection (MSP) groups on the unit.

Reference:

Use the MSP Group window at Provision > Protection Switch >
MSP Group.

............................................................................................................................................................

4 Delete any cross connections on the unit.

Reference:

Use the Cross Connect window at Provision > Cross Connects
> Cross Connect.

............................................................................................................................................................

5 Query the cross connect to make sure that no trail on the unit is part
of a Sub-Network Connection Protection (SNCP) group.

Reference:

Use the SNCP Group window at Provision > Protection Switch
> SNCP Group.

Unit window and procedures Equipment
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Deleting a unit Important! You can delete only port units.

............................................................................................................................................................

1 Go to the Unit window at Provision > Equipment > Unit.

............................................................................................................................................................

2 Select the Unit ID.

............................................................................................................................................................

3 Click Delete.

Related topics For more information about deleting units, see one of the following
topics.

• “About provisioning a unit after deleting it” (6-6)

• “About deleting units that are part of an equipment protection
group” (6-6)

• “What happens when you delete a port unit?” (6-6)

• “The process for deleting units” (6-7)

Unit window and procedures
Deleting a unit
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7 EOW and user channel

Overview
....................................................................................................................................................................................................................................

Purpose “EOW and user channel” describes how to use the EOW / User
Channel window. The EOW / User Channel window is used to
provision an Engineering Order Wire (EOW) or user channel on a
PSC subrack.

Window location Provision > Equipment > EOW / User Channel

Organisation “EOW and user channel” is organised as follows:

“EOW and user channel concepts” (7-2)

“EOW / User Channel window description” (7-3)

“Querying the EOW and user channel status” (7-5)

“EOW / User Channel query results” (7-6)

“Changing the EOW” (7-7)

“Changing the user channel” (7-8)

....................................................................................................................................................................................................................................
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EOW and user channel concepts
....................................................................................................................................................................................................................................

EOW The Engineering Order Wire (EOW) channel is a 64 kbps voice path
used for communication between regenerator or multiplex section
terminating equipment. This communication path is used primarily by
technicians for maintenance communications. The E1 EOW channel is
in the Regenerator Section (RS), and the E2 EOW channel is in the
Multiplexer Section (MS). The E1 EOW channel in the RS can be
accessed by RS terminating equipment. The E2 EOW channel in the
MS can be accessed by MS terminating equipment.

Example

You can plug in a telephone using a standard voice jack at the
repeater location, so that you can have instant voice access on the
fibre span.

User channel Whereas the EOW channel is used primarily for voice
communications, the user channel is used primarily for data. Each
network provider can use the user channel to fit specific needs. The
user channel uses the F1 bytes in the higher order path overhead.

EOW and user channel
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EOW / User Channel window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the EOW / User Channel window.

Field descriptions The EOW / User Channel window has the following fields.

Field name Description

Unit ID The Unit ID fields specify the STM-4 or STM-16
unit identification number.

For a description of the Unit ID options, see
“About physical layer addresses” (3-3).

EOW The EOW field specifies the Engineering Order
Wire (EOW) port number connection. The values
are as follows:

• OFF

• E1_PORT1

• E2_PORT1

• E1_PORT2

• E2_PORT2

• E1_PORT3

• E2_PORT3

• E1_PORT4

• E2_PORT4

The E1 EOW channel is in the Regenerator
Section (RS), and the E2 EOW channel is in the
Multiplexer Secton (MS).

EOW and user channel
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Field name Description

User Channel The User Channel field specifies the user channel
port number connection. The values are as
follows:

• F1_OFF

• F1_PORT1

• F1_PORT2

• F1_PORT3

• F1_PORT4

Related topics For more information, see one of the following topics:

• “EOW and user channel concepts” (7-2)

• For general information about windows, see “About the main
application window” (2-10).

EOW / User Channel window description EOW and user channel
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Querying the EOW and user channel status
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the EOW / User Channel window at Provision > Equipment >
EOW / User Channel.

............................................................................................................................................................

2 Enter the STM-4 or STM-16 address you wish to query in the Unit ID
field.

Reference:

For more information about Unit ID addresses, see “About
physical layer addresses” (3-3).

............................................................................................................................................................

3 Click Query.

EOW and user channel
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EOW / User Channel query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results for
the EOW / User Channel window.

Important! The data displayed on this screen may not be typical.

Results field descriptions The EOW / User Channel Query Results window has the following
fields.

Column Description

Unit ID Displays the identification number of the STM-4
or STM-16 unit.

For a description of the Unit IDs, see “About
physical layer addresses” (3-3).

EOW The EOW field displays the Engineering Order
Wire (EOW) port number connection.

User Channel The User Channel field displays the user channel
port number connection.

Related topics For more information, see one of the following topics:

• “About the main application window” (2-10)

• “EOW and user channel concepts” (7-2)

EOW and user channel
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Changing the EOW
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the EOW / User Channel window at Provision > Equipment >
EOW / User Channel.

............................................................................................................................................................

2 Enter the STM-4 or STM-16 address you wish to change in the Unit
ID field.

Reference:

For more information about Unit ID addresses, see “About
physical layer addresses” (3-3).

............................................................................................................................................................

3 Select the appropriate value in the EOW field.

............................................................................................................................................................

4 Click Apply.

EOW and user channel
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Changing the user channel
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the EOW / User Channel window at Provision > Equipment >
EOW / User Channel.

............................................................................................................................................................

2 Enter the STM-4 or STM-16 address you wish to change in the Unit
ID field.

Reference:

For more information about Unit ID addresses, see “About
physical layer addresses” (3-3).

............................................................................................................................................................

3 Select the appropriate value in the User Channel field.

............................................................................................................................................................

4 Click Apply.

EOW and user channel
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8 Transmission

Overview
....................................................................................................................................................................................................................................

Purpose “Transmission” contains the following information:

• General information about transmission provisioning

• Descriptions of the windows that are used to provision
transmission ports and signals

• Step-by-step procedures for provisioning transmission ports, SDH
signal layers, and higher order path parameters

Organisation The organisation is as follows:

• “Background information” (8-2)

• “Port window and procedures” (8-8)

• “Signal Type window and procedures” (8-16)

• “High Order Path window and procedures” (8-23)

....................................................................................................................................................................................................................................
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Background information

Overview
....................................................................................................................................................................................................................................

Purpose This section contains background information about transmission
provisioning.

Organisation This section is organised as follows:

• “Transmission provisioning terms” (8-3)

• “General information about transmission provisioning” (8-4)

• “The transmission provisioning process” (8-7)

Transmission
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Transmission provisioning terms
....................................................................................................................................................................................................................................

List of terms AU-3 An Administrative Unit 3 (AU-3) consists of a Virtual
Container 3 (VC-3) plus an AU pointer.

AU-4 An Administrative Unit 4 (AU-4) consists of a Virtual
Container 4 (VC-4) plus an AU pointer.

AU-4-4c An AU-4-4c consists of four concatenated, meaning
linked together in a series, AU-4s.

Path Trace Identifier The purpose of the Path Trace Identifier
(PTI) is to transmit a path access point identifier so that a
receiving terminal can verify that the receiving terminal is
connected to the intended transmitter.

TU-12 A Tributary Unit 12 (TU-12) consists of a Virtual
Container 12 (VC-12) plus a TU pointer.

TU-3 A Tributary Unit 3 (TU-3) consists of a Virtual Container 3
(VC-3) plus a TU pointer.

Background information Transmission
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General information about transmission provisioning
....................................................................................................................................................................................................................................

Monitoring Control button The Port, Signal Type, and High Order Path windows have a button
labelled Monitoring Control. Clicking this button takes you directly to
the Port Monitoring and Signal Monitoring windows. You can use
these windows to specify the ports and SDH signal layers for which
you want to monitor alarms and defects.

Signal type provisioning
for STM-1 ports

The following illustration shows the multiplexing structure that the
system supports for an STM-1 port. The signal types that can be
provisioned and cross connected for an STM-1 port are shown as
rectangles. The multiplexing factor is shown as an x plus a number.
For example: the x3 above the TU-12 signal layer means that there
are three TU-12s in a TUG2.

An AU-4 signal can be provisioned as TUG structured or as clear
channel. A clear channel AU-4 does not have a TUG structure.

The signal type that you assign to an STM-1 port determines how that
port can be cross connected. If you want to cross connect an STM-1
port at the TU-12 signal level, the signal type for that port must be
provisioned as TU-12.

As shown in the multiplexing structure illustration, there are three
TUG3s in an STM-1 signal.

STM-1

x1

AU-4

AUG1

VC-4

TUG3

AU-3

TUG2

TU-12

TU-3

x3

x7

x1

x1

x1

x3

x3

AU-4

VC-4

x1

x1

VC-3

x1

VC-3

x1

VC-12

x1
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The TUG3s in an STM-1 signal can be provisioned as follows:

• All TUG3s can be provisioned as TU-12s.

• All TUG3s can be provisioned as TU-3s.

• Individual TUG3s can be provisioned as either TU-12s or TU-3s.
For example: the signal type for one TUG3 can be provisioned as
TU-3, and the signal type for the other TUG3s can be
provisioned as TU-12.

Signal type provisioning
for STM-4 and STM-16

ports

The following illustration shows the multiplexing structure that the
system supports for STM-4 and STM-16 ports.

Changing the signal type When you change the signal type from AU-4 to AU-3 or from AU-3
to AU-4, the system will change all higher order path parameters to
the default values, and change the monitoring mode of the AU and
HP layers to NMON (not monitored). When you change the signal
type to TU-3 or TU-12, the system will change the monitoring mode
of all the TUs in the changed TUG3s to NMON.

STM-4

AU-4

AUG1

VC-4

TUG3

AU-3

TUG2

TU-12

TU-3

x4

x3

x7

x1

x1

x1

x3

x3

AUG4

x1 x4

AU4-4c

VC4-4c

x1

STM-16

AU-4

VC-4

x1

x1

VC-3

x1

VC-3

x1

VC-12

x1
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Related topic For more information about signal addressing, see “Table of signal
layer addresses” (3-4).

Background information
General information about transmission
provisioning
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The transmission provisioning process
....................................................................................................................................................................................................................................

Provisioning transmission
parameters

To provision transmission parameters, do the following:

............................................................................................................................................................

1 Use the Port window to query and provision transmission parameters
for a port.

Reference:

Use the Port window at Provision > Transmission > Port.

............................................................................................................................................................

2 Use the Signal Type window to query and provision the signal type or
multiplexing structure for a transmission port.

Reference:

Use the Signal Type window at Provision > Transmission >
Signal Type.

............................................................................................................................................................

3 Use the High Order Path window to query and provision higher order
path parameters.

Reference:

Use the High Order Path window at Provision > Transmission >
High Order Path.

............................................................................................................................................................

4 Use the Low Order Path window to query and provision lower order
path parameters.

Reference:

Use the Low Order Path window at Provision > Transmission >
Low Order Path.

Background information Transmission
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Port window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the Port window to do the following:

• Query ports on a per-unit or per-port basis.

• Change the values of the port parameters M and IT%. These
parameters determine when a Multiplex Section Degraded
(MSdDEG) defect is declared.

Window location Provision > Transmission > Port

Organisation This section is organised as follows:

• “Port window description” (8-9)

• “Querying port transmission parameters” (8-11)

• “Port query results” (8-12)

• “Changing port transmission parameters” (8-14)

• “Enabling or disabling automatic laser shutdown” (8-15)

Transmission
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Port window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Port window.

Field descriptions The Port window has the following fields.

Field name Description

Port ID The Port ID fields specify the physical location of
a port.

For a description of the Port ID options, see
“About physical layer addresses” (3-3).

M The M field is a port parameter that specifies the
number of consecutive errored seconds before a
Multiplex Section Degraded (MSdDEG) defect is
declared.

The values are 2–10. The default value is 7.

IT% The IT% field is a port parameter that specifies
the minimum percentage of errored blocks
detected in a one-second interval for the second to
be considered errored. Combined with M, IT%
determines when a Multiplex Section Degraded
(MSdDEG) defect is declared.

The values are 1–100. The default value is 25.

Port window and procedures Transmission
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Field name Description

Enable
(Automatic
Laser
Shutdown)

A check in this box will enable the automatic
laser shutdown feature.

For more information about the automatic laser
shutdown feature, see the Maintenance guide,
365-367-513.

Related topic For general information about windows, see “About the main
application window” (2-10).

Port window and procedures
Port window description
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Querying port transmission parameters
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Port window at Provision > Transmission > Port.

..........................................................................................................................................................

2 Do you want to query all ports on a unit or a specific port?

If Then

You want to query all ports on a
unit

Select the ALL value for the Port
ID field.

You want to query a specific port Select a value other than ALL
for the Port ID field.

............................................................................................................................................................

3 Click Query.

Port window and procedures Transmission
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Port query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results for
the Port window.

Important! The data displayed on this screen may not be typical.

Results field descriptions The Port Query Results window has the following fields.

Column Description

Port ID Displays the physical location of the port.

M (seconds) Displays the M value (2–10). M is the number of
consecutive errored seconds before a Multiplex
Section Degraded (MSdDEG) defect is declared.

IT% Threshold Displays the IT% value (1–100). IT% is the
minimum percentage of errored blocks detected in
a one-second interval for the second to be
considered errored. Combined with M, IT%
determines when a Multiplex Section Degraded
(MSdDEG) defect is declared.

ALS Displays the provisioned value of the Automatic
Laser Shutdown (ALS) feature as one of the
following:

• ON

• OFF

• Not Applicable — for STM-1 ports

Port window and procedures Transmission

....................................................................................................................................................................................................................................

8 - 1 2 Lucent Technologies 365–367–512
Issue 2, July 2002



Column Description

Laser Displays the current state of the laser as one of
the following:

• ON

• OFF

• Not Applicable — for STM-1 ports

Related topic For general information about windows, see “About the main
application window” (2-10).

Port window and procedures
Port query results
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Changing port transmission parameters
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Port window at Provision > Transmission > Port.

............................................................................................................................................................

2 Select the Port ID.

Reference:

For more information about Port IDs, see “About physical layer
addresses” (3-3).

............................................................................................................................................................

3 Select values for the following fields:

• M

• IT%

............................................................................................................................................................

4 Click Apply.

Port window and procedures Transmission
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Enabling or disabling automatic laser shutdown
....................................................................................................................................................................................................................................

Procedure The following procedure will enable or disable the automatic
laser shutdown feature:
............................................................................................................................................................

1 Go to the Port window at Provision > Transmission > Port.

............................................................................................................................................................

2 Select the STM-4 or STM-16 Port ID that you want enabled or
disabled.

Reference:

For more information about Port IDs, see “About physical layer
addresses” (3-3).

..........................................................................................................................................................

3 Do you want to enable or disable automatic laser shutdown?

To Then

Enable Select the checkmark in the
Enable field.

Disable Deselect the checkmark in the
Enable field.

............................................................................................................................................................

4 Click Apply.

Port window and procedures Transmission
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Signal Type window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the Signal Type window to do the following:

• Query the signal type assigned to a transmission port.

• Change the signal type or multiplexing structure of a
transmission port.

Window location Provision > Transmission > Signal Type

Organisation This section is organised as follows:

• “Signal Type window description” (8-17)

• “Querying a signal type” (8-19)

• “Signal Type query results” (8-20)

• “Changing a signal type” (8-22)

Transmission
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Signal Type window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Signal Type window.

Field descriptions The Signal Type window has the following fields.

Field name Description

Signal Type The Signal Type field specifies the signal level for
provisioning a transmission signal.
The values are as follows:

• AU4_4c

• AU4

• AU3

• TU3

• TU12

Port ID The Port ID fields specify the physical location of
a port.

For a description of the Port ID options, see
“About physical layer addresses” (3-3).

Signal Type window and procedures Transmission
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Field name Description

Signal ID The Signal ID field specifies the multiplexing
structure for a signal. The options available for
Signal ID depend on the Signal Type.

For a description of the Signal ID options, see
“About signal layer addresses” (3-4).

Related topic For general information about windows, see “About the main
application window” (2-10).

Signal Type window and procedures
Signal Type window description
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Querying a signal type
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Signal Type window at Provision > Transmission > Signal
Type.

............................................................................................................................................................

2 Select the Port ID.

Reference:

For more information about Port IDs, see “About physical layer
addresses” (3-3).

............................................................................................................................................................

3 Click Query.

Signal Type window and procedures Transmission
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Signal Type query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results for
the Signal Type window.

Important! The data displayed on this screen may not be typical.

Results field descriptions Depending on how an STM-1 port is provisioned, either one record
(row of data) or three records will be displayed for a signal type
query. For an STM-1 port provisioned as AU-3, TU-3, or TU-12, three
records (rows) will be displayed. For an STM-1 port provisioned as
AU-4 one record will be displayed.

The following information appears in the Signal Type Query Results
window.

Column Description

Equipment ID The Equipment ID column displays the physical
location of the equipment you queried.

For a description of the equipment addresses, see
“About physical layer addresses” (3-3).

Signal ID The Signal ID column displays the multiplexing
structure of a signal. The options available for
Signal ID depend on the Signal Type.

For a description of the Signal ID options, see
“About signal layer addresses” (3-4).

Signal Type The Signal Type column displays one of the
following values:

• AU4_4c

• AU4

• AU3

• TU3

• TU12

Signal Type window and procedures Transmission
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Related topic For general information about windows, see “About the main
application window” (2-10).

Signal Type window and procedures
Signal Type query results
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Changing a signal type
....................................................................................................................................................................................................................................

Before you begin You cannot change a signal type if:

• The affected unit is the protection unit in an STM-1 1:8 electrical
protection group.

• The affected port is the protection port in an MSP group.

• The signal layer that you want to change has a cross connect
provisioned.

• The higher order path of the affected port is provisioned as
supervisory unequipped.

Procedure ............................................................................................................................................................

1 Go to the Signal Type window at Provision > Transmission > Signal
Type.

............................................................................................................................................................

2 Select the Signal Type, Port ID, and Signal ID.

............................................................................................................................................................

3 Click Apply.

Signal Type window and procedures Transmission
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High Order Path window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the High Order Path window to query and provision higher order
path parameters.

Higher order path parameters apply to the following:

• AU-4-4c, AU-4, and AU-3 clear-channel signals provisioned as
supervisory unequipped

• TUG-structured AU-4 signals that contain TU-3s or TU-12s

Higher order path parameters do not apply to AU-4-4c, AU-4, and
AU-3 clear-channel signals that are provisioned as Normal.

The values that you specify for the M and IT% parameters determine
when a Higher order Path Degraded (HPdDEG) defect is declared.

Window location Provision > Transmission > High Order Path

Organisation This section is organised as follows:

• “High Order Path window description” (8-24)

• “Querying higher order path parameters” (8-27)

• “High Order Path query results” (8-28)

• “Changing higher order path parameters” (8-30)

Transmission
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High Order Path window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the High Order Path window.

Field descriptions The High Order Path window has the following fields.

Field name Description

Signal Type The Signal Type field specifies the signal level for
a transmission signal.
The values are as follows:

• AU4_4c

• AU4

• AU3

To provision higher order path parameters for a
signal multiplexed as TU-3 or TU-12, choose
AU-4 as the Signal Type.

Port ID The Port ID fields specify the physical location of
a port.

For a description of the Port ID options, see
“About physical layer addresses” (3-3).

High Order Path window and procedures Transmission
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Field name Description

Signal ID The Signal ID field specifies the multiplexing
structure for a transmission signal. The options
available for Signal ID depend on the Signal
Type.

For a description of the Signal ID options, see
“About signal layer addresses” (3-4).

M The M field is a higher order path parameter that
specifies the number of consecutive errored
seconds before a Higher order Path Degraded
(HPdDEG) defect is declared.

The values are 2–10. The default value is 7.

IT% The IT% field is a higher order path parameter
that specifies the minimum percentage of errored
blocks detected in a one-second interval for the
second to be considered errored. Combined with
M, IT% determines when a Higher order Path
Degraded (HPdDEG) defect is declared.

The values are 1–100. The default value is 25.

Signal The Signal field is a higher order path parameter
that specifies the type of outgoing signal for a
higher order path.
The values are as follows:

• Normal — The outgoing signal is a normal
signal.

• Supuneq — The outgoing signal is a
supervisory unequipped signal as defined by
ITU-T G.783.

The default value is Normal.

Transmitted PTI
Mode

The Transmitted PTI Mode field is a higher order
path parameter that specifies the mode that a port
uses to transmit the Path Trace Identifier.
The values are as follows:

• 15 Byte PTI — A specific string of characters
plus the result of a CRC-7 calculation will be
transmitted.

• No PTI — No PTI value is transmitted.

The default value is 15 Byte PTI.

High Order Path window and procedures
High Order Path window description
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Field name Description

Expected PTI
Mode

The Expected PTI Mode field is a higher order
path parameter that specifies the mode of the Path
Trace Identifier that a port expects to receive.
The values are as follows:

• 15 Byte PTI — A specific string of characters
plus the result of a CRC-7 calculation will be
received.

• No PTI — The received PTI value is ignored.

The default value is No PTI.

Transmitted PTI The Transmitted PTI field is a higher order path
parameter that specifies the Path Trace Identifier
that a port transmits. A value can be specified for
this field only if the Transmitted PTI Mode field
is set to 15 Byte PTI.

This field accepts up to 15 alphanumeric
characters. The characters , ; : # { } space are not
allowed.

The default value is WaveStar.

Expected PTI The Expected PTI field is a higher order path
parameter that specifies the Path Trace Identifier
that a port expects to receive. A value can be
specified for this field only if the Expected PTI
Mode field is set to 15 Byte PTI.

This field accepts up to 15 alphanumeric
characters. The characters , ; : # { } space are not
allowed.

Related topic For general information about windows, see “About the main
application window” (2-10).

High Order Path window and procedures
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Querying higher order path parameters
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the High Order Path window at Provision > Transmission >
High Order Path.

............................................................................................................................................................

2 Select the Signal Type and the Port ID.

............................................................................................................................................................

3 Click Query.

High Order Path window and procedures Transmission
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High Order Path query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results for
the High Order Path window.

Important! The data displayed on this screen may not be typical.

Results field descriptions The following information appears in the High Order Path Query
Results window.

Column Description

Port ID Displays the physical location of the port.

Signal ID Displays the multiplexing structure of the signal.
The options available for Signal ID depend on the
Signal Type.

For a description of the Signal ID options, see
“About signal layer addresses” (3-4).

M Displays the M value (2–10). M is the number of
consecutive errored seconds before a Higher order
Path Degraded (HPdDEG) defect is declared.

IT% Displays the IT% value (1–100). IT% is the
minimum percentage of errored blocks detected in
a one-second interval for the second to be
considered errored. Combined with M, IT%
determines when a Higher order Path Degraded
(HPdDEG) defect is declared.

Signal Displays one of the following values:

• Normal — The outgoing signal is a normal
signal.

• Supuneq — The outgoing signal is a
supervisory unequipped signal as defined by
ITU-T G.783.

High Order Path window and procedures Transmission
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Column Description

Transmit PTI
Mode

Displays one of the following values:

• 15 Byte PTI

• No PTI

Transmit PTI Displays the Transmitted PTI value.

Expected PTI
Mode

Displays one of the following values:

• 15 Byte PTI

• No PTI

Expected PTI Displays the Expected PTI value.

Accepted PTI Displays the accepted Path Trace Identifier (PTI).
The accepted PTI will be displayed if the
expected PTI mode is provisioned as 15 Byte PTI
and a valid path trace is being received. If a valid
PTI is not received, or if the expected PTI mode
is provisioned as No PTI, the Accepted PTI
column will be blank.

Accepted PSL Displays the accepted Path Signal Label (PSL). If
a valid PSL is not received, the Accepted PSL
column will be blank.

Related topic For general information about windows, see “About the main
application window” (2-10).

High Order Path window and procedures
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Changing higher order path parameters
....................................................................................................................................................................................................................................

Before you begin You cannot provision higher order path parameters if:

• The affected unit is the protection unit in an STM-1 1:8 electrical
protection group.

• The affected port is the protection port in an MSP group.

Procedure ............................................................................................................................................................

1 Go to the High Order Path window at Provision > Transmission >
High Order Path.

............................................................................................................................................................

2 Select the Signal Type, Port ID, and Signal ID.

............................................................................................................................................................

3 Select values for one or more of the following fields:

• M

• IT%

• Signal

• Transmitted PTI Mode

• Expected PTI Mode

• Transmitted PTI

• Expected PTI

............................................................................................................................................................

4 Click Apply.

High Order Path window and procedures Transmission
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Low Order Path window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the Low Order Path window to query and provision lower order
path parameters.

Lower order path parameters apply to TUG-structured AU-4 signals
that contain TU-3s or TU-12s. Also, the TUG-structured AU-4 signal
must be provisioned as supervisory unequipped.

Lower order path parameters do not apply to TUG-structured AU-4
signals that are provisioned as Normal.

The values that you specify for the M and IT% parameters determine
when a Lower order Path Degraded (LPdDEG) defect is declared.

Window location Provision > Transmission > Low Order Path

Organisation This section is organised as follows:

• “Low Order Path window description” (8-32)

• “Querying lower order path parameters” (8-34)

• “Low Order Path query results” (8-35)

• “Changing lower order path parameters” (8-37)

Transmission
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Low Order Path window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Low Order Path window.

Field descriptions The Low Order Path window has the following fields.

Field name Description

Signal Type The Signal Type field specifies the signal level for
a transmission signal.
The values are as follows:

• TU3

• TU12

Port ID The Port ID fields specify the physical location of
a port.

For a description of the Port ID options, see
“About physical layer addresses” (3-3).

Signal ID The Signal ID field specifies the multiplexing
structure for a transmission signal. The options
available for Signal ID depend on the Signal
Type.

For a description of the Signal ID options, see
“About signal layer addresses” (3-4).

Low Order Path window and procedures Transmission
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Field name Description

M The M field is a lower order path parameter that
specifies the number of consecutive errored
seconds before a Lower order Path Degraded
(LPdDEG) defect is declared.

The values are 2–10. The default value is 7.

IT% The IT% field is a lower order path parameter that
specifies the minimum percentage of errored
blocks detected in a one-second interval for the
second to be considered errored. Combined with
M, IT% determines when a Lower order Path
Degraded (LPdDEG) defect is declared.

The values are 1–100. The default value is 25.

Expected PTI
Mode

The Expected Path Trace Identifier (PTI) Mode
field is a lower order path parameter that specifies
the mode of the Path Trace identifier that a port
expects to receive.
The values are as follows:

• 15 Byte PTI — A specific string of characters
plus the result of a CRC-7 calculation will be
received.

• No PTI — The received PTI value is ignored.

The default value is No PTI.

Expected PTI The Expected Path Trace Identifier (PTI) field is a
lower order path parameter that specifies the Path
Trace identifier that a port expects to receive. A
value can be specified for this field only if the
Expected PTI Mode field is set to 15 Byte PTI.

This field accepts up to 15 alphanumeric
characters. The characters , ; : # { } space are not
allowed.

Related topic For general information about windows, see “About the main
application window” (2-10).

Low Order Path window and procedures
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Querying lower order path parameters
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Low Order Path window at Provision > Transmission >
Low Order Path.

............................................................................................................................................................

2 Select the Signal Type and the Port ID.

............................................................................................................................................................

3 Click Query.

Low Order Path window and procedures Transmission
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Low Order Path query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results for
the Low Order Path window.

Important! The data displayed on this screen may not be typical.

Results field descriptions The following information appears in the Low Order Path Query
Results window.

Column Description

Port ID Displays the physical location of the port.

Signal ID Displays the multiplexing structure of the signal.
The options available for Signal ID depend on the
Signal Type.

For a description of the Signal ID options, see
“About signal layer addresses” (3-4).

M Displays the M value (2–10). M is the number of
consecutive errored seconds before a Lower order
Path Degraded (LPdDEG) defect is declared.

IT% Displays the IT% value (1–100). IT% is the
minimum percentage of errored blocks detected in
a one-second interval for the second to be
considered errored. Combined with M, IT%
determines when a Lower order Path Degraded
(LPdDEG) defect is declared.

Low Order Path window and procedures Transmission
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Column Description

Expected PTI
Mode

Displays one of the following values:

• 15 Byte PTI

• No PTI

Expected PTI Displays the Expected PTI value.

Accepted PTI Displays the accepted Path Trace Identifier (PTI).
The accepted PTI will be displayed if the
expected PTI mode is provisioned as 15 Byte PTI
and a valid path trace is being received. If a valid
PTI is not received, or if the expected PTI mode
is provisioned as No PTI, the Accepted PTI
column will be blank.

Accepted PSL Displays the accepted Path Signal Label (PSL). If
a valid PSL is not received, the Accepted PSL
column will be blank.

Related topic For general information about windows, see “About the main
application window” (2-10).

Low Order Path window and procedures
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Changing lower order path parameters
....................................................................................................................................................................................................................................

Before you begin You cannot provision lower order path parameters if:

• The affected trail is contained within the secondary trail of a
higher order SNCP group.

• The affected trail is on the protection port in an MSP group.

Procedure ............................................................................................................................................................

1 Go to the Low Order Path window at Provision > Transmission >
Low Order Path.

............................................................................................................................................................

2 Select the Signal Type, Port ID, and Signal ID.

............................................................................................................................................................

3 Select values for one or more of the following fields:

• M

• IT%

• Expected PTI Mode

• Expected PTI

............................................................................................................................................................

4 Click Apply.

Low Order Path window and procedures Transmission
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9 Protection switching

Overview
....................................................................................................................................................................................................................................

Purpose “Protection switching” contains the following information:

• General information about Multiplex Section Protection (MSP)
and Sub-Network Connection Protection (SNCP)

• Descriptions of the windows that are used to provision
transmission protection switching

• Step-by-step procedures for provisioning the following:

- Protection switching for an MSP group

- Protection switching for an SNCP group

- The Wait-To-Restore timer for matrix and STM-1 protection
groups

Organisation The organisation is as follows:

• “MSP background information” (9-2)

• “SNCP background information” (9-11)

• “MSP Group window and procedures” (9-27)

• “SNCP Group window and procedures” (9-36)

• “Wait To Restore Timer window and procedures” (9-49)
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MSP background information

Overview
....................................................................................................................................................................................................................................

Purpose This section contains background information about Multiplex Section
Protection (MSP) and the different types of MSP.

Organisation This section is organised as follows:

• “MSP terms” (9-3)

• “General information about MSP” (9-5)

• “About MSP types” (9-7)

• “About NTT line restore time” (9-9)

• “About provisioning MSP groups” (9-10)

Protection switching
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MSP terms
....................................................................................................................................................................................................................................

List of terms MSP 1+1 Multiplex Section Protection (MSP) is a transmission
protection arrangement. The same signal is sent and received over
two separate transmission lines. These transmission lines
terminate on separate transmission ports that are logically linked
in software.

The following types of MSP are available:

• ITU MSP complies with ITU-T Recommendation G.783, Annex
A.

• NTT MSP complies with ITU-T Recommendation G.783, Annex
B, and a set of recommendations provided by Nippon Telegraph
and Telephone (NTT).

• ANSI MSP complies with American National Standards Institute
(ANSI) T1–105.01.

MSP group An MSP group is a pair of associated ports on a pair
of physically-adjacent port units. An MSP group, also called an
MSP pair, provides transmission line protection between network
elements.

ITU MSP ITU MSP provides 1+1 unidirectional or bidirectional
nonrevertive switching for STM-16, STM-4, and STM-1 optical
interfaces, and for STM-1 electrical interfaces. Two lines carry
identical payloads in a permanent bridged arrangement between
network elements.

NTT MSP NTT MSP provides switching similar to bidirectional
ITU MSP for STM-1 optical interfaces, and for STM-1 electrical
interfaces.

ANSI MSP ANSI MSP provides switching similar to
unidirectional ITU MSP for STM-16, STM-4, and STM-1 optical
interfaces, and for STM-1 electrical interfaces.

Line restore time Line restore time is the number of minutes
that the system waits, after a failure condition that caused a
protection switch clears, before switching to the line that is not
carrying service (the line where the fault cleared). Line restore
time applies only to NTT MSP.

Nonrevertive Nonrevertive is a protection-switching operation
type. When a protection group is nonrevertive, the protection
entity will continue to operate as the active entity even after a
failure clears on the working entity.

Revertive Revertive is a protection-switching operation type.
When a protection group is revertive, the system will

MSP background information Protection switching
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automatically switch service from the protection entity back to
the working entity when a failure clears and the Wait-To-Restore
time has elapsed.

MSP background information
MSP terms

Protection switching
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General information about MSP
....................................................................................................................................................................................................................................

What is transmission
protection?

Transmission protection protects a transmission facility from failures
that can affect service. If a failure is detected, service is switched
automatically to a facility that is reserved for protection.

What is an MSP group? A Multiplex Section Protection (MSP) group is a pair of transmission
ports, a working port and a protection port. Because MSP is assigned
to pairs of transmission ports, an MSP group is also called an MSP
pair.

MSP provides the capability for switching the transmission path from
the working line to the protection line in a point-to-point connection
between network elements. The protection line is reserved for
protection and cannot be used for carrying other traffic.

Where are the working and
protection ports?

For all types of port subracks, an MSP group is a pair of transmission
ports on adjacent port units. The transmission ports have the following
characteristics:

• The working port is on an odd-numbered port unit.

• The protection port is the corresponding port on the
even-numbered port unit to the right of the working unit.

Example of an MSP group The following illustration shows an example of an MSP group.

How many MSP groups
can I provision?

You can create an MSP group on any port subrack. The following
table shows how many MSP groups you can provision per pair of port
units.

PSA-4-STM1-MSP1-1

STM1
unit 1

(working)

Slot 1

Working
Ports

1 2 3 4

STM1
unit 2

(protection)

Slot 2

Protection
Ports

1 2 3 4

MSP1

MSP background information Protection switching

....................................................................................................................................................................................................................................

365–367–512
Issue 2, July 2002

Lucent Technologies 9 - 5



Port unit Subrack Maximum Number
of MSP Groups

STM-1 PSA 4

STM-4 PSC 4

STM-16 PSC 1

MSP background information
General information about MSP
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About MSP types
....................................................................................................................................................................................................................................

Purpose of MSP NTT, ANSI, and ITU MSP are similar, and their purpose is the same:
to protect a transmission facility from failures that can affect service.

Hardware differences The following table shows the port units that can and cannot be used
with ITU MSP, ANSI MSP, and NTT MSP.

MSP type STM-16/4
optical

STM-1
electrical

STM-1 optical

ITU MSP Yes Yes Yes

NTT MSP No Yes Yes

ANSI MSP Yes Yes Yes

Provisioning differences Except for creating an MSP group, all provisioning procedures, such
as connecting cross connections, are the same for ITU MSP, ANSI
MSP, and NTT MSP. For ITU MSP, you must choose UNI_ITU
(unidirectional) or BI_ITU (bidirectional) in the Switching Type field
on the MSP Group window. NTT MSP can be provisioned only as
bidirectional. ANSI MSP can be provisioned only as unidirectional.

Functional differences There are no functional differences between ITU MSP and ANSI
MSP. The following table describes the functional differences between
ITU MSP and NTT MSP.

ITU and ANSI MSP NTT MSP

Designed to keep service on the
working line — always treating
the working line as the preferred
line

Either the working or the
protection line can be the
preferred line

Transmits and acknowledges a
lockout condition by using the
K-bytes (K1 and K2)

Lockout condition is not carried
by the K-bytes

Never interprets K-bytes received
on the working line

Transmits K-bytes on both the
working and protection lines and,
depending on the state of the
lines, receives K-bytes from
either line

Waits 2.5 seconds for an
acknowledgment from the
far-end before giving up on a
manual request

Waits 1 second for an
acknowledgment from the
far-end before giving up on a
manual request

MSP background information Protection switching
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ITU and ANSI MSP NTT MSP

Supports both forced and manual
switches

Supports only forced switches

MSP background information
About MSP types

Protection switching

....................................................................................................................................................................................................................................

9 - 8 Lucent Technologies 365–367–512
Issue 2, July 2002



About NTT line restore time
....................................................................................................................................................................................................................................

What is line restore time? Although NTT MSP is nonrevertive, it makes use of a
Wait-To-Restore (WTR) timer. On the DACS user interface, this timer
is referred to as “Line Restore Time.” When a fault on the
service-carrying line causes a protection switch, the received K-bytes
continue to be interpreted from the new line carrying service. When
the fault clears, the line restore timer is started. When the line restore
timer expires, the line used to interpret the received K-bytes is
switched to the line that is not carrying service (the line where the
fault cleared).

Each NTT MSP group must be assigned a line restore time when the
MSP group is created.

What are the line restore
time values?

The line restore time range is 0 to 60 minutes in 1-minute increments.
The default value is 5 minutes. If the line restore time is set to 0, the
system automatically changes it to 1-second. This means that line
restore cannot be disabled by setting the value to 0.

How do I change line
restore time?

You cannot directly change the line restore time value. To change the
value, you must delete the MSP group, and then create it again with
the new line restore time value.

MSP background information Protection switching
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About provisioning MSP groups
....................................................................................................................................................................................................................................

How creating an MSP
group affects other

provisioning

When you create an MSP group, the higher and lower order path
provisioning and multiplexing for both lines become what was
provisioned for the working port.

MSP groups and IU types
on PSA subracks

For PSA subracks, the creation of MSP groups is not affected by the
type of Interface Unit (IU). You can create MSP groups for STM-1
ports with electrical or optical IUs, or a mixture of IU types.

MSP groups and
bandwidth on single-fibre

PSA subracks

For a single-fibre PSA subrack configuration, there is no lost
bandwidth when you create MSP groups, since bandwidth was never
allocated to the even-numbered (protection) units. Although cross
connections cannot be made to ports on even-numbered units,
provisioning is not blocked for other port features. For example, it is
possible to put a port in supervisory unequipped mode to verify
connectivity even if that port has no bandwidth because it is a
protection port in a single-fibre subrack. A port on a protection unit in
a single-fibre PSA subrack will carry traffic only when the port is
provisioned as part of an MSP protection group and service switches
to that port from a working unit.

Related topics

For more information about single-fibre subracks, see one of the
following topics:

• “Single-fibre PSA port subrack configurations” (6-9)

• “Single-fibre PSC port subrack configurations” (6-11)

MSP groups and
bandwidth on dual-fibre

PSA subracks

Whenever you create an MSP group in a dual-fibre PSA subrack
configuration, the overall system bandwidth is reduced, since the MSP
group uses two physical ports but carries the bandwidth of only one.
The bandwidth that ordinarily would have been allocated to the
protection port is inaccessible once you have created the MSP group.

Related topics

For more information about dual-fibre subracks, see one of the
following topics:

• “Dual-fibre PSA port subrack configurations” (6-10)

• “Dual-fibre PSC port subrack configurations” (6-12)

MSP groups and
bandwidth on quad-fibre

PSC subracks

You can provision MSP in a quad-fibre PSC subrack, but the overall
system bandwidth will be reduced. Bandwidth is reduced because
MSP uses two physical ports, but carries the bandwidth of one port.
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SNCP background information

Overview
....................................................................................................................................................................................................................................

Purpose This section contains background information about Sub-Network
Connection Protection (SNCP).

Organisation This section is organised as follows:

• “SNCP terms” (9-12)

• “About SNCP” (9-13)

• “SNCP configurations” (9-14)

• “SNCP ring architectures” (9-18)

• “About trail protection” (9-21)

• “Higher order and lower order trails” (9-22)

• “TSF conditions for inherently-monitored trails” (9-23)

• “TSF and TSD conditions for nonintrusively-monitored trails”
(9-24)

• “SNCP with other types of protection” (9-25)

• “Cross connect status of SNCP trails” (9-26)

Protection switching
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SNCP terms
....................................................................................................................................................................................................................................

List of terms Add traffic Add traffic is traffic that is inserted into a working
trail at a ring node.

Bridge A bridge transmits identical traffic on both the working
and protection trails.

Drop and continue Drop and continue is a function within a
ring node where traffic is both extracted from the working
channels on the ring (drop), and transmitted onwards on the ring
(continue).

Drop traffic Drop traffic is traffic that is extracted from a
working trail at a ring node.

Dual node interconnection Dual node interconnection is an
architecture between two rings where two nodes in each ring are
interconnected.

Head end The node that executes a bridge.

Hold-off time The time (0 to 10 seconds) that the system waits
after detecting a failure before initiating a protection switch. The
hold-off time can be used to control switching order when
multiple protection mechanisms are protecting the same service.
For example, lower order or higher order SNCP can be combined
with MSP or equipment protection.

Node A node is a point of connection into a network.

Path selector Within an Sub-Network Connection Protection
(SNCP) architecture, the node function that selects a tributary
which is extracted from the working channels arriving from one
side of the node or from the other side of the node, according to
path level criteria.

Protection trail The trail allocated to carry traffic if a failure is
detected on the working trail.

Ring A ring is constructed within a layer consisting of a set of
nodes, each of which is connected to its immediate neighbor
(adjacent) nodes by a trail connection, forming a closed loop.

Single node interconnection Single node interconnection is an
architecture between two rings where one node in each ring is
interconnected.

Tail end The node that executes the switch.

Working trail The trail over which traffic is transported when
there is no switch event (such as a cable cut).

SNCP background information Protection switching
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About SNCP
....................................................................................................................................................................................................................................

What is transmission
protection?

Transmission protection protects a transmission facility from failures
that can affect service. If a failure is detected, service is switched
automatically to a facility that is reserved for protection.

What is SNCP? Sub-Network Connection Protection (SNCP) is a transmission
protection feature that provides protection for all or part of a trail
through a network. At the head end of the protected subnetwork
connection, a bridge is created. The bridge sends two identical copies
of the protected trail toward the tail end over different routes. The tail
end selects which copy of the trail to take as input based on manual
and automatic switching criteria. For bidirectional traffic, each end of
the connection provides both the head end (bridging) and the tail end
(selector) functions.

Trail monitoring When SNCP is provisioned for a higher order or a lower order trail,
the system monitors the trail for Trail Signal Fail (TSF) and Trail
Signal Degrade (TSD) conditions. When a TSF or TSD condition
occurs and the trail was not previously in a failed or degraded state,
the hold-off timer is started. If the hold-off timer is set to zero, or if
the TSF or TSD condition exists at the expiry of the hold-off timer,
service is switched away from the failed trail unless an equal or
higher priority request is in effect.

Inherent and nonintrusive
monitoring

The monitoring that triggers protection switching for SNCP trails can
be provisioned as inherent (SNCP/I) or nonintrusive (SNCP/N). The
automatic switching criteria are based on the following criteria:

• Inherent — Trail Signal Fail (TSF) conditions in the server layer

• Nonintrusive — TSF conditions in the server layer and client
layer; Trail Signal Degrade (TSD) and TSF conditions in the
client layer

Related topics

For more information, see one of the following topics:

• “TSF conditions for inherently-monitored trails” (9-23)

• “TSF and TSD conditions for nonintrusively-monitored trails”
(9-24)
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SNCP configurations
....................................................................................................................................................................................................................................

Unidirectional The unidirectional VC-trail selector configuration creates a
unidirectional selector on the incoming direction of a port. The
unidirectional VC-trail selector configuration also applies to multipoint
(bridge and broadcast) connections. The working trail is the primary
trail, and the protection trail is the secondary trail.

Bidirectional Bidirectional SNCP operates with incoming and outgoing traffic on
the working port. Each end of the connection provides both the head
end (bridging) and the tail end (selector) functions. The working trail
is the primary trail, and the protection trail is the secondary trail.

Working Protection

Unidirectional connection
without protection

Protected unidirectional
connection

Working Protection

Bidirectional connection
without protection

Protected bidirectional
connection

SNCP background information Protection switching
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The bidirectional SNCP configuration applies also to multipoint
connections (bridge or broadcast).

The following illustration shows an example of a ring that uses
bidirectional SNCP.

Nodes A and D both have a head end bridge and a tail end selector.
Nodes B and C both have bidirectional cross connects.

Working Protection

Bidirectional multi-point
connection without protection

Multi-point connection
with bidirectional
SNCP protection

Node B

Node C

Node A

Node D

SNCP background information
SNCP configurations
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Drop and continue
working

The drop and continue working configuration is used at the primary
interconnection node in rings with dual node interconnections. This
configuration provides the same selector in the incoming direction as
the bidirectional SNCP configuration. However, the outgoing signal is
sent only to the working trail, and the incoming signal on the working
trail is bridged to the outgoing signal on the protection trail. The
working trail is the primary trail, and the protection trail is the
secondary trail.

Related topic

For more information, see “Dual node interconnection” (9-18).

Drop and continue
protection

The drop and continue protection configuration is used at the
secondary interconnection node in rings with dual node
interconnection. This configuration provides the same selector on the
incoming direction as the bidirectional SNCP configuration. However,
the outgoing signal is sent only to protection trail, and the incoming
signal on the protection trail is bridged to the outgoing signal on the
working trail. The protection trail is the primary trail, and the working
trail is the secondary trail.

Working Protection

Bidirectional connection
without protection

Protected bidirectional
connection

Working

Working Protection

Bidirectional connection
without protection

Protected bidirectional
connection

Protection
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Related topic For more information about the drop and continue working, and the
drop and continue protection configurations, refer to ITU-T
Recommendation G.842.

For more examples, see “Example of dual node interconnection”
(9-19).
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SNCP ring architectures
....................................................................................................................................................................................................................................

Single node
interconnection

Single node interconnection is an architecture between two rings
where one node in each ring is interconnected.

Dual node interconnection Dual node interconnection is an architecture between two rings where
two nodes in each ring are interconnected.

Related topic

For more information, see “Example of dual node interconnection”
(9-19).

A

W

B

X

D

Z

C

Y

Ring 1

Ring 2

A

W

B

X

D

Z

C

Y

Ring 1

Ring 2
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Example of dual node interconnection
....................................................................................................................................................................................................................................

Example

Legend:

Node A A bidirectional SNCP bridge and selector configuration

Node B A primary interconnection node with a drop and
continue working configuration, and a unidirectional
cross connect

Node C A secondary interconnection node with a drop and
continue protection configuration, and a unidirectional
cross connect

Node D A secondary interconnection node with a drop and
continue protection configuration, and a unidirectional
cross connect

Node A

Node B Node C

Node ENode D

Node F

SNCP background information Protection switching
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Node E A primary interconnection node with a drop and
continue working configuration, and a unidirectional
cross connect

Node F A bidirectional SNCP bridge and selector configuration

SNCP background information
Example of dual node interconnection
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About trail protection
....................................................................................................................................................................................................................................

What trails can be
protected?

You can provision SNCP for the following:

• Trails that are cross connected through the DACS, but not
terminated on the DACS, at any rate

• Trails that have not yet been cross connected

The signal multiplexing must match the SNCP multiplexing. This
applies to the secondary trail as well as to the primary trail. Always
query the signal multiplexing structure at Provision > Transmission >
Signal Type before provisioning an SNCP group.

SNCP background information Protection switching
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Higher order and lower order trails
....................................................................................................................................................................................................................................

Higher order trails You can provision SNCP for the following types of higher order trails,
whether the trail is terminated on the DACS or not:

• VC-4-4c

• VC-3

Lower order trails You can provision SNCP for the following types of lower order trails
when the higher order path contains VC-4s that are provisioned as
TUG structured:

• VC-3 as TU-3

• VC-12 as TU-12

SNCP background information Protection switching
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TSF conditions for inherently-monitored trails
....................................................................................................................................................................................................................................

Higher order trails The following are Trail Signal Fail (TSF) conditions for higher order
inherently-monitored trails:

• Port unit failure

• STMdLOS

• RSdLOF

• MSdAIS

• AUdLOP

• AUdAIS

Because TSD detection requires nonintrusive monitoring, TSD
conditions do not apply to higher order inherently-monitored trails.

Lower order trails The following are Trail Signal Fail conditions for lower order
inherently-monitored trails:

• Port unit failure

• STMdLOS

• RSdLOF

• MSdAIS

• AUdLOP

• AUdAIS

• HPdUNEQ

• HPdTIM

• HPdPLM

• TUdLOM (only for VC-12 trails)

• TUdAIS

• TUdLOP

Because TSD detection requires nonintrusive monitoring, TSD
conditions do not apply to lower order inherently-monitored trails.

SNCP background information Protection switching
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TSF and TSD conditions for nonintrusively-monitored trails
....................................................................................................................................................................................................................................

Higher order trails The following are Trail Signal Fail (TSF) conditions for higher order
nonintrusively-monitored trails:

• Port unit failure

• STMdLOS

• RSdLOF

• MSdAIS

• AUdAIS

• HPdUNEQ and accepted PTI is all zeros

• HPdTIM

HPdDEG is a Trail Signal Degrade (TSD) condition for higher order
nonintrusively-monitored trails.

Lower order trails The following are TSF conditions for lower order nonintrusively-
monitored trails:

• Port unit failure

• STMdLOS

• RSdLOF

• MSdAIS

• AUdAIS

• HPdUNEQ

• HPdTIM

• HPdPLM

• TUdLOM (only for VC-12 trails)

• TUdAIS

• TUdLOP

• LPdUNEQ and accepted PTI is all zeros

• LPdTIM

LPdDEG is a TSD condition for lower order nonintrusively-monitored
trails.
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SNCP with other types of protection
....................................................................................................................................................................................................................................

Hold-off timer You can provision SNCP with MSP or equipment protection. When
you use SNCP with another type of protection, you should provision a
hold-off timer for the SNCP group. Hold-off time is the amount of
time that the system waits after detecting a Trail Signal Fail (TSF) or
Trail Signal Degrade (TSD) condition before initiating a protection
switch. Provisioning a hold-off timer for an SNCP group allows MSP
or equipment protection switching to operate first.
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Cross connect status of SNCP trails
....................................................................................................................................................................................................................................

Guidelines The cross connect status of the primary and secondary trails on
bidirectional and unidirectional configurations must comply with the
following guidelines:

• The working and protection trails are clear channel AU-4-4c,
AU-4, AU-3, or TU-12 with no cross connects on the secondary
trail. You can use any selector type.

• The working and protection trails are clear channel AU-4-4c,
AU-4, AU-3, or TU-12 with no cross connects in the incoming
direction on the secondary trail for the unidirectional trail
protection selector type. Cross connects in the outgoing direction
are unrelated to the SNCP group for this selector type.

SNCP and cross connect
provisioning

You identify the working and protection trails when you create an
SNCP group. Subsequently, you will need to connect or disconnect
cross connects only on the working trail. The system will
automatically configure the corresponding connections for the
protection trail.

Protection bridge For bidirectional, drop and continue working, and drop and continue
protection configurations, the system will automatically create the
protection bridge when you create the cross connect.

SNCP background information Protection switching
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MSP Group window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the MSP Group window to query and provision Multiplex Section
Protection (MSP) groups. This window is also used to specify a Line
Restore Time and the Switching Type for an MSP group.

Window location Provision > Protection Switching > MSP Group

Organisation This section is organised as follows:

• “MSP Group window description” (9-28)

• “Querying an MSP group” (9-30)

• “MSP Group query results” (9-31)

• “Creating an MSP group” (9-32)

• “Deleting an MSP group” (9-34)

• “Changing the Line Restore Time” (9-35)

Protection switching
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MSP Group window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the MSP Group window.

Field descriptions The MSP Group window has the following fields.

Field name Description

MSP Group ID The MSP Group ID fields specify the address of
an MSP group.

For a description of the MSP group addresses, see
“MSP addresses” (3-17).

Line Restore
Time

The Line Restore Time field specifies the number
of minutes that the system waits, after a failure
condition that caused a protection switch clears,
before switching to the line that is not carrying
service (the line where the fault cleared).

A line restore time can be provisioned only for
Bidirectional NTT MSP (BI_NTT).

The values are 0–60 minutes. The default value is
5.

MSP Group window and procedures Protection switching
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Field name Description

Switching Type The Switching Type field specifies the type of
MSP switching as one of the following values:

• BI_ITU (Bidirectional MSP that complies with
ITU-T Recommendation G.783)

• UNI_ITU (Unidirectional MSP that complies
with ITU-T Recommendation G.783)

• BI_NTT (Bidirectional MSP designed to
Nippon Telegraph and Telephone
specifications)

• UNI_ANSI (Unidirectional MSP that complies
with ANSI T1–105.01)

Related topic For general information about windows, see “About the main
application window” (2-10).

MSP Group window and procedures
MSP Group window description
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Querying an MSP group
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the MSP Group window at Provision > Protection Switching >
MSP Group.

............................................................................................................................................................

2 Select the MSP Group ID.

For a description of the MSP group addresses, see “MSP addresses”
(3-17).

............................................................................................................................................................

3 Click Query.

MSP Group window and procedures Protection switching
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MSP Group query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results for
the MSP Group window.

Important! The data displayed on this screen may not be typical.

Results field descriptions The MSP Group Query Results window has the following fields.

Column Description

MSP Group ID Displays the physical location of the MSP group.

Line Restore
Time

Displays the provisioned line restore time (0–60
minutes).

Switching Type Displays one of the following values:

• BI_ITU (Bidirectional ITU MSP)

• UNI_ITU (Unidirectional ITU MSP)

• BI_NTT (Bidirectional NTT MSP)

• UNI_ANSI (Unidirectional ANSI MSP)

Related topic For general information about windows, see “About the main
application window” (2-10).
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Creating an MSP group
....................................................................................................................................................................................................................................

Before you begin Before creating an MSP group, perform the following steps:
............................................................................................................................................................

1 Verify that both port units are the same type. They should have the
same apparatus code. For STM1 port units, the associated Interface
Units do not have to be the same.

Reference:

Query the Unit window at Provision > Equipment > Unit.

............................................................................................................................................................

2 Verify that the protection ports do not have cross connections
provisioned.

Reference:

Query the Cross Connect window at Provision > Cross Connects
> Cross Connect.

............................................................................................................................................................

3 Verify that neither the working nor the protection port is used as a
line-timing reference.

Reference:

Query the System Clock window at Provision > Synchronisation
and Timing > System Clock.

............................................................................................................................................................

4 Verify that an MSP group has not already been created.

Reference:

Query the MSP Group window at Provision > Protection Switch
> MSP Group.

............................................................................................................................................................

5 Verify that the protection port for the MSP group is not the working
nor the protection trail for a Sub-Network Connection Protection
(SNCP) group.

Reference:

Query the SNCP Group window at Provision > Protection
Switch > SNCP Group.

MSP Group window and procedures Protection switching
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Related topics

For more information about MSP groups, see one of the following
topics:

• “General information about MSP” (9-5)

• “About provisioning MSP groups” (9-10)

Procedure ............................................................................................................................................................

1 Go to the MSP Group window at Provision > Protection Switching >
MSP Group.

............................................................................................................................................................

2 Select values for the following fields:

• MSP Group ID

• Line Restore Time

• Switching Type

............................................................................................................................................................

3 Click Create.

Result:

You will receive a confirmation request if both of the following
conditions are true:

• Either of the units in the group you are creating has an
electrical Interface Unit

• Service is currently being provided through the equipment
protection unit

Please note that creating an MSP group with this configuration
will cause service to revert to the working unit. This may affect
service if the working unit is defective.

MSP Group window and procedures
Creating an MSP group
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Deleting an MSP group
....................................................................................................................................................................................................................................

Before you begin Before deleting an MSP group, perform the following steps:
............................................................................................................................................................

1 Verify that the MSP group is not provisioned as a line-timing
reference.

Reference:

Query the System Clock window at Provision > Synchronisation
> System Clock.

............................................................................................................................................................

2 For an ITU MSP group, verify that the protection line is not active.

Reference:

Query the MSP transmission window at Protection Switch >
Transmission > MSP.

Procedure ............................................................................................................................................................

1 Go to the MSP Group window at Provision > Protection Switching >
MSP Group.

............................................................................................................................................................

2 Select the MSP Group ID.

For a description of the MSP group addresses, see “MSP addresses”
(3-17).

............................................................................................................................................................

3 Click Delete.

Result:

You will receive a confirmation request if you are deleting an
NTT MSP group, and the protection line is the active line.

MSP Group window and procedures Protection switching
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Changing the Line Restore Time
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the MSP Group window at Provision > Protection Switching >
MSP Group.

............................................................................................................................................................

2 Delete the MSP group that has the Line Restore Time that you want
to change.

............................................................................................................................................................

3 Create a new MSP group with the new Line Restore Time.
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SNCP Group window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the SNCP Group window to query and provision Sub-Network
Connection Protection (SNCP) groups.

Window location Provision > Protection Switching > SNCP Group

Organisation This section is organised as follows:

• “SNCP Group window description” (9-37)

• “Querying an SNCP group” (9-39)

• “SNCP Group query results” (9-40)

• “Creating an SNCP group” (9-42)

• “Deleting an SNCP group” (9-48)

Protection switching
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SNCP Group window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the SNCP Group window.

Field descriptions The SNCP Group window has the following fields.

Field name Description

Signal Type The Signal Type field specifies the signal level as
AU4_4c, AU4, AU3, TU3, or TU12.

Primary ID The Primary ID is the entity that is the preferred
routing that traffic travelling from one network
element to another normally follows.

Port ID The Port ID field specifies the physical location
of the entity.

Signal ID The Signal ID field specifies the signal level of
the address. The options available for Signal ID
depend on the Signal Type.

For a description of the Signal ID options, see
“About signal layer addresses” (3-4).

Secondary ID The Secondary ID identifies the alternate routing
that traffic travelling from one network element to
another follows. The system will use this alternate
routing when a manual or automatic request
switches service away from the primary route.

SNCP Group window and procedures Protection switching
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Field name Description

Configuration Select one of the following configurations:

• Bi-Directional

• Uni-Directional

• Drop and Continue Working

• Drop and Continue Protection

For more information, see “SNCP configurations”
(9-14).

Monitoring
Mode

Select one of the following values:

• Inherent

• Non-Intrusive
For more information, see one of the following
topics:

• “Inherent and nonintrusive monitoring” (9-13)

• “TSF conditions for inherently-monitored
trails” (9-23)

• “TSF and TSD conditions for
nonintrusively-monitored trails” (9-24)

Hold Off Timer Use the Hold Off Timer field to set the amount of
time that the system waits after detecting a
failure, before initiating a protection switch. The
values for hold-off time are 0–10 seconds. The
default value is 0 seconds.

Switching Mode Select one of the following values:

• REVERTIVE — Service will be restored to
the working trail when the manual or
automatic switch request has cleared.

• NON-REVERTIVE — Service will not be
restored to the working trail when manual or
automatic switch request has cleared.

Wait to Restore
Time

A wait-to-restore time can be provisioned only if
the Switching Mode field is set to revertive.
Wait-to-restore time is the amount of time that the
working entity must remain fault free before the
system restores service to the working trail after a
protection switch that is caused by a TSF or TSD
condition. The values for wait-to-restore time are
0–60 minutes. The default value is 5 minutes.

Related topic For general information about windows, see “About the main
application window” (2-10).

SNCP Group window and procedures
SNCP Group window description

Protection switching

....................................................................................................................................................................................................................................

9 - 3 8 Lucent Technologies 365–367–512
Issue 2, July 2002



Querying an SNCP group
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the SNCP Group window at Provision > Protection Switching
> SNCP Group.

............................................................................................................................................................

2 Select the entity address in the Primary ID field or the Secondary ID
field.

............................................................................................................................................................

3 Click Query.
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SNCP Group query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results for
the SNCP Group window.

Important! The data displayed on this screen may not be typical.

Results field descriptions The SNCP Group Query Results window has the following fields.

Column Description

Primary Port ID Displays the port address that provides the
preferred routing that traffic travelling from one
network element to another normally follows.

Primary Signal
ID

Displays the signal address that provides the
preferred routing that traffic travelling from one
network element to another normally follows.

Secondary Port
ID

Displays the port address that provides the
alternate routing that traffic travelling from one
network element to another follows.

Secondary
Signal ID

Displays the signal address that provides the
alternate routing that traffic travelling from one
network element to another follows.

Configuration Displays one of the following values:

• Bi-Directional

• Uni-Directional

• Drop and Continue Working

• Drop and Continue Protection

For more information, see “SNCP configurations”
(9-14).

SNCP Group window and procedures Protection switching
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Column Description

Monitoring
Mode

Displays one of the following values:

• Inherent

• Non-Intrusive
For more information, see one of the following
topics:

• “Inherent and nonintrusive monitoring” (9-13)

• “TSF conditions for inherently-monitored
trails” (9-23)

• “TSF and TSD conditions for
nonintrusively-monitored trails” (9-24)

Hold Off Time Displays the provisioned hold-off time.

Switching Mode Displays one of the following values:

• REVERTIVE

• NON-REVERTIVE

Wait to Restore
Time

Displays the provisioned wait-to-restore time.

Related topic For general information about windows, see “About the main
application window” (2-10).

SNCP Group window and procedures
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Creating an SNCP group
....................................................................................................................................................................................................................................

Before you begin Before creating a Sub-Network Connection Protection (SNCP)
group, perform the following steps:
............................................................................................................................................................

1 Verify that the primary and secondary trails you want to use are
different trails.

............................................................................................................................................................

2 Verify that neither the primary nor secondary trail you want to use is
on the protection port of an MSP pair nor on the protection unit (9 or
19) of an STM-1 electrical equipment protection group. The primary
or secondary trail you want to use can be on the working port of an
MSP pair or on one of the working units of an STM-1 electrical
equipment protection group.

Reference:

For more information, see “SNCP with other types of
protection” (9-25).

............................................................................................................................................................

3 Verify that neither the primary nor secondary trail you want to use is
within the secondary trail of another SNCP group.

Reference:

Query the SNCP group window at Provision > Protection
Switch > SNCP Group.

............................................................................................................................................................

4 Verify that the multiplexing for both primary and secondary trails is
identical.

Reference:

Use the Signal Type window at Provision > Transmission >
Signal Type.

............................................................................................................................................................

5 Verify that the signal for both primary and secondary trails is
provisioned as normal, and not supervisory unequipped.

Reference:

Use the High Order Path window at Provision > Transmission >
High Order Path.

............................................................................................................................................................

6 Verify that the cross connect status of both trails are part of an
acceptable configuration.

SNCP Group window and procedures Protection switching
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Reference:

For more information, see “Cross connect status of SNCP trails”
(9-26).

............................................................................................................................................................

7 Verify that the SNCP group has not already been created.

Reference:

Query the SNCP group window at Provision > Protection
Switch > SNCP Group.

Related topics

For more information about SNCP groups, see “SNCP background
information” (9-11).

Procedure What type of SNCP do you want to create?

If Then

Bidirectional ring Go to “Provisioning a
bidirectional SNCP ring” (9-44)

Ring with a Dual Node
Interconnection (DNI)

Go to “Provisioning SNCP for a
ring with a DNI” (9-46)

SNCP Group window and procedures
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Provisioning a bidirectional SNCP ring
....................................................................................................................................................................................................................................

Before you begin If you have not done so already, perform the “Before you begin” tasks
in “Creating an SNCP group” (9-42).

Illustration The following illustration shows an example of a ring that uses
bidirectional SNCP. The following procedure describes how to
provision the nodes shown in this illustration.

Provisioning node A and
node D

............................................................................................................................................................

1 Using the SNCP Group window, create an SNCP group with a
bidirectional configuration.

............................................................................................................................................................

2 Using the Cross Connect window, create a bidirectional cross connect
for the primary trail.

Node B

Node C

Node A

Node D

Primary
(Working)
Trail

Secondary
(Protection)
Trail

Primary
(Working)
Trail

Secondary
(Protection)
Trail
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Result:

The system automatically creates the bridged cross connect
when you create the bidirectional SNCP group.

Provisioning node B and
node C

............................................................................................................................................................

1 Using the Cross Connect window, create a bidirectional cross connect.

SNCP Group window and procedures
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Provisioning SNCP for a ring with a DNI
....................................................................................................................................................................................................................................

Before you begin If you have not done so already, perform the “Before you begin” tasks
in “Creating an SNCP group” (9-42).

Illustration The following illustration shows an example of rings with SNCP and
dual node interconnections. The following procedure describes how to
provision the nodes shown in this illustration.

Provisioning node A and
node F

............................................................................................................................................................

1 Using the SNCP Group window, create an SNCP group with a
bidirectional configuration.

Node A

Node B Node C

Node ENode D

Node F

Primary
Trail

Secondary
Trail

Primary
Trail

Primary
Trail

Primary
Trail

Secondary
Trail

Primary
Trail

Secondary
Trail

Working
Trail

Protection
Trail

Working
Trail

Protection
Trail
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............................................................................................................................................................

2 Using the Cross Connect window, create a bidirectional cross connect
for the primary trail.

Result:

The system automatically creates the bridged cross connect
when you create the bidirectional SNCP group.

Provisioning node C and
node D

............................................................................................................................................................

1 Using the SNCP Group window, create an SNCP group with a drop
and continue protection configuration.

............................................................................................................................................................

2 Using the Cross Connect window, create a bidirectional cross connect
for the primary trail to the drop port.

Provisioning node B and
node E

............................................................................................................................................................

1 Using the SNCP Group window, create an SNCP group with a drop
and continue working configuration.

............................................................................................................................................................

2 Using the Cross Connect window, create a bidirectional cross connect
for the primary trail to the drop port.

SNCP Group window and procedures
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Deleting an SNCP group
....................................................................................................................................................................................................................................

Before you begin Before deleting a Sub-Network Connection Protection (SNCP)
group, perform the following steps:
............................................................................................................................................................

1 Verify that the SNCP group exists.

............................................................................................................................................................

2 Verify that the primary trail is active.

Important! If you delete an SNCP group with the secondary trail
active, you will force service back to the primary trail. This could
affect service if there is a failure on the primary trail.

Procedure ............................................................................................................................................................

1 Go to the SNCP Group window at Provision > Protection Switching
> SNCP Group.

............................................................................................................................................................

2 Select the Signal Type.

............................................................................................................................................................

3 Select the Primary ID in the Port ID and Signal ID fields.

............................................................................................................................................................

4 Click Delete.
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Wait To Restore Timer window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the Wait To Restore Timer window to query and provision a
Wait-To-Restore (WTR) time for the matrix protection group or for
STM-1 equipment protection groups.

Window location Provision > Protection Switching > Wait To Restore Timer

Organisation This section is organised as follows:

• “Wait To Restore Timer window description” (9-50)

• “Querying the WTR time for STM-1 protection” (9-52)

• “Querying the WTR time for matrix protection” (9-53)

• “Changing the WTR time for STM-1 protection” (9-54)

• “Changing the WTR time for matrix protection” (9-55)

Protection switching
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Wait To Restore Timer window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Wait To Restore Timer window.

Field descriptions The Wait To Restore Timer window has the following fields.

Field name Description

Matrix
Protection

Select the Matrix Protection field to query or
provision the matrix protection group.

STM1
Protection

Select the STM1 Protection field to query or
provision an STM-1 equipment protection group.

Protection
Group ID

The Protection Group ID specifies the address of
an STM-1 equipment protection group.

For a description of equipment protection group
addresses, see “Equipment protection group
addresses” (3-16).

Wait To Restore
Time

The Wait To Restore Time field specifies the
amount of time that the system waits, after a
failure condition that caused a protection switch
clears, before switching back to the
previously-active equipment (matrix slice or
STM-1 unit).

The values are 0–60 minutes. The default value is
5.

Wait To Restore Timer window and
procedures
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Related topic For general information about windows, see “About the main
application window” (2-10).

Wait To Restore Timer window and
procedures
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Querying the WTR time for STM-1 protection
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Wait To Restore Timer window at Provision > Protection
Switching > Wait To Restore Timer.

............................................................................................................................................................

2 Select STM1 Protection and the Protection Group ID.

............................................................................................................................................................

3 Click Query.

Result:

The provisioned Wait-To-Restore time displays in a query results
window.

Wait To Restore Timer window and
procedures
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Querying the WTR time for matrix protection
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Wait To Restore Timer window at Provision > Protection
Switching > Wait To Restore Timer.

............................................................................................................................................................

2 Select Matrix Protection.

............................................................................................................................................................

3 Click Query.

Result:

The provisioned Wait-To-Restore time displays in a query results
window.
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Changing the WTR time for STM-1 protection
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Wait To Restore Timer window at Provision > Protection
Switching > Wait To Restore Timer.

............................................................................................................................................................

2 Select STM1 Protection and a Protection Group ID.

............................................................................................................................................................

3 Change the Wait To Restore Time.

............................................................................................................................................................

4 Click Apply.

Wait To Restore Timer window and
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Changing the WTR time for matrix protection
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Wait To Restore Timer window at Provision > Protection
Switching > Wait To Restore Timer.

............................................................................................................................................................

2 Select Matrix Protection.

............................................................................................................................................................

3 Change the Wait To Restore Time.

............................................................................................................................................................

4 Click Apply.
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10 Performance monitoring

Overview
....................................................................................................................................................................................................................................

Purpose “Performance monitoring” contains the following information:

• General information about performance monitoring (PM)

• Descriptions of the windows that are used to provision PM

• Step-by-step procedures for provisioning PM

Organisation The organisation is as follows:

• “Background information” (10-2)

• “Count Control window and procedures” (10-14)

• “TCA Control window and procedures” (10-25)

• “TCA Thresholds window and procedures” (10-37)

....................................................................................................................................................................................................................................

365–367–512
Issue 2, July 2002

Lucent Technologies 1 0 - 1



Background information

Overview
....................................................................................................................................................................................................................................

Purpose This section provides background information about performance
monitoring (PM).

Organisation This section is organised as follows:

• “PM tasks” (10-3)

• “PM terms” (10-4)

• “PM concepts” (10-6)

• “How PM works” (10-7)

• “Trail types” (10-8)

• “VC-3, VC-4, and VC-4-4c threshold values” (10-9)

• “VC-12 threshold values” (10-10)

• “RS threshold values” (10-11)

• “MS threshold values” (10-12)

Performance monitoring
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PM tasks
....................................................................................................................................................................................................................................

Starting PM Use the following procedure when provisioning PM for the first time.

............................................................................................................................................................

1 Go to “Starting PM counts” (10-20).

............................................................................................................................................................

2 Go to “Changing TCA threshold values” (10-44). This procedure is
optional. Perform this procedure only if you want to change the
default TCA threshold values.

............................................................................................................................................................

3 Go to “Starting TCA reporting when all parameters are inhibited”
(10-31) or “Starting TCA reporting when some parameters are
enabled” (10-33).

Ongoing PM tasks Perform the following tasks as needed:

• “Querying PM count control” (10-17)

• “Inhibiting PM counts” (10-23)

• “Clearing the PM counters” (10-24)

• “Querying TCA reporting” (10-28)

• “Inhibiting TCA reporting” (10-35)

• “Querying TCA threshold values” (10-41)

• “Changing TCA threshold values” (10-44)

Background information Performance monitoring
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PM terms
....................................................................................................................................................................................................................................

List of terms Background Block Errors Background Block Errors (BBEs) are
the number of errored blocks that were detected. A block is a set
of consecutive bits associated with the path; each bit belongs to
only one block. An Errored Block is a block in which one or
more bits are in error.

Errored Seconds Errored Seconds (ES) is a performance-
monitoring parameter that refers to the number of one-second
periods in which one or more Errored Blocks occur.

Estimator value The estimator value is a value that is used in
the performance-monitoring calculation process. The estimator
value is the error rate, in errored-blocks-per second, at which the
errored seconds become severely-errored seconds.

Far end Far end refers to the remote network element. For PM,
the system collects performance-monitoring data on the local
network element from anomalies detected in the incoming signal
by the remote (far-end) network element.

Multiplex section A multiplex section (MS) is a transmission
medium, together with the associated equipment, required to
provide the means of transporting information between two
consecutive network elements. One of the network elements
originates the line signal and the other network element
terminates the line signal.

Multiplex section terminating equipment Multiplex section
terminating equipment is a network element that originates or
terminates STM-1, STM-4, or STM-16 signals.

Near end Near end refers to the local network element. For PM,
the system collects performance-monitoring data on the local
network element from anomalies detected in the incoming signal
by the local (near-end) network element.

Parameter Parameters are the output of the performance-
monitoring calculation process. For example: background block
errors, errored seconds, severely-errored seconds, and unavailable
seconds are all parameters.

Path terminating equipment Path terminating equipment is a
network element that multiplexes or demultiplexes the VC-4
payloads.

Regenerator section A regenerator section (RS) is the portion of
a transmission facility, including terminating points, between a
terminating network element and regenerator, or two regenerators.

Background information Performance monitoring
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Severely-Errored Seconds Severely-Errored Seconds (SES)
refers to the number of one-second periods in which the number
of Errored Blocks equals or exceeds the estimator value.

Threshold A threshold is the level of a parameter count at which
the system sends a Threshold Crossing Alert.

Threshold Crossing Alert The system reports a Threshold
Crossing Alert (TCA) whenever a performance-monitoring
parameter exceeds a specified threshold.

Trail A trail is the logical transmission path between two path
termination points.

Unavailable Seconds Unavailable Seconds is the number of
one-second periods when performance-monitoring data is
unavailable due to prolonged severely-errored conditions. The
Unavailable Seconds count begins when the system detects ten or
more consecutive Severely-Errored Seconds. The system will
count these severely-errored seconds as an unavailable second
instead. The Unavailable Seconds count stops when the system
detects ten or more consecutive, nonseverely-errored seconds. All
other counts stop during Unavailable Seconds.

VC-4-4c A VC-4-4c consists of four concatenated, meaning
linked together in a series, VC-4s.

VC A Virtual Container (VC) is the information structure used to
support path layer connections in the Synchronous Digital
Hierarchy (SDH).

Related topics For more information about these terms, see one of the following
topics:

• “VC-3, VC-4, and VC-4-4c threshold values” (10-9)

• “VC-12 threshold values” (10-10)

• “RS threshold values” (10-11)

• “MS threshold values” (10-12)

• For a graphical description of the differences between trail types,
see “Trail types” (10-8)

• For a flowchart of the parameters, see “How PM works” (10-7)

Background information
PM terms
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PM concepts
....................................................................................................................................................................................................................................

What is PM? You can provision the system to monitor the quality of transmission
signals. By default, transmission signals are not monitored. You can
define thresholds for PM parameters, also called performance events.
If one of these thresholds is crossed, the system notifies you by
automatically generating a Threshold Crossing Alert (TCA) message.

Related topic

You can query the system about previous PM TCA messages. For
more information about TCA records, see the Reports chapter in the
Maintenance guide, 365-367-513.

Why use PM? Because degraded performance often precedes signal failure, PM lets
you know where corrective action may be necessary before service is
affected.

What happens during a
protection switch?

When a protection switch occurs on a transmission unit, all the PM
counts on the unit are set to zero.

How do I choose
meaningful thresholds?

It is best to start with high thresholds and then set lower thresholds
once the degraded performance problems associated with the higher
thresholds have been resolved. For more information, see the ITU-T
Recommendations G.826 and G.784.

Do transmission alarms
affect the counts?

The system stops collecting far-end counts if there is a Loss of
Incoming Signal, but it continues to collect near-end counts.

Background information Performance monitoring
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How PM works
....................................................................................................................................................................................................................................

Process flowchart The following flowchart describes the PM process.

Defects?

Anomalies?

BB
equals or exceeds
estimator value?

Path in
unavailable

period?

Increment the
ES count

End

Background
block (BB)

Severely errored
second (SES)

Errored second
(ES)

Monitored Signal

No

Yes

No

Yes

Yes

No

Yes

No

Path in
unavailable

period?

Increment the
ES count

Increment the
SES count

No

Yes

Increment the
UAS count

Increment the
UAS count

Background information Performance monitoring

....................................................................................................................................................................................................................................

365–367–512
Issue 2, July 2002

Lucent Technologies 1 0 - 7



Trail types
....................................................................................................................................................................................................................................

Trail types you can
monitor

Performance monitoring is available on Regenerator section (RS),
Multiplex section (MS), VC-4-4c, VC-4, VC-3 (Higher order Path),
VC-3 (Lower order Path), and VC-12 trail types.

Differences between trail
types

This illustration provides a basic overview of PM trail types.

Note

A VC-4-4c consists of four concatenated VC-4s.

Related topic For more information, see one of the following:

• For more information about the terms used in this topic, see “PM
terms” (10-4).

• For more information about Synchronous Digital Hierarchy
(SDH) standards, concepts, and applications, see the ITU-T
standards.

regeneratorregenerator

multiplex section
terminating
equipment

path terminating
equipment

path terminating
equipment

multiplex section
terminating
equipment

multiplex section

regenerator section

regenerator section

Virtual Container 4
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VC-3, VC-4, and VC-4-4c threshold values
....................................................................................................................................................................................................................................

Table The following table displays the allowable range and default values
for Virtual Container 3 (VC-3), Virtual Container 4 (VC-4), and
VC-4-4c counts.

Parameter 15-minute threshold 24-hour threshold

Range Default Range Default

NE-BBE 1–7,200,000 720,000 1–691,200,000 69,120,000

NE-ES 1–900 90 1–86,400 8,640

NE-SES 1–900 90 1–86,400 8,640

NE-UAS 1–900 90 1–86,400 8,640

FE-BBE 1–7,200,000 720,000 1–691,200,000 69,120,000

FE-ES 1–900 90 1–86,400 8,640

FE-SES 1–900 90 1–86,400 8,640

FE-UAS 1–900 90 1–86,400 8,640

Related topic “How do I choose meaningful thresholds?” (10-6)
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VC-12 threshold values
....................................................................................................................................................................................................................................

Table The following table displays the allowable range and default values
for Virtual Container 12 (VC-12) counts.

Parameter 15-minute threshold 24-hour threshold

Range Default Range Default

NE-BBE 1–1,800,000 180,000 1–172,800,000 17,280,000

NE-ES 1–900 90 1–86,400 8,640

NE-SES 1–900 90 1–86,400 8,640

NE-UAS 1–900 90 1–86,400 8,640

FE-BBE 1–1,800,000 180,000 1–172,800,000 17,280,000

FE-ES 1–900 90 1–86,400 8,640

FE-SES 1–900 90 1–86,400 8,640

FE-UAS 1–900 90 1–86,400 8,640

Related topic “How do I choose meaningful thresholds?” (10-6)

Background information Performance monitoring
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RS threshold values
....................................................................................................................................................................................................................................

Table The following table displays the allowable range and default values
for Regenerator Section (RS) counts.

Parameter 15-minute threshold 24-hour threshold

Range Default Range Default

NE-BBE 1–7,200,000 720,000 1–691,200,000 69,120,000

NE-ES 1–900 90 1–86,400 8,640

NE-SES 1–900 90 1–86,400 8,640

NE-UAS 1–900 90 1–86,400 8,640

Related topic “How do I choose meaningful thresholds?” (10-6)

Background information Performance monitoring
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MS threshold values
....................................................................................................................................................................................................................................

STM-1 The following table displays the allowable range and default values
for STM-1 Multiplex Section (MS) counts.

Parameter 15-minute threshold 24-hour threshold

Range Default Range Default

NE-BBE 1–21,600,000 2,160,000 1–2,073,600,000 207,360,000

NE-ES 1–900 90 1–86,400 8,640

NE-SES 1–900 90 1–86,400 8,640

NE-UAS 1–900 90 1–86,400 8,640

FE-BBE 1–21,600,000 2,160,000 1–2,073,600,000 207,360,000

FE-ES 1–900 90 1–86,400 8,640

FE-SES 1–900 90 1–86,400 8,640

FE-UAS 1–900 90 1–86,400 8,640

STM-4 The following table displays the allowable range and default values
for STM-4 Multiplex Section (MS) counts.

Parameter 15-minute threshold 24-hour threshold

Range Default Range Default

NE-BBE 1–86,400,000 8,640,000 1–8,294,400,000 829,440,000

NE-ES 1–900 90 1–86,400 8,640

NE-SES 1–900 90 1–86,400 8,640

NE-UAS 1–900 90 1–86,400 8,640

FE-BBE 1–86,400,000 8,640,000 1–8,294,400,000 829,440,000

FE-ES 1–900 90 1–86,400 8,640

FE-SES 1–900 90 1–86,400 8,640

FE-UAS 1–900 90 1–86,400 8,640

STM-16 The following table displays the allowable range and default values
for STM-16 Multiplex Section (MS) counts.

Parameter 15-minute threshold 24-hour threshold

Range Default Range Default

NE-BBE 1–345,600,000 34,560,000 1–33,177,600,000 3,317,760,000

NE-ES 1–900 90 1–86,400 8,640

NE-SES 1–900 90 1–86,400 8,640

Background information Performance monitoring
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Parameter 15-minute threshold 24-hour threshold

Range Default Range Default

NE-UAS 1–900 90 1–86,400 8,640

FE-BBE 1–345,600,000 34,560,000 1–33,177,600,000 3,317,760,000

FE-ES 1–900 90 1–86,400 8,640

FE-SES 1–900 90 1–86,400 8,640

FE-UAS 1–900 90 1–86,400 8,640

Related topic “How do I choose meaningful thresholds?” (10-6)

Background information
MS threshold values

Performance monitoring
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Count Control window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the Count Control window to query and provision performance
monitoring (PM) count control. This window can be used to start or
stop (inhibit) PM counts for a trail, or to clear (set to zero) the PM
counters for a trail.

You can start or stop PM counts for the following trail types:

• RS

• MS

• VC4_4c

• VC4

• VC3 (HP) — VC-3 as AU-3

• VC3 (LP) — VC-3 as TU-3

• VC12

Window location Provision > Performance Monitoring > Count Control

Organisation This section is organised as follows:

• “Count Control window description” (10-15)

• “Querying PM count control” (10-17)

• “Count Control query results” (10-18)

• “Starting PM counts” (10-20)

• “Inhibiting PM counts” (10-23)

• “Clearing the PM counters” (10-24)

Performance monitoring
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Count Control window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Count Control window.

Field descriptions The Count Control window has the following fields.

Field name Description

Trail Type The Trail Type column displays the trail type for
PM signal provisioning. The following options are
available:

• RS

• MS

• VC4_4c

• VC4

• VC3 (HP) — VC-3 as AU-3

• VC3 (LP) — VC-3 as TU-3

• VC12
For more information, see one of the following
topics:

• For definitions of trail types, see “PM terms”
(10-4).

• For a graphical description of the differences
between trail types, see “Trail types” (10-8).

Count Control window and procedures Performance monitoring
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Field name Description

Port ID The Port ID fields specify the physical location of
the port.

For more information about addresses, see “About
entity addresses” (3-2).

Signal ID The Signal ID field specifies the signal that you
want to query or provision.

• For some Trail Type and Port ID
combinations, the system automatically
populates the Signal ID field.

• For RS and MS signals, this field is
unavailable.

For more information about signal addresses, see
“About signal layer addresses” (3-4).

PM Count
Control

The PM Count Control field specifies the count
control task as one of the following:

• Allow Count — starts PM counts on one trail.

• Inhibit Count — prevents count control on one
trail at a time.

• Clear Counters — clears the current 15-minute
and the current 24-hour counts on one trail by
setting them to 0.

Related topic For general information about windows, see “About the main
application window” (2-10).

Count Control window and procedures
Count Control window description
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Querying PM count control
....................................................................................................................................................................................................................................

Purpose This procedure displays the allow/inhibit status for a specified trail
ID. It will not display the PM counts that are currently being collected
for the specified trail. Query the PM report at Reports > Performance
Monitoring to determine whether PM counts are currently being
collected.

Procedure ............................................................................................................................................................

1 Go to the Count Control window at Provision > Performance
Monitoring > Count Control.

............................................................................................................................................................

2 Select the trail type in the Trail Type field.

Reference: For more information, see one of the following
topics:

• For definitions of trail types, see “PM terms” (10-4).

• For a graphical description of the differences between trail
types, see “Trail types” (10-8).

............................................................................................................................................................

3 Select the port address in the Port ID field.

Result:

Depending on what you enter in the Port ID field, the system
automatically populates the Signal ID field or the field is
unavailable.

Reference: For more information, see one of the following
topics:

• For general information about port addresses and signal
addresses, see “About entity addresses” (3-2).

• For specific information about the Signal ID field, see
“About signal layer addresses” (3-4).

............................................................................................................................................................

4 Click Query.

Count Control window and procedures Performance monitoring
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Count Control query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results
from the Count Control window.

Important! The data displayed on this screen may not be typical.

Results field descriptions The following information appears in the Count Control Query
Results window.

Column Description

Port ID The Port ID column displays the Port ID, or
physical address, of the input port.

For more information about addresses, see “About
entity addresses” (3-2).

Signal ID The Signal ID column displays the Signal ID, or
signal address.

For more information about signal addresses, see
“About signal layer addresses” (3-4).

PM Count
Control

The PM Count Control column displays the count
control state as one of the following:

• Allow — PM counts are allowed on this trail.

• Inhibit — PM counts are not allowed on this
trail.

Count Control window and procedures Performance monitoring
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Column Description

Trail Type The Trail Type column displays the trail type for
PM signal provisioning. The following options are
available:

• RS

• MS

• VC4_4c

• VC4

• VC3 (HP) — VC-3 as AU-3

• VC3 (LP) — VC-3 as TU-3

• VC12
For more information, see one of the following
topics:

• For definitions of trail types, see “PM terms”
(10-4).

• For a graphical description of the differences
between trail types, see “Trail types” (10-8).

Related topic For general information about windows, see “About the main
application window” (2-10).

Count Control window and procedures
Count Control query results
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Starting PM counts
....................................................................................................................................................................................................................................

Purpose Use this procedure to turn on the PM count control for a specified
Trail ID.

Gathering information Before applying PM count control on a port, perform the
following steps.
............................................................................................................................................................

1 Query the unit to verify that the unit is fully operational.

Reference:

Use the Unit window at Provision > Equipment > Unit.

............................................................................................................................................................

2 Query the port monitoring to verify that the port monitoring mode is
set to MON. If the mode is set to AUTO, it will automatically
transition to MON if the signal is valid.

Reference:

Use the Port Monitoring window at Provision > Monitoring
Control > Port Monitoring.

............................................................................................................................................................

3 Query the signal monitoring to check one of the following:

• For VC4_4c trails, check the HP row to verify that the higher
order path monitoring mode for the AU-4-4c is set to MON.

• For VC4 trails, check the HP row to verify that the higher order
path monitoring mode for the AU-4 is set to MON.

• For VC3 (HP) trails, check the HP row to verify that the higher
order path monitoring mode for the AU-3 is set to MON.

• For VC3 (LP) trails, check the LP row to verify that the lower
order path monitoring mode for the TU-3 is set to MON.

• For VC12 trails, check the LP row to verify that the lower order
path monitoring mode for the TU-12 is set to MON.

• For RS trails, verify that the RS monitoring mode is set to MON.

• For MS trails, verify that the MS monitoring mode is set to
MON.

Reference:

Use the Signal Monitoring window at Provision > Monitoring
Control > Signal Monitoring.

Count Control window and procedures Performance monitoring
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............................................................................................................................................................

4 Look at the Alarm Panel to see if there are any diagnostic tests in
progress. If there are, wait until the diagnostic test completes.

............................................................................................................................................................

5 For VC4 or VC4_4c trails only, if the port is part of an MSP group,
query the MSP group to verify that the specified unit is the working
unit.

Reference:

Use the MSP Group window at Provision > Protection Switch >
MSP Group.

Procedure ............................................................................................................................................................

1 Go to the Count Control window at Provision > Performance
Monitoring > Count Control.

............................................................................................................................................................

2 Select the trail type in the Trail Type field.

Reference: For more information, see one of the following
topics:

• For definitions of trail types, see “PM terms” (10-4).

• For a graphical description of the differences between trail
types, see “Trail types” (10-8).

............................................................................................................................................................

3 Select the port address in the Port ID field.

Result:

Depending on what you enter in the Port ID field, the system
automatically populates the Signal ID field or the field is
unavailable.

Reference: For more information, see one of the following
topics:

• For general information about port addresses and signal
addresses, see “About entity addresses” (3-2).

• For specific information about the Signal ID field, see
“About signal layer addresses” (3-4).

............................................................................................................................................................

4 Click the Allow Count button in the PM Count Control field.

Count Control window and procedures
Starting PM counts
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............................................................................................................................................................

5 Click Apply.

Result:

The counts will start at zero.

............................................................................................................................................................

6 If you want to change the system default TCA threshold values, go to
the TCA Thresholds window to change them.

Reference:

Provision > Performance Monitoring > TCA Thresholds

Count Control window and procedures
Starting PM counts
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Inhibiting PM counts
....................................................................................................................................................................................................................................

Purpose Use this procedure to stop count control for the specified trail ID.

Procedure ............................................................................................................................................................

1 Go to the Count Control window at Provision > Performance
Monitoring > Count Control.

............................................................................................................................................................

2 Select the trail type in the Trail Type field.

Reference: For more information, see one of the following
topics:

• For definitions of RS, MS, VC4_4c, VC4, VC3 (HP), VC3
(LP), and VC12 see “PM terms” (10-4).

• For a graphical description of the differences between trail
types, see “Trail types” (10-8).

............................................................................................................................................................

3 Select the port address in the Port ID field.

Result:

Depending on what you enter in the Port ID field, the system
automatically populates the Signal ID field or the field is
unavailable.

Reference: For more information, see one of the following
topics:

• For general information about port addresses and signal
addresses, see “About entity addresses” (3-2).

• For specific information about the Signal ID field, see
“About signal layer addresses” (3-4).

............................................................................................................................................................

4 Click the Inhibit Count button in the PM Count Control field.

............................................................................................................................................................

5 Click Apply.

Count Control window and procedures Performance monitoring
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Clearing the PM counters
....................................................................................................................................................................................................................................

Purpose Use this procedure to set the current 15-minute and the current
24-hour counts to zero for the specified Trail ID.

Procedure ............................................................................................................................................................

1 Go to the Count Control window at Provision > Performance
Monitoring > Count Control.

............................................................................................................................................................

2 Select the trail type in the Trail Type field.

Reference: For more information, see one of the following
topics:

• For definitions of trail types, see “PM terms” (10-4).

• For a graphical description of the differences between trail
types, see “Trail types” (10-8).

............................................................................................................................................................

3 Select the port address in the Port ID field.

Result:

Depending on what you enter in the Port ID field, the system
automatically populates the Signal ID field or the field is
unavailable.

Reference: For more information, see one of the following
topics:

• For general information about port addresses and signal
addresses, see “About entity addresses” (3-2).

• For specific information about the Signal ID field, see
“About signal layer addresses” (3-4).

............................................................................................................................................................

4 Click the Clear Counters button in the PM Count Control field.

............................................................................................................................................................

5 Click Apply.
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TCA Control window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the TCA Control window to query, allow, or inhibit the reporting
of a Threshold Crossing Alert (TCA) for one or more performance
monitoring (PM) parameters.

Window location Provision > Performance Monitoring > TCA Control

Organisation This section is organised as follows:

• “TCA Control window description” (10-26)

• “Querying TCA reporting” (10-28)

• “TCA Control query results” (10-29)

• “Starting TCA reporting when all parameters are inhibited”
(10-31)

• “Starting TCA reporting when some parameters are enabled”
(10-33)

• “Inhibiting TCA reporting” (10-35)

Performance monitoring
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TCA Control window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the TCA Control window.

Field descriptions The following information appears in the TCA Control window.

Field name Description

Trail Type The Trail Type column displays the trail type for
PM signal provisioning. The following options are
available:

• RS

• MS

• VC4_4c

• VC4

• VC3 (HP) — VC-3 as AU-3

• VC3 (LP) — VC-3 as TU-3

• VC12
For more information, see one of the following
topics:

• For definitions of trail types, see “PM terms”
(10-4).

• For a graphical description of the differences
between trail types, see “Trail types” (10-8).

TCA Control window and procedures Performance monitoring
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Field name Description

Port ID The Port ID fields specify the physical location of
the port.

For more information about addresses, see “About
entity addresses” (3-2).

Signal ID The Signal ID field specifies the signal that you
want to query or provision.

• For some Trail Type and Port ID
combinations, the system automatically
populates the Signal ID field.

• For RS and MS signals, this field is
unavailable.

For more information about signal addresses, see
“About signal layer addresses” (3-4).

Interval The Interval field tells the system to allow or
inhibit TCAs for the following time intervals:

• 15-Minute

• 24-Hour

• Both 15-Minute and 24-Hour

PM Parameters
— Reporting:
Near End

Near-end parameters are monitored and reported
by a local system. When the near-end parameters
exceed their threshold, the system will report a
Threshold Crossing Alert.

For a list and a definition of each parameter, see
“List of terms” (10-4).

PM Parameters
— Reporting:
Far End

Far-end parameters are monitored by a remote
system and reported by a local system. When the
far-end parameters exceed their threshold, the
system will report a Threshold Crossing Alert.

There are no far-end parameters for an RS trail.

For a list and a definition of each parameter, see
“List of terms” (10-4).

Related topic For general information about windows, see “About the main
application window” (2-10).

TCA Control window and procedures
TCA Control window description
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Querying TCA reporting
....................................................................................................................................................................................................................................

Purpose Use this procedure to query and display the TCA reporting status for
the specified Trail Type and Trail ID.

Procedure ............................................................................................................................................................

1 Go to the TCA Control window at Provision > Performance
Monitoring > TCA Control.

............................................................................................................................................................

2 Select the trail type in the Trail Type field.

Reference: For more information, see one of the following
topics:

• For definitions of trail types, see “PM terms” (10-4).

• For a graphical description of the differences between trail
types, see “Trail types” (10-8).

............................................................................................................................................................

3 Select the port address in the Port ID field.

Result:

Depending on what you enter in the Port ID field, the system
automatically populates the Signal ID field or the field is
unavailable.

Reference: For more information, see one of the following
topics:

• For general information about port addresses and signal
addresses, see “About entity addresses” (3-2).

• For specific information about the Signal ID field, see
“About signal layer addresses” (3-4).

............................................................................................................................................................

4 Click the appropriate Interval as 15-Minute or 24-Hour.

............................................................................................................................................................

5 Click Query.

TCA Control window and procedures Performance monitoring

....................................................................................................................................................................................................................................

1 0 - 2 8 Lucent Technologies 365–367–512
Issue 2, July 2002

E N D O F S T E P S
.........................................................................................................................................................................................................................................................



TCA Control query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results
from the TCA Control window.

Important! The data displayed on this screen may not be typical.

Results field descriptions The following information appears in the TCA Control Query Results
window.

Column Description

Port ID The Port ID column displays the Port ID, or
physical address, of the input port.

For more information about addresses, see “About
entity addresses” (3-2).

Signal ID The Signal ID column displays the Signal ID, or
signal address.

For more information about signal addresses, see
“About signal layer addresses” (3-4).

Interval The Interval column displays the time interval
associated with the displayed Allow/Inhibit
statuses as one of the following:

• 15-Minute

• 24-Hour

TCA Control window and procedures Performance monitoring
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Column Description

Trail Type The Trail Type column displays the trail type for
PM signal provisioning. The following options are
available:

• RS

• MS

• VC4_4c

• VC4

• VC3 (HP) — VC-3 as AU-3

• VC3 (LP) — VC-3 as TU-3

• VC12
For more information, see one of the following
topics:

• For definitions of trail types, see “PM terms”
(10-4).

• For a graphical description of the differences
between trail types, see “Trail types” (10-8).

NE_BBE The NE_BBE column displays the Allow/Inhibit
status for Near-End Background-Block Errors.

NE_ES The NE_ES column displays the Allow/Inhibit
status for Near-End Errored Seconds.

NE_SES The NE_SES column displays the Allow/Inhibit
status for Near-End Severely-Errored Seconds.

NE_UAS The NE_UAS column displays the Allow/Inhibit
status for Near-End Unavailable Seconds.

FE_BBE The FE_BBE column displays the Allow/Inhibit
status for Far-End Background Block Errors.

FE_ES The FE_ES column displays the Allow/Inhibit
status for Far-End Errored Seconds.

FE_SES The FE_SES column displays the Allow/Inhibit
status for Far-End Severely-Errored Seconds.

FE_UAS The FE_UAS column displays the Allow/Inhibit
status for Far-End Unavailable Seconds.

RS and far-end parameters The far-end parameter fields are unavailable if you select RS as a trail
type.

Related topic For general information about windows, see “About the main
application window” (2-10).

TCA Control window and procedures
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Starting TCA reporting when all parameters are inhibited
....................................................................................................................................................................................................................................

Purpose Use this procedure to start the reporting of a Threshold Crossing Alert
(TCA) for one or more PM parameters when all the parameters are
currently inhibited.

Before you begin If you are provisioning PM for the first time, perform the
following steps before starting TCA reporting.
............................................................................................................................................................

1 Start the counting from the Count Control window.

Reference:

Provision > Performance Monitoring > Count Control

............................................................................................................................................................

2 If you want to change the default TCA threshold values, set the new
values from the TCA Thresholds window.

Reference:

Provision > Performance Monitoring > TCA Thresholds

Procedure ............................................................................................................................................................

1 Go to the TCA Control window at Provision > Performance
Monitoring > TCA Control.

............................................................................................................................................................

2 Select the trail type in the Trail Type field.

Reference: For more information, see one of the following
topics:

• For definitions of trail types, see “PM terms” (10-4).

• For a graphical description of the differences between trail
types, see “Trail types” (10-8).

............................................................................................................................................................

3 Select the port address in the Port ID field.

Result:

Depending on what you enter in the Port ID field, the system
automatically populates the Signal ID field or the field is
unavailable.

TCA Control window and procedures Performance monitoring
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Reference: For more information, see one of the following
topics:

• For general information about port addresses and signal
addresses, see “About entity addresses” (3-2).

• For specific information about the Signal ID field, see
“About signal layer addresses” (3-4).

............................................................................................................................................................

4 Click the appropriate Interval.

............................................................................................................................................................

5 Check the box for each parameter in the Near End and Far End fields
that you want to enable with TCA reporting. Each parameter with its
box checked will have TCA reporting enabled for the specified
interval. Each parameter with its box not checked will have TCA
reporting inhibited.

............................................................................................................................................................

6 Click Apply.

TCA Control window and procedures
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Starting TCA reporting when some parameters are enabled
....................................................................................................................................................................................................................................

Purpose Use this procedure to start the reporting of a Threshold Crossing Alert
(TCA) for one or more PM parameters when some parameters are
enabled for the specified Trail ID.

Before you begin If you are provisioning PM for the first time, perform the
following steps before starting TCA reporting.
............................................................................................................................................................

1 Start the counting from the Count Control window.

Reference:

Provision > Performance Monitoring > Count Control

............................................................................................................................................................

2 If you want to change the default TCA threshold values, set the new
values from the TCA Thresholds window.

Reference:

Provision > Performance Monitoring > TCA Thresholds

Procedure Important! If you already have TCA reporting enabled for some
parameters (for example: BBE, ES, and SES) and you want to enable
TCA reporting for another parameter (for example: UAS), then you
must check the boxes for all of the parameters that you want enabled,
not just for the new parameters. The easiest way to enable TCA
reporting for another parameter is to query the TCA reporting first, as
described in the following procedure. This will tell you which
parameters are already enabled. Then you can check the box for these
parameters plus the new parameter that you want to enable.
............................................................................................................................................................

1 Go to the TCA Control window at Provision > Performance
Monitoring > TCA Control.

............................................................................................................................................................

2 Select the trail type in the Trail Type field.

Reference: For more information, see one of the following
topics:

• For definitions of trail types, see “PM terms” (10-4).

• For a graphical description of the differences between trail
types, see “Trail types” (10-8).
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............................................................................................................................................................

3 Select the port address in the Port ID field.

Result:

Depending on what you enter in the Port ID field, the system
automatically populates the Signal ID field or the field is
unavailable.

Reference: For more information, see one of the following
topics:

• For general information about port addresses and signal
addresses, see “About entity addresses” (3-2).

• For specific information about the Signal ID field, see
“About signal layer addresses” (3-4).

............................................................................................................................................................

4 Click the appropriate Interval.

............................................................................................................................................................

5 Click Query.

Result:

The current TCA control state displays on the TCA Control
Results window.

............................................................................................................................................................

6 Write down which parameters have TCA Reporting allowed, and close
the window, or click on the Update button to populate the fields in the
TCA Control window.

............................................................................................................................................................

7 In the TCA Control window, check the box for each parameter in the
Near End and Far End fields that you want to enable with TCA
reporting. Include all the parameters that were allowed in the TCA
Control Results window (see the previous step), unless you want to
disable them at this time.

............................................................................................................................................................

8 Click Apply.

Result:

Every parameter with its box checked will have TCA reporting
enabled for the specified interval. Every parameter with its box
not checked will have TCA reporting inhibited.

TCA Control window and procedures
Starting TCA reporting when some
parameters are enabled
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Inhibiting TCA reporting
....................................................................................................................................................................................................................................

Purpose Use this procedure to turn off the reporting of a Threshold Crossing
Alert (TCA) for one or more PM parameters for the specified Trail
ID.

Procedure ............................................................................................................................................................

1 Go to the TCA Control window at Provision > Performance
Monitoring > TCA Control.

............................................................................................................................................................

2 Select the trail type in the Trail Type field.

Reference: For more information, see one of the following
topics:

• For definitions of trail types, see “PM terms” (10-4).

• For a graphical description of the differences between trail
types, see “Trail types” (10-8).

............................................................................................................................................................

3 Select the port address in the Port ID field.

Result:

Depending on what you enter in the Port ID field, the system
automatically populates the Signal ID field or the field is
unavailable.

Reference: For more information, see one of the following
topics:

• For general information about port addresses and signal
addresses, see “About entity addresses” (3-2).

• For specific information about the Signal ID field, see
“About signal layer addresses” (3-4).

............................................................................................................................................................

4 Click the appropriate Interval.

............................................................................................................................................................

5 Click Query to determine which parameters have TCA reporting
enabled for the interval.

............................................................................................................................................................

6 Write down which parameters are allowed, and close the window, or
click on the Update button to populate the fields in the TCA Control
window.

TCA Control window and procedures Performance monitoring
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............................................................................................................................................................

7 In the TCA Control window, check the box for each parameter noted
in the previous step. Remove the checks for the PM parameters in the
Near End or Far End fields that you want to inhibit at this time.

............................................................................................................................................................

8 Click Apply.

TCA Control window and procedures
Inhibiting TCA reporting
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TCA Thresholds window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the TCA Thresholds window to query and provision the threshold
values for one or more performance-monitoring parameters.

Window location Provision > Performance Monitoring > TCA Thresholds

Organisation This section is organised as follows:

• “TCA Thresholds window description” (10-38)

• “Querying TCA threshold values” (10-41)

• “Changing TCA threshold values” (10-44)

Performance monitoring
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TCA Thresholds window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the TCA Thresholds window.

Field descriptions The TCA Thresholds window has the following fields.

Field name Description

Trail Type The Trail Type column displays the trail type for
PM signal provisioning. The following options are
available:

• RS

• MS

• VC4_4c

• VC4

• VC3 (HP) — VC-3 as AU-3

• VC3 (LP) — VC-3 as TU-3

• VC12
For more information, see one of the following
topics:

• For definitions of trail types, see “PM terms”
(10-4).

• For a graphical description of the differences
between trail types, see “Trail types” (10-8).

TCA Thresholds window and procedures Performance monitoring
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Field name Description

Port ID The Port ID fields specify the physical location of
the port.

For more information about addresses, see “About
entity addresses” (3-2).

Signal ID The Signal ID field specifies the signal that you
want to query or provision.

• For some Trail Type and Port ID
combinations, the system automatically
populates the Signal ID field.

• For RS and MS signals, this field is
unavailable.

For more information about signal addresses, see
“About signal layer addresses” (3-4).

Interval Tells the system to set TCA thresholds for
parameters at the following time intervals:

• 15-Minute

• 24-Hour

PM Parameters
— TCA
Thresholds:
Near End
Thresholds

The Near End Thresholds fields specify the
Threshold Crossing Alert (TCA) thresholds for
PM parameters. Near-end PM parameters are
monitored and reported by a local system. When
the near-end parameters exceed their threshold,
the system will report a Threshold Crossing Alert.
For more information, see any of the following
topics:

• “VC-3, VC-4, and VC-4-4c threshold values”
(10-9)

• “VC-12 threshold values” (10-10)

• “RS threshold values” (10-11)

• “MS threshold values” (10-12)

• For a list and a definition of each parameter,
see “List of terms” (10-4).

TCA Thresholds window and procedures
TCA Thresholds window description
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Field name Description

PM Parameters
— TCA
Thresholds: Far
End Thresholds

The PM Parameters field specifies the Threshold
Crossing Alert (TCA) thresholds for PM
parameters. Far-end PM parameters are monitored
by a remote system and reported by a local
system. When the far-end parameters exceed their
threshold, the system will report a Threshold
Crossing Alert.
For more information, see any of the following
topics:

• “VC-3, VC-4, and VC-4-4c threshold values”
(10-9)

• “VC-12 threshold values” (10-10)

• “RS threshold values” (10-11)

• “MS threshold values” (10-12)

• For a list and a definition of each parameter,
see “List of terms” (10-4).

RS and far-end parameters The far-end parameter fields are unavailable if you select RS as a trail
type.

Related topic For general information about windows, see “About the main
application window” (2-10).

TCA Thresholds window and procedures
TCA Thresholds window description
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Querying TCA threshold values
....................................................................................................................................................................................................................................

Purpose Use this procedure to query and display the TCA threshold values and
intervals for PM parameters for the specified Trail ID.

Procedure ............................................................................................................................................................

1 Go to the TCA Thresholds window at Provision > Performance
Monitoring > TCA Thresholds.

............................................................................................................................................................

2 Select the trail type in the Trail Type field.

Reference: For more information, see one of the following
topics:

• For definitions of trail types, see “PM terms” (10-4).

• For a graphical description of the differences between trail
types, see “Trail types” (10-8).

............................................................................................................................................................

3 Select the port address in the Port ID field.

Result:

Depending on what you enter in the Port ID field, the system
automatically populates the Signal ID field or the field is
unavailable.

Reference: For more information, see one of the following
topics:

• For general information about port addresses and signal
addresses, see “About entity addresses” (3-2).

• For specific information about the Signal ID field, see
“About signal layer addresses” (3-4).

............................................................................................................................................................

4 Click the Interval to display the 15-minute or the 24-hour intervals.

Result:

The default threshold values for the selected trail and interval
will automatically display on the screen.

............................................................................................................................................................

5 Click Query for the currently-provisioned threshold values.

TCA Thresholds window and procedures Performance monitoring
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TCA Thresholds query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results
from the TCA Threshold window.

Important! The data displayed on this screen may not be typical.

Results field descriptions The following information appears in the TCA Thresholds Query
Results window.

Column Description

Port ID The Port ID column displays the Port ID, or
physical address, of the input port.

For more information about addresses, see “About
entity addresses” (3-2).

Signal ID The Signal ID column displays the Signal ID, or
signal address.

For more information about signal addresses, see
“About signal layer addresses” (3-4).

Interval The Interval column displays the time interval
associated with the displayed TCA threshold
values as one of the following:

• 15-Minute

• 24-Hour

TCA Thresholds window and procedures Performance monitoring
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Column Description

Trail Type The Trail Type column displays the trail type for
PM signal provisioning. The following options are
available:

• RS

• MS

• VC4_4c

• VC4

• VC3 (HP) — VC-3 as AU-3

• VC3 (LP) — VC-3 as TU-3

• VC12
For more information, see one of the following
topics:

• For definitions of trail types, see “PM terms”
(10-4).

• For a graphical description of the differences
between trail types, see “Trail types” (10-8).

NE_BBE The NE_BBE column displays the TCA threshold
for Near-End Background-Block Errors.

NE_ES The NE_ES column displays the TCA threshold
for Near-End Errored Seconds.

NE_SES The NE_SES column displays the TCA threshold
for Near-End Severely-Errored Seconds.

NE_UAS The NE_UAS column displays the TCA threshold
for Near-End Unavailable Seconds.

FE_BBE The FE_BBE column displays the TCA threshold
for Far-End Background-Block Errors.

FE_ES The FE_ES column displays the TCA threshold
for Far-End Errored Seconds.

FE_SES The FE_SES column displays the TCA threshold
for Far-End Severely-Errored Seconds.

FE_UAS The FE_UAS column displays the TCA threshold
for Far-End Unavailable Seconds.

RS and far-end parameters The far-end parameter fields are unavailable if you select RS as a trail
type.

Related topic For general information about windows, see “About the main
application window” (2-10).

TCA Thresholds window and procedures
TCA Thresholds query results
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Changing TCA threshold values
....................................................................................................................................................................................................................................

Purpose Use this procedure to change the default TCA thresholds for one or
more performance-monitoring parameters.

Procedure ............................................................................................................................................................

1 Go to the TCA Thresholds window at Provision > Performance
Monitoring > TCA Thresholds.

............................................................................................................................................................

2 Select the trail type in the Trail Type field.

Reference: For more information, see one of the following
topics:

• For definitions of trail types, see “PM terms” (10-4).

• For a graphical description of the differences between trail
types, see “Trail types” (10-8).

............................................................................................................................................................

3 Select the port address in the Port ID field.

Result:

Depending on what you enter in the Port ID field, the system
automatically populates the Signal ID field or the field is
unavailable.

Reference: For more information, see one of the following
topics:

• For general information about port addresses and signal
addresses, see “About entity addresses” (3-2).

• For specific information about the Signal ID field, see
“About signal layer addresses” (3-4).

............................................................................................................................................................

4 Click the appropriate Interval.

............................................................................................................................................................

Important! Perform a query before changing the threshold value for
any parameter. If you do not perform a query, you may inadvertently
set the threshold value of another parameter to its default value.

5 Click Query to see the currently-provisioned threshold values.

............................................................................................................................................................

6 Write down the threshold value of each parameter, and close the
window, or click on the Update button to populate the fields in the
TCA Thresholds window.

TCA Thresholds window and procedures Performance monitoring
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............................................................................................................................................................

7 In the TCA Thresholds window, change the threshold values for the
parameters in the Near End Thresholds and Far End Thresholds fields
based on the data you collected in the previous step. You may also
change any other threshold values at this time.

............................................................................................................................................................

8 Click Apply.

............................................................................................................................................................

9 If you are provisioning PM for the first time, go to the TCA Control
window to start the TCA reporting.

Reference: For more information, see one of the following
topics:

• “Starting TCA reporting when all parameters are inhibited”
(10-31)

• “Starting TCA reporting when some parameters are
enabled” (10-33)

TCA Thresholds window and procedures
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11 About alarms

Overview
....................................................................................................................................................................................................................................

Purpose “About alarms” contains general information about alarms.

Organisation “About alarms” is organised as follows:

• “Alarm terms” (11-2)

• “Defects and failures” (11-3)

• “Delay timers” (11-4)

• “Alarm Panel” (11-5)

• “User Panel” (11-6)

• “Conditions that affect service” (11-7)

• “Alarm indicator definition” (11-8)

• “Alarm indicator descriptions” (11-9)

• “MDIs and MDOs” (11-10)

• “About disconnecting and suppressing alarm indicators” (11-12)

• “About provisioning alarm indicators” (11-13)
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Alarm terms
....................................................................................................................................................................................................................................

List of terms Deferred Deferred indicates one, or both, of the following: a
performance-degrading condition exists, but the condition does
not affect service; a changeover to standby equipment has been
used to restore service. Maintenance personnel must take
immediate action, but they must resolve any prompt alarms first.

Information An alarm designated as information means that the
alarm requires no immediate action. Maintenance personnel can
perform the required actions on a scheduled basis or after an
accumulation of maintenance events. Information alarms are
indicated only on the User Panel.

Prompt A prompt alarm indicates that maintenance personnel
must repair the defective equipment or take whatever corrective
action is necessary to restore good service. Alarms for conditions
that affect service are always classified as prompt.

About alarms
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Defects and failures
....................................................................................................................................................................................................................................

Differences between
transmission and

equipment defects or
failures

The system collects information about transmission and equipment
defects, failures, or degraded performance.

The difference between a transmission defect or failure, and an
equipment defect or failure is as follows:

• A transmission defect or failure indicates a problem with the
transmission signal received from outside your local equipment.

• An equipment defect or failure indicates a problem with the
system equipment.

Alarm and defect reports The system logs information about transmission and equipment
defects and alarms. You can examine or print a report from a local or
remote PC.

How the system correlates
defects

The system correlates observed defects to determine the source of the
trouble. If multiple parts of the system detect defects caused by one
problem, the system uses defect correlation to try to find the real
cause and to suppress side-effect causes. After the system correlates a
defect, the system will time the defect to determine if the defect
should be declared a failure.

Failures and consequent
actions

If a defect persists long enough to be considered a failure, the system
initiates the consequent actions defined for that failure. Consequent
actions return the system to proper operation or prevent faults from
propagating through the network.

Example of a consequent action

One example of a consequent action is the switching of service from
the equipment that is currently providing service to standby or
protection equipment.

About alarms
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Delay timers
....................................................................................................................................................................................................................................

Defect-to-alarm delay
timers

The defect-to-alarm delay is the amount of time the system waits after
a defect occurs before the system declares and reports a failure. If the
defect goes away before the defect-to-alarm delay expires, no alarm is
generated.

Alarm-clear delay timers The alarm-clear delay is the number of seconds that the system waits
after an equipment or transmission alarm has cleared before turning
off the associated alarm indicators and generating an alarm-clear
message.

About alarms
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Alarm Panel
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Alarm Panel.

What is displayed on the
Alarm Panel?

The Alarm Panel displays alarm tallies and information about
autonomous events. You can gain access to the Alarm Panel from a
local or remote PC.

What are alarm tallies? Alarm tallies are the current numbers of prompt, deferred, and
information alarms for the system.

What are autonomous
events?

Autonomous events are actions that the system initiates automatically.

Examples of autonomous events

Alarms, protection-switching events, and system clock reference
changes are examples of autonomous events.

About alarms
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User Panel
....................................................................................................................................................................................................................................

User Panel alarm
indicators and controls

The User Panel is located on the front of the Main Controller rack,
below the Main Controller subrack. The User Panel displays general
system status and alarm information.

The Alarm Connector Panel (ACP) and the Fan Connector Panel
(FCP) are located on the back of the User Panel. The ACP and the
FCP have connectors for alarm-related cables.

Related topics

For more information, see one of the following topics:

• “User Panel” (1-20)

• “Alarm Connector Panel (ACP)” (1-22)

• “Fan Connector Panel (FCP)” (1-25)
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Conditions that affect service
....................................................................................................................................................................................................................................

What affects service? Any of the following conditions will affect service:

• Protection is not available for the alarmed equipment or
transmission entity.

• The alarmed entity is still providing service and cannot be
protected.

• For control functions, any condition that can cause a
cross-connect command to be denied.
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Alarm indicator definition
....................................................................................................................................................................................................................................

What are alarm
indicators?

Once a failure is declared, the system raises an alarm and turns on the
appropriate alarm indicators. The alarm indicators provide a trail of
lights that identifies the suite, rack, and unit on which the failure
occurred. Alarm indicators are interfaced through solid-state relays
located on the ARU in the Main Controller subrack. Alarm indicators
are turned on or off by opening or closing relay contacts. When the
condition that caused an alarm clears, the system clears the failure and
automatically turns the alarm indicators off.
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Alarm indicator descriptions
....................................................................................................................................................................................................................................

End-of-suite alarm
indicators

Typically, Prompt and Deferred end-of-suite alarm indicators are
located at the end of every suite (aisle), and are activated when the
system detects a fault in that suite. You can disconnect or suppress
end-of-suite alarm indicators from the User Panel or from a local or
remote PC.

Rack-top alarm indicators Prompt and Deferred rack-top alarm indicators are located at the top
of each equipment rack and are activated when the system detects a
fault in that rack. You can suppress rack-top alarm indicators from the
User Panel or from a local or remote PC. You cannot disconnect
rack-top alarm indicators.

Station alarm indicators Station alarm indicators are alarm indicators that your company has
designed to draw attention to an alarm condition. Station alarm
indicators can be designed to either ring or light. These alarm
indicators can be located in the equipment room or in other parts of
the office. The system provides relays for the disconnectable and
nondisconnectable station alarm indicators.

Disconnectable and
nondisconnectable station

alarm indicators

In a typical configuration, disconnectable station alarm indicators are
connected to audible alarms, and nondisconnectable station alarm
indicators are connected to visual alarms. If you disconnect a station
alarm indicator, the audible alarms are silenced, but the visual alarms
remain active until the failure has cleared.

You can disconnect or suppress disconnectable station alarm indicators
on a system-wide basis. You cannot disconnect nondisconnectable
station alarm indicators, but you can suppress nondisconnectable
station alarm indicators on a system-wide basis.

You can disconnect or suppress station alarm indicators from the User
Panel or from a local or remote PC.

Related topic For information about Miscellaneous Discrete (MD) alarm indicators,
see “MDIs and MDOs” (11-10).
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MDIs and MDOs
....................................................................................................................................................................................................................................

Description Miscellaneous Discrete (MD) alarm indicators provide alarm
indications for internal and external events; such as burglar alarms,
smoke detectors, door contacts, and fan failures in port racks that are
equipped with PSC subracks. MD alarm indicators are connected on
the Fan Connector Panel (FCP), which is located on the back of the
User Panel. The system provides Miscellaneous Discrete Inputs
(MDIs) and Miscellaneous Discrete Outputs (MDOs).

MDIs MDIs provide inputs to the DACS system from fan trays in port racks
that are equipped with PSC subracks, and from external equipment.
You can use MDIs to collect status information from other
transmission equipment or to monitor internal and external events. The
DACS system allows up to eight inputs from fan trays in port racks
that are equipped with PSC subracks, and up to four inputs from
external equipment.

MDOs You can use MDOs to provide outputs from the DACS system to
drive external equipment. The DACS system allows three MDOs.

Connecting MDIs to the
FCP

MDIs from external equipment are connected to the connector labeled
MD IN on the FCP. Refer to “Fan Connector Panel (FCP)” (1-25) for
a description and illustration of the FCP.

MDIs from fan trays in port racks that are equipped with PSC
subracks are connected to the connectors labeled MDI 1 through MDI
4 on the FCP. Each of the four MDIs is a group of four connectors,
for a total of 16 connectors. This configuration gives you flexibility in
connecting the MDIs.

If you want to use MDIs to monitor fan failures and external
equipment alarms and you have more than four MDIs, group the fan
tray inputs, because fan failures are also indicated by lighting an LED
on the connector panel of the failed port rack fan tray. If fan tray MD
inputs are grouped and one of the fans in the group fails, you can
identify which port rack fan tray has the failure by looking for a
lighted FAIL LED on each fan tray connector panel.

MDI connection example If you have four port rack fan trays that you want to connect to
MDIs, you can connect all four fan trays to one MDI, one fan tray to
each of the four MDIs, or two fan trays to two of the four MDIs. If
you have more than four port rack fan trays, more than one fan tray
will have to be connected to at least one MDI.
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Provisioning MDs You cannot enable or disable MDs from the user interface on the
DACS system. MDs are always enabled.

Testing MDOs You can test the MDO alarm indicators from the Maintenance >
Alarm Indicator Tests window. If the MDOs are not connected to any
external equipment, you can run an Alarm Indicator test and check for
continuity on a specific output with a Volt Ohm Meter (VOM).

Testing MDIs All MDIs were tested during installation. If you need to test the MDIs
again, you can short the appropriate pins and check for an alarm
indication. You can also run a diagnostic test on the MD input
circuitry on the ARU using the MD Inputs diagnostic test.

Related topic

Use the Maintenance > Execute Tests > Diagnostic Tests window to
run an MD Inputs diagnostic test.

Alarms on MDs MDcIP{1–4} alarms report monitored internal or external events to
the local system. If an event occurs, the system will raise an alarm.
You can change the severity of these alarms.

Related topic

To change the alarm severity, go to Provision > Alarm Settings >
Severity Levels on the user interface.

MDIs and MDOs About alarms
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About disconnecting and suppressing alarm indicators
....................................................................................................................................................................................................................................

General information about
disconnecting and
suppressing alarm

notifications

When you disconnect or suppress alarm indicators, the system will
turn off the corresponding visual or audible notifications of the alarm.
However, you can still gain access to information about alarms
through a local or remote PC with XC-CIT application software. A
yellow LED next to the DISCONNECTED or SUPPRESSED button
on the User Panel indicates that alarm indicators are disconnected or
suppressed.

About disconnecting
alarm indicators

When you disconnect alarm indicators, the disconnection becomes a
system-wide and permanent condition. Alarms that occur after you
disconnect alarm indicators will not be indicated until you remove the
disconnection.

You can remove the disconnection in either of the following ways:

• Press the DISCONNECT button on the User Panel

• Go to Alarms > Station Alarm Control

About suppressing alarm
indicators

When you suppress alarm indicators, the suppression becomes a
system-wide and temporary condition. The system will turn off
suppressible indicators for current alarms only. Any subsequent alarms
will light the alarm indicators. Once you suppress the alarm
indicators, the SUPPRESSED alarm indicator on the User Panel lights
and remains lit until you clear the originally-suppressed alarms. You
must clear the originally-suppressed alarms to remove the suppression
of any alarm indicators.

About alarms

....................................................................................................................................................................................................................................

1 1 - 1 2 Lucent Technologies 365–367–512
Issue 2, July 2002



About provisioning alarm indicators
....................................................................................................................................................................................................................................

Changing alarm indicators You can change station, rack-top, end-of-suite, and User Panel alarm
indicators from suppressible to nonsuppressible or vice versa by using
the Alarm Suppress Control window at Provision > Alarm Settings >
Alarm Suppress Control.
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12 Alarm settings

Overview
....................................................................................................................................................................................................................................

Purpose “Alarm settings” contains the following information:

• Descriptions of the windows that are used to provision alarm
settings

• Step-by-step procedures for provisioning alarm-severity levels,
delay and pre-service timer values, and the suppress status of
alarm indicators

Related topic

For general information about alarms, see Chapter 11, “About
alarms”.

Organisation The organisation is as follows:

• “Severity Levels window and procedures” (12-2)

• “Timers window and procedures” (12-11)

• “Alarm Suppress Control window and procedures” (12-16)
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Severity Levels window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the Severity Levels window to do the following:

• Query the severity levels for all equipment or transmission
alarms

• Change the severity levels for equipment or transmission failure
conditions

• Restore the severity levels for all equipment or transmission
alarms to the system defaults

Window location Provision > Alarm Settings > Severity Levels

Organisation This section is organised as follows:

• “Severity Levels window description” (12-3)

• “Querying alarm severity levels” (12-5)

• “Severity Levels query results” (12-6)

• “Changing alarm severity levels” (12-9)

• “Restoring the severity levels” (12-10)

Alarm settings
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Severity Levels window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Severity Levels window.

Field descriptions The Severity Levels window has the following fields.

Field name Description

Equipment Select Equipment to query or provision equipment
alarms.

Transmission Select Transmission to query or provision
transmission alarms.

Failure
Condition

The Failure Condition field specifies the alarm for
which you want to change the severity levels.

For more information about each of these failure
conditions, see the Alarm clearing chapter in the
Maintenance guide, 365-367-513.

Severity Levels window and procedures Alarm settings
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Field name Description

Service-
Affecting
Severity

The Service-Affecting Severity field specifies the
severity level of the equipment or transmission
alarm that is raised for the specified Failure
Condition when a service-affecting condition
exists. If this area of the window is not
accessible, it means that the corresponding
severity level is not applicable to that failure
condition.
The valid values are as follows:

• Prompt

• Deferred

• Info

• No change

Non-Service-
Affecting
Severity

The Non-Service-Affecting Severity field specifies
the severity level of the equipment or transmission
alarm that is raised for the specified Failure
Condition when a non-service-affecting condition
exists. If this area of the window is not
accessible, it means that the corresponding
severity level is not applicable to that failure
condition.
The valid values are as follows:

• Prompt

• Deferred

• Info

• No change

Related topic For general information about windows, see “About the main
application window” (2-10).

Severity Levels window and procedures
Severity Levels window description
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Querying alarm severity levels
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Severity Levels window at Provision > Alarm Settings >
Severity Levels.

............................................................................................................................................................

2 Select Equipment or Transmission.

............................................................................................................................................................

3 Click Query.

Severity Levels window and procedures Alarm settings
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Severity Levels query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results for
equipment alarms on the Severity Levels window.

Important! The data displayed on this screen may not be typical.

Severity Levels window and procedures Alarm settings
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Illustration Use the following illustration only as an example of query results for
transmission alarms on the Severity Levels window.

Important! The data displayed on this screen may not be typical.

Results field descriptions The following information appears in the Severity Levels Query
Results window.

Column Description

Failure
Condition

The Failure Condition column displays the failure
condition associated with the alarm.

For more information about each of these failure
conditions, see the Alarm clearing chapter in the
Maintenance guide, 365-367-513.

Service
Affecting
Severity

Displays one of the following values:

• Prompt

• Deferred

• Info

• NA (not applicable)

Severity Levels window and procedures
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Column Description

Non-Service-
Affecting
Severity

Displays one of the following values:

• Prompt

• Deferred

• Info

• NA (not applicable)

Related topic For general information about windows, see “About the main
application window” (2-10).
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Changing alarm severity levels
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Severity Levels window at Provision > Alarm Settings >
Severity Levels.

............................................................................................................................................................

2 Select Equipment or Transmission.

............................................................................................................................................................

3 Select a Failure Condition.

............................................................................................................................................................

4 Change the Service-Affecting Severity, Non-Service-Affecting
Severity, or both.

............................................................................................................................................................

5 Click Apply.

Severity Levels window and procedures Alarm settings
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Restoring the severity levels
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Severity Levels window at Provision > Alarm Settings >
Severity Levels.

............................................................................................................................................................

2 Select Equipment or Transmission.

............................................................................................................................................................

3 Click Restore All.
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Timers window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the Timers window to query or change the value of any of the
following timers:

• Defect to Alarm Delay

• Alarm Clear Delay

• Pre-Service

When you open the Timers window, the default timer values are
displayed. To display a currently-provisioned timer value, click the
appropriate Query button.

Window location Provision > Alarm Settings > Timers

Organisation This section is organised as follows:

• “Timers window description” (12-12)

• “Querying timer values” (12-14)

• “Changing a timer value” (12-15)

Alarm settings
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Timers window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Timers window.

Field descriptions The Timers window has the following fields.

Field name Description

Defect to Alarm
Delay

The Defect to Alarm Delay field specifies the
number of seconds that the system waits after
detecting an equipment or transmission defect
before generating an alarm. If the defect clears
(goes away) before the delay interval expires, the
system does not raise an alarm.

The field also specifies the number of seconds
that the system waits after an alarm is raised
before turning on the station alarm indicators.

The valid values are 0–128 seconds, in 1/2-second
increments. The default value is 2.5.

Alarm Clear
Delay

The Alarm Clear Delay field specifies the number
of seconds that the system waits, after an
equipment or transmission alarm has cleared,
before turning off the associated alarm indicators
and generating an alarm clear message.

The valid values are 0–128 seconds, in 1/2-second
increments. The default value is 10.

Timers window and procedures Alarm settings
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Field name Description

Pre-Service
Timer

The Pre-Service Timer field specifies the number
of minutes that a valid transmission signal must
be received before the monitoring mode for ports
provisioned as AUTO (automatic monitoring)
changes to MON (monitored).

The valid values are 0–30 minutes, in 1-minute
increments. The default value is 10.

Related topic For general information about windows, see “About the main
application window” (2-10).

Timers window and procedures
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Querying timer values
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Timers window at Provision > Alarm Settings > Timers.

..........................................................................................................................................................

2 If you want to query Then

Delay timer values Click the Query button in the
Delay Timers area of the
window.

The pre-service timer value Click the Query button in the
Pre-Service area of the window.

Result

The system displays the provisioned timer value in a query results
window.

Timers window and procedures Alarm settings
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Changing a timer value
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Timers window at Provision > Alarm Settings > Timers.

............................................................................................................................................................

2 Select a value for Defect to Alarm Delay, Alarm Clear Delay, or
Pre-Service Timer.

............................................................................................................................................................

3 Click Apply.
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Alarm Suppress Control window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the Alarm Suppress Control window to query or change the
suppress status (suppressible or nonsuppressible) of the following
alarm indicators:

• Station

• End-of-suite and Rack top

• User Panel

When you open the Alarm Suppress Control window, the default
alarm suppress values are displayed. To display the currently-
provisioned values, click the Query button.

Window location Provision > Alarm Settings > Alarm Suppress Control

Organisation This section is organised as follows:

• “Alarm Suppress Control window description” (12-17)

• “Querying the suppress status of alarm indicators” (12-18)

• “Changing the suppress status of alarm indicators” (12-19)

Alarm settings
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Alarm Suppress Control window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Alarm Suppress Control window.

Field descriptions The Alarm Suppress Control window has the following fields.

Field name Description

No Change Select No Change if you do not want to change
the suppress status (suppressible or
nonsuppressible) of an alarm indicator.

Suppressible Select Suppressible to provision alarm indicators
as suppressible. Alarm indicators that are
provisioned as suppressible can be suppressed
from the User Panel or from a local or remote PC
with XC-CIT application software.

Non-
Suppressible

Select Non-Suppressible to provision alarm
indicators as nonsuppressible. Alarm indicators
that are provisioned as nonsuppressible cannot be
suppressed.

Related topic For general information about windows, see “About the main
application window” (2-10).

Alarm Suppress Control window and
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Querying the suppress status of alarm indicators
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Alarm Suppress Control window at Provision > Alarm
Settings > Alarm Suppress Control.

............................................................................................................................................................

2 Click Query.

Result:

The suppress status (suppressible or nonsuppressible) displays in
a query results window.

Alarm Suppress Control window and
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Changing the suppress status of alarm indicators
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Alarm Suppress Control window at Provision > Alarm
Settings > Alarm Suppress Control.

............................................................................................................................................................

2 Select No Change, Suppressible, or Non-Suppressible as desired for
each type of alarm indicator that you want to modify.

............................................................................................................................................................

3 Click Apply.
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13 Synchronisation and timing

Overview
....................................................................................................................................................................................................................................

Purpose “Synchronisation and timing” contains the following information:

• General information about synchronisation and timing

• Descriptions of the windows that are used to provision
synchronisation and timing

• Step-by-step procedures for the following:

- Querying the system clock, station clock, or the status of the
working and protection STUs

- Assigning the station clock as the timing reference for the
system clock

- Assigning a transmission port as the timing reference for the
system clock

- Deleting a timing reference for the system clock

- Changing the priority of the system’s internal clock

- Assigning the system clock as the timing reference for the
station clock

- Assigning a transmission port as the timing reference for the
station clock

Organisation The organisation is as follows:

• “Background information” (13-2)

• “System Clock window and procedures” (13-13)

• “Station Clock window and procedures” (13-27)
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Background information

Overview
....................................................................................................................................................................................................................................

Purpose This section contains background information about synchronisation
and timing.

Organisation This section is organised as follows:

• “Synchronisation and timing hardware” (13-3)

• “Input reference definitions” (13-4)

• “Timing modes” (13-5)

• “How synchronisation and timing works” (13-6)

• “System clock input timing references” (13-7)

• “Input timing references for station clock output ports” (13-8)

• “Synchronisation and priorities” (13-10)

• “About changing timing references” (13-11)

• “The synchronisation and timing provisioning process” (13-12)
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Synchronisation and timing hardware
....................................................................................................................................................................................................................................

Synchronisation and
timing hardware

capabilities

The system has duplicated synchronisation and timing hardware that
provides the following capabilities:

• The STU has an ITU G.812 Type I clock with holdover mode.

• System clock input references can be derived from
traffic-carrying lines (transmission ports or MSP pairs) or from
external references (station clock inputs).

• External references can be derived from 2048 kHz inputs or from
64 kHz composite clock inputs.

• Reference source and timing mode selection are based on
user-assigned priorities.

• System timing is distributed to transmission hardware within the
system.

• A 2048 kHz station clock output port on each STU that can be
used as a timing source for other equipment.

• When no faults are present, user-initiated protection switching of
the synchronisation and timing hardware is glitchless.

Cross-couple link A cross-couple link between the active and standby synchronisation
and timing hardware enables the standby hardware to maintain the
same frequency and phase as the active hardware. Consequently, no
bit errors (also called hits or glitches) are caused by manual switching
of the synchronisation and timing hardware.

Station clock cable
connections

Each Matrix and Synchronisation subrack has connectors for station
clock input and output cables. There are two station clock input
connectors (Station Clock In 1 and Station Clock In 2) and one station
clock output connector (Station Clock Out) on each Matrix and
Synchronisation subrack.

Background information Synchronisation and timing
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Input reference definitions
....................................................................................................................................................................................................................................

List of terms Station clock input The station clock input (2048 kHz or 64
kHz) depends on the type of System Timing Unit (STU) that is
installed in the system.

System clock input reference System clock input references can
be derived from transmission ports or from external timing
references (station clock inputs). External references can be
derived from one or two 2048 kHz timing inputs or from one or
two 64 kHz composite clock inputs.

Background information Synchronisation and timing
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Timing modes
....................................................................................................................................................................................................................................

Free-running mode The system operates in free-running mode when it is initially put into
service. In free-running mode, the system timing is provided by the
internal clock. This timing mode can be used for installation/testing
before timing references are provisioned. If a protection switch of the
synchronisation and timing hardware occurs while the system is in
free-running mode, the timing mode changes to holdover mode. After
the system has been phaselocked to a timing reference, it will not
return to free-running mode.

Phaselocked mode Phaselocked mode is the normal mode of operation. In this mode, the
active STU is slaved to an external timing reference (transmission port
or station clock input). The standby STU is phaselocked to the active
STU through a cross-couple link.

Holdover mode Holdover mode is a backup operational mode that the system switches
to automatically if all provisioned timing references have failed, or if
a protection switch of the STU occurs while the system is in
free-running mode. In holdover mode, the internal system clock
simulates the timing that occurred during a previous period in
free-running mode or phaselocked mode. Before switching to holdover
mode, the system should be phaselocked to a good timing reference
for at least 30 minutes. The system can enter holdover mode after a
shorter phaselock interval, but transmission performance requirements
may not be satisfied.

An alarm is raised whenever the system enters holdover mode.

Background information Synchronisation and timing
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How synchronisation and timing works
....................................................................................................................................................................................................................................

Synchronisation and
timing diagram

The following illustration shows the duplicated STUs and the various
input timing references for the system clock and station clock.

Legend:

1. Station clock input reference from the transmission port

2. Cross-couple from the standby STU

3. System clock input references

4. Station clock inputs

5. Protection STU

6. Working STU

7. System clock

8. Internal clock

9. Station clock outputs

10. Timing for transmission ports

1

5

7
10

9

8

6

2

3

4
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System clock input timing references
....................................................................................................................................................................................................................................

Types of STUs Two types of STU are available. One STU accepts 2048 kHz station
clock inputs, and the other STU accepts 64 kHz station clock inputs.
Both types of STU have two station clock input ports.

The STU with the G.812 Type VI clock that was used in Release 1.0
and Release 1.1 systems can also be used in later releases.

Types of system clock
input references

System clock input references can be derived from transmission ports
or from external timing references (station clock inputs).

Types of external or
station clock inputs

External references can be derived from one or two 2048 kHz timing
inputs or from one or two 64 kHz composite clock inputs. The type of
station clock input (2048 kHz or 64 kHz composite clock) depends on
the type of STU that is installed in the system.

Limits on timing
references

You can provision as many as four prioritised timing references for
the system clock. If no references are provisioned, the system operates
in free-running or holdover timing mode.

There is a limit of one timing reference per port unit. If MSP is
provisioned, only one port per MSP pair can be a timing reference,
and the port must be on the working unit. If SNCP is provisioned, the
working or protection port unit can be provisioned as a timing
reference. For a two-fibre or a four-fibre port subrack, you can
provision as many as four timing references. For a one-fibre port
subrack, you can provision as many as two timing references.

The limits for line-derived timing references apply to both system
clock input references and station clock input references. For example,
if four STM-1 ports in a dual-fibre port subrack are provisioned as
system clock input references, a fifth STM-1 port in the same port
subrack cannot be provisioned as a station clock input reference. Also,
if a port on an STM-1 port unit is provisioned as a system clock input
reference, another port on the same unit cannot be provisioned as a
station clock input reference.

Background information Synchronisation and timing
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Input timing references for station clock output ports
....................................................................................................................................................................................................................................

Station clock output ports The system provides two 2048 kHz station clock output ports, one
output port on each STU. The station clock output port can be used as
a timing source for other equipment. The input timing reference for
the station clock output port can be derived from the system clock or
from a transmission port, including ports provisioned for MSP or
SNCP.

If the input timing reference used for the station clock outputs is a
transmission port, the port can be one of the transmission ports used
as an input reference for the system clock, or the port can be different
from any of the transmission ports used as input references for the
system clock. Because both station clock output ports get their input
from the same timing source, the output signals are not independent.
A failure of the timing source affects both station clock output ports.

Hardware connections for
station clock input

references

When the input timing reference for the system clock is derived from
an external reference, the station clock input ports on the working and
protection MS subracks should be connected to the same external
reference. The following illustration shows the connections for two
station clock input references. The connectors for the station clock
inputs are located on the back of the Matrix and Synchronisation
subrack.

Legend:

1. Working Matrix and Synchronisation subrack

2. Protection Matrix and Synchronisation subrack

STATION CLOCK

IN 1

IN 2

OUT

STATION CLOCK

IN 1

IN 2

OUT

1

2

3

4
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3. Reference 1

4. Reference 2

Signal failures The timing output signal is squelched (no signal is transmitted) if the
STU has a hardware failure that prevents a valid signal from being
transmitted. If timing is derived from a transmission port, a signal
failure will also cause the output signal to be squelched.

Background information
Input timing references for station clock
output ports
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Synchronisation and priorities
....................................................................................................................................................................................................................................

About assigning priorities
to system clock input
references and to the

internal clock

A priority can be assigned to each system clock input reference and to
the internal clock. The system selects the active timing reference for
the system clock based on the status of the provisioned references
(good or failed) and the assigned priority. Only a reference whose
status is good will be selected as the active reference. Priority
assignments do not have to be unique. That is, the same priority can
be assigned to more than one reference.

Priorities and timing
modes

The priority you assign to system clock input references and to the
internal clock determine how timing modes are selected. The default
priority for the internal clock (holdover timing mode) is lower than
any of the priorities that can be assigned to system clock input
references. Consequently, under normal circumstances, the system will
go into holdover timing mode only if all references provisioned for
the system clock have failed. The system can, however, be forced into
holdover mode by assigning the internal clock a higher priority than
any of the references provisioned for the system clock.

Priorities and protection
switching

The priority assigned to system clock input references also determines
whether reference selection (switching) is revertive or nonrevertive. If
timing references are assigned different priority values, reference
selection is revertive. If the highest priority reference is active and
fails, the system selects the next highest priority reference. However,
if the status of the highest priority reference becomes good, the
system switches back (reverts) to that reference. If all provisioned
timing references are assigned equal priority values, reference
selection is nonrevertive.

Using priorities to force or
prevent the selection of a

timing reference

You can force the selection of a particular system clock input
reference by assigning it a priority that is higher than the priority
assigned to the internal clock or to other provisioned references. You
can prevent the system from selecting a provisioned reference by
assigning it the priority “None.” You can also force the system to
select a different active reference by changing the priority of the
active reference or by assigning it the priority “None.”

Background information Synchronisation and timing
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About changing timing references
....................................................................................................................................................................................................................................

Information about
changing a timing

reference

To change the source of a provisioned timing reference (from station
clock to port or vice versa, or from one transmission port to another),
you first have to delete the reference that you want to change, and
then provision a different reference. If the reference that you want to
change is the active reference, you first have to force the system to
select a different active reference by changing the priority of the
active reference or by assigning it the priority “None.”

Related topics For more information, see one of the following topics:

• “Querying the system clock” (13-16)

• “Deleting a timing reference for the system clock” (13-25)

• “Assigning the station clock as a timing reference for the system
clock” (13-22)

• “Assigning a transmission port as the timing reference for the
system clock” (13-23)

• “Changing the priority of a timing reference for the system
clock” (13-24)

• “Changing the priority of the system’s internal clock” (13-26)

Background information Synchronisation and timing
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The synchronisation and timing provisioning process
....................................................................................................................................................................................................................................

Provisioning
synchronisation and timing

To provision synchronisation and timing, do the following:

............................................................................................................................................................

1 Use the System Clock window to query and provision as many as
four input timing references for the system clock, and to assign a
priority to the timing references. This window can also be used to
change the priority of the internal clock, if necessary, or to query the
status of the working and protection System Timing Units (STUs).

............................................................................................................................................................

2 Use the Station Clock window to query and provision the input timing
reference for the station clock.

Background information Synchronisation and timing
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System Clock window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the System Clock window to do the following:

• Query and provision input timing references for the system clock

• Assign a priority to as many as four timing references

• Change the priority of a timing reference

• Change the priority of the internal clock

Window location Provision > Synchronisation and Timing > System Clock

Organisation This section is organised as follows:

• “System Clock window description” (13-14)

• “Querying the system clock” (13-16)

• “System Clock query results” (13-17)

• “Assigning the station clock as a timing reference for the system
clock” (13-22)

• “Assigning a transmission port as the timing reference for the
system clock” (13-23)

• “Changing the priority of a timing reference for the system
clock” (13-24)

• “Deleting a timing reference for the system clock” (13-25)

• “Changing the priority of the system’s internal clock” (13-26)

Synchronisation and timing
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System Clock window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the System Clock window.

Field descriptions The System Clock window has the following fields.

Field name Description

Station Clock 1 Selecting the Station Clock 1 field specifies that
the input timing reference for the system clock is
derived from Station Clock In 1 (input 1).

Station Clock 2 Selecting the Station Clock 2 field specifies that
the input timing reference for the system clock is
derived from Station Clock In 2 (input 2).

Port Selecting the Port field specifies that the input
timing reference for the system clock is derived
from a transmission port.

Port ID The Port ID fields specify the physical location of
a port.

For a description of the Port ID options, see
“About physical layer addresses” (3-3).

System Clock window and procedures Synchronisation and timing
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Field name Description

Reference
Number

The Reference Number field specifies the number
of the system clock input reference. You must
specify a reference number to assign (apply) or
delete a system clock input reference.

The values are 1–4.

Assigned
Priority (System
Clock Input
Reference)

The Assigned Priority (System Clock Input
Reference) field specifies the priority of an input
timing reference for the system clock. 1 is the
highest priority, and 4 is the lowest priority. A
reference assigned the priority None will not be
selected as the active reference for the system
clock, but it will be monitored for failures.

The values are 1–4, None.

Assigned
Priority
(Internal Clock)

The Assigned Priority (Internal Clock) specifies
the priority of the system’s internal clock. 0 is the
highest priority, and 5 is the lowest priority.

The values are 0–5. The default value is 5.

Related topic For general information about windows, see “About the main
application window” (2-10).

System Clock window and procedures
System Clock window description
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Querying the system clock
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the System Clock window at Provision > Synchronisation and
Timing > System Clock.

............................................................................................................................................................

2 To query the active STU, click Query Active. To query the standby
STU, click Query Standby.

System Clock window and procedures Synchronisation and timing
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System Clock query results
....................................................................................................................................................................................................................................

Illustration for active STU
results

Use the following illustration only as an example of query results for
the active STU.

Important! The data displayed on this screen may not be typical.

Illustration for standby
STU results

Use the following illustration only as an example of query results for
the standby STU.

Important! The data displayed on this screen may not be typical.

Results field descriptions The following information appears in the System Clock Query Results
window.

Column Description

Reference
Number

Displays the provisioned Reference Number (1–4
for a Station Clock, or the field will be blank for
both the internal clock and the cross-couple link)

System Clock window and procedures Synchronisation and timing
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Column Description

Timing Source Displays one of the following values:

• Internal clock

• Cross couple

• Station Clock 1

• Station Clock 2

• The physical location of a port provisioned for
line-derived timing

Priority Displays the priority (0–5, or None) assigned to
the timing source.

Status Displays one of the following values:

• Active — The source is providing timing.

• Standby — The source is available for
providing timing.

• Failed — The source has a failure condition.

• OK — The source has no failures, but it will
not become active because the priority
assigned to the timing reference is less than
the priority assigned to the internal clock, or
the priority None is assigned to the timing
reference. A query on the standby STU will
display OK for all timing references that are
not failed.

• Unknown — The status of the reference is
unknown because the STU is not equipped,
meaning that it is not physically present or
booting.

Related topic For general information about windows, see “About the main
application window” (2-10).

System Clock window and procedures
System Clock query results

Synchronisation and timing
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Querying the status of the working and protection STUs
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the System Clock window at Provision > Synchronisation and
Timing > System Clock.

............................................................................................................................................................

2 Click Query Status.

System Clock window and procedures Synchronisation and timing
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STU Status query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results for
STU Status.

Important! The data displayed on this screen may not be typical.

Results field descriptions The following information appears in the STU Status Query Results
window.

Column Description

STU The STU column displays one of the following
values:

• Working

• Protect

Protection
Switch Status

The Protection Switch Status column displays the
protection switching status of the working or
protection STU as one of the following:

• Active — The STU is active.

• Standby — The STU is standby.

• Unequipped — Unequipped is displayed if the
STU is not available.

Timing Mode The Timing Mode column displays the current
timing mode of the working or protection STU as
one of the following:

• Phase Locked

• Holdover

• Freerunning

• Blank — No value is displayed if the STU is
not available

System Clock window and procedures Synchronisation and timing
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Column Description

Active
Reference

The Active Reference column displays the active
timing reference for the working or protection
STU.

For the active STU, if the system is in
phaselocked mode, this column displays the
reference number of the port or station clock input
that is providing the timing reference. If the
system is not in phaselocked mode, this column is
blank.

For the standby STU, if the standby STU is
cross-coupled to the active STU, this column
displays Cross Couple. If the standby STU is not
cross-coupled to the active STU, this column is
blank.

Related topic For general information about windows, see “About the main
application window” (2-10).

System Clock window and procedures
STU Status query results

Synchronisation and timing
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Assigning the station clock as a timing reference for the system
clock
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the System Clock window at Provision > Synchronisation and
Timing > System Clock.

............................................................................................................................................................

2 Select Station Clock 1 or Station Clock 2 as the System Clock Input
Reference.

............................................................................................................................................................

3 Select values for the following fields:

• Reference Number

• Assigned Priority

............................................................................................................................................................

4 Click Apply.

System Clock window and procedures Synchronisation and timing
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Assigning a transmission port as the timing reference for the
system clock
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the System Clock window at Provision > Synchronisation and
Timing > System Clock.

............................................................................................................................................................

2 Select Port as the System Clock Input Reference.

............................................................................................................................................................

3 Select values for the following fields:

• Port ID

• Reference Number

• Assigned Priority

............................................................................................................................................................

4 Click Apply.

System Clock window and procedures Synchronisation and timing
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Changing the priority of a timing reference for the system clock
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the System Clock window at Provision > Synchronisation and
Timing > System Clock.

............................................................................................................................................................

2 Select Station Clock 1, Station Clock 2, or Port as the System Clock
Input Reference.

............................................................................................................................................................

3 Select values for the following fields:

• Port ID, if you selected Port in the previous step

• Reference Number

• Assigned Priority

............................................................................................................................................................

4 Click Apply.

System Clock window and procedures Synchronisation and timing
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Deleting a timing reference for the system clock
....................................................................................................................................................................................................................................

Procedure Important! You can delete only timing references that are not active.
To delete the active timing reference, you must first lower its priority
or change its priority to None, so that another timing reference
becomes active.
............................................................................................................................................................

1 Go to the System Clock window at Provision > Synchronisation and
Timing > System Clock.

............................................................................................................................................................

2 Select the Reference Number.

............................................................................................................................................................

3 Click Delete.

System Clock window and procedures Synchronisation and timing
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Changing the priority of the system’s internal clock
....................................................................................................................................................................................................................................

Procedure Important! If you assign the internal clock a priority that is higher
than the priority of the active timing reference for the system clock,
you will force the system clock into holdover timing mode.

............................................................................................................................................................

1 Go to the System Clock window at Provision > Synchronisation and
Timing > System Clock.

............................................................................................................................................................

2 Select an Assigned Priority for the Internal Clock.

............................................................................................................................................................

3 Click Apply.

System Clock window and procedures Synchronisation and timing
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Station Clock window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the Station Clock window to query and provision the input timing
reference for the Station Clock output port. The input timing reference
can be derived from traffic-carrying lines (transmission ports or MSP
pairs) or from the system clock.

The station clock input timing reference is the timing source for the
Station Clock output port on each System Timing Unit. The station
clock output is a 2048 kHz clock that can be used as a timing source
for other equipment.

The timing source for the station clock can be different from the
timing source for the system clock.

Window location Provision > Synchronisation and Timing > Station Clock

Organisation This section is organised as follows:

• “Station Clock window description” (13-28)

• “Querying the station clock” (13-29)

• “Station Clock query results” (13-30)

• “Assigning the system clock as the timing reference for the
station clock” (13-32)

• “Assigning a transmission port as the timing reference for the
station clock” (13-33)

• “Changing the timing reference for the station clock” (13-34)

Synchronisation and timing
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Station Clock window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Station Clock window.

Field descriptions The Station Clock window has the following fields.

Field name Description

Port Selecting the Port field specifies that the input
timing reference for the station clock is derived
from a transmission port.

Port ID When Port is selected as the input timing
reference, the Port ID fields specify the physical
location of the port.

For a description of the Port ID options, see
“About physical layer addresses” (3-3).

System Clock Selecting the System Clock field specifies that the
input timing reference for the station clock is
derived from the system clock.

None Selecting the None field removes the
currently-assigned input timing reference for the
station clock.

Related topic For general information about windows, see “About the main
application window” (2-10).

Station Clock window and procedures Synchronisation and timing
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Querying the station clock
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Station Clock window at Provision > Synchronisation and
Timing > Station Clock.

............................................................................................................................................................

2 Click Query.

Station Clock window and procedures Synchronisation and timing
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Station Clock query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results for
the Station Clock window.

Important! The data displayed on this screen may not be typical.

Results field descriptions The following information appears in the Station Clock Query Results
window.

Column Description

Reference ID Displays one of the following values:

• The location of the port being used for
line-derived timing

• System Clock

• None

Working STU
Input

Displays one of the following values:

• Active — The source is providing timing.

• Failed — The source has a failure condition.

• Not Provisioned — The STU is not
provisioned.

• Unknown — The STU is not available.

Protect STU
Input

Displays one of the following values:

• Active — The source is providing timing.

• Failed — The source has a failure condition.

• Not Provisioned — The STU is not
provisioned.

• Unknown — The STU is not available.

Station Clock window and procedures Synchronisation and timing
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Column Description

Working STU
Output

Displays one of the following values:

• Active — The source is providing timing.

• Failed — The source has a failure condition.

• Not Provisioned — The STU is not
provisioned.

• Unknown — The STU is not available.

Protect STU
Output

Displays one of the following values:

• Active — The source is providing timing.

• Failed — The source has a failure condition.

• Not Provisioned — The STU is not
provisioned.

• Unknown — The STU is not available.

Related topic For general information about windows, see “About the main
application window” (2-10).

Station Clock window and procedures
Station Clock query results
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Assigning the system clock as the timing reference for the
station clock
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Station Clock window at Provision > Synchronisation and
Timing > Station Clock.

............................................................................................................................................................

2 Select System Clock as the Input Timing Reference.

............................................................................................................................................................

3 Click Apply.

Station Clock window and procedures Synchronisation and timing
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Assigning a transmission port as the timing reference for the
station clock
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Station Clock window at Provision > Synchronisation and
Timing > Station Clock.

............................................................................................................................................................

2 Select Port as the Input Timing Reference.

............................................................................................................................................................

3 Select the Port ID.

............................................................................................................................................................

4 Click Apply.

Station Clock window and procedures Synchronisation and timing
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Changing the timing reference for the station clock
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Station Clock window at Provision > Synchronisation and
Timing > Station Clock.

............................................................................................................................................................

2 Select None.

............................................................................................................................................................

3 Click Apply.

............................................................................................................................................................

4 Provision a different timing reference.

Station Clock window and procedures Synchronisation and timing
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14 Data Communication Channel

Overview
....................................................................................................................................................................................................................................

Purpose “Data Communication Channel ” contains the following information:

• General information about Data Communication Channel

• Descriptions of the windows that are used to provision a Data
Communication Channel

• Step-by-step procedures for the following:

- Procedures for setting up and changing Data Communication
Channels and networks

- Procedures for doing various queries associated with Data
Communication Channels and networks

Organisation The organisation is as follows:

• “Data Communication Channel window and procedures” (14-3)

• “DCC in MSP Mode Provision window and procedures” (14-9)

• “DCN Neighbor Nodes window and procedures” (14-15)

• “QLAN Link window and procedures” (14-20)

• “Data Communication Network window and procedures” (14-24)

Data Communication
Channel background

information

The DCC is the Data Communication Channel. It consists of several
channels, each of which may or may not be present (depending on the
type of network element).

All DCC channels together form a network, which is called the Data
Communication Network (DCN). The goal of the DCN is to provide a
management network. The Network Element Managers (for example,
ITM-SC, and SNMS) use the DCN to communicate with their
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respective managed network elements. The DCN is also used by the
network elements themselves to exchange management-related
information.

Be aware that, technically speaking, only the D1 thru D3 and D4 thru
D12 channels are DCC channels. Q-LAN and OSC are not formally
DCC channels. However, they are integral parts of the DCN.

The following is a brief summary of important information concerning
DCC and DCC:

DCC: Data Communication Channel

• D1 thru D3 (192 kbit/s)

• D4 thru D12 (576 kbit/s)

• Q-LAN (Ethernet)

• OSC (Supervisory Channel).

DCN: Data Communication Network

• The network of all DCC channels

• Goal of the DCN: to provide network management.

Overview Data Communication Channel
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Data Communication Channel window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the Data Communication Channel window to do the following:

• Query DCC status

• Assign the DCC channel mode

• Enable or disable a DCC channel.

Window location Provision > Data Communication Channel > Data Communication
Channel

Organisation This section is organised as follows:

• “Data Communication Channel window description” (14-4)

• “Enabling or disabling a Data Communication Channel” (14-6)

• “Querying a Data Communication Channel” (14-7)

Data Communication Channel
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Data Communication Channel window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Data Communication Channel
window.

Field descriptions The Data Communication Channel window has the following fields.

Field name Description

Port ID The Port ID fields specify the physical location of
a port.

For a description of the Port ID options, see
“About physical layer addresses” (3-3).

DCC Channel The DCC Channel field specifies the overhead
section that carries the DCC channel as either RS
(Regenerator Section) or MS (Multiplex Section).

Data Communication Channel window and
procedures

Data Communication Channel

....................................................................................................................................................................................................................................

1 4 - 4 Lucent Technologies 365–367–512
Issue 2, July 2002



Field name Description

DCC Status The DCC Status field specifies whether the status
is Enabled or Disabled.

Related topic For general information about windows, see “About the main
application window” (2-10).

Data Communication Channel window and
procedures
Data Communication Channel window
description

Data Communication Channel
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Enabling or disabling a Data Communication Channel
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Data Communication Channel window at Provision > Data
Communication Channel > Data Communication Channel.

............................................................................................................................................................

2 Specify the Subrack and Number, Port and Number, and the Port ID.

............................................................................................................................................................

3 Also, if necessary, change the DCC Channel and DCC Status as
desired.

............................................................................................................................................................

4 Click Apply.

Result:
If the NE is installed and configured correctly, the

command will
be performed. Otherwise, an error message will be

returned.

Data Communication Channel window and
procedures

Data Communication Channel
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Querying a Data Communication Channel
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Data Communication Channel window at Provision > Data
Communication Channel > Data Communication Channel.

............................................................................................................................................................

2 Specify the Subrack and Number, Port and Number, and the Port ID.

............................................................................................................................................................

3 Also, if necessary, change the DCC Channel and DCC Status as
desired.

............................................................................................................................................................

4 Click Query.

Result:
A query results window will appear.

Data Communication Channel window and
procedures

Data Communication Channel
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Data Communication Channel query results
....................................................................................................................................................................................................................................

Results field descriptions The following information appears in the Data Communication
Channel Query Results window.

Column Description

Port ID Displays the Port ID associated with the Data
Communication Channel

Channel Displays the DCC Channel as either RS or MS for
the Data Communication Channel

DCC Status Displays the DCC Status as either Enable or
Disable for the Data Communication Channel

Data Communication Channel window and
procedures

Data Communication Channel
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DCC in MSP Mode Provision window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose This feature only applies to PSC subracks (for STM–4 and STM–16).

To support DCC communication over 1+1 MSP protected STM-N
links, two modes of operation are defined, which can be selected
independently for RS-DCC and MS-DCC:

• Independent mode (default). In this mode, the DCC channels
over the working and protection STM-N interface operate
independently from the MSP protocol and can be individually
enabled/disabled. DCC protection is performed at the IS-IS
protocol level.

• Slaved to MSP. In this mode, the DCC information in the
transmit direction is bridged over both the working and the
protection part of the MSP connection. At the receive end, the
DCC is retrieved from the service (= active) part.

Window location Provision > Data Communication Channel > DCC in MSP Mode
Provision

Organisation This section is organised as follows:

• “DCC in MSP Mode Provision window description” (14-10)

• “Provisioning a Data Communication Channel in MSP Mode”
(14-12)

• “Querying a Data Communication Channel in MSP Mode”
(14-13)

Data Communication Channel
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DCC in MSP Mode Provision window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the DCC in MSP Mode Provision
window.

Field descriptions The DCC in MSP Mode Provision window has the following fields.

Field name Description

MSP Group ID The MSP Group ID fields specify the physical
location of a port.

For a description of the MSP Group ID options,
see “About physical layer addresses” (3-3).

DCC in MSP Mode Provision window and
procedures

Data Communication Channel
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Field name Description

DCC Channel The DCC Channel field specifies the overhead
section that carries the DCC channel.
The following values are available:

• RS (Regenerator Section)

• MS (Multiplex Section)

DCC Mode The DCC Mode field specifies the mode in which
the DCC channel operates over 1 + 1 MSP
protected interfaces.
The following values are available:

• Independent mode (default) — The DCC
channels over the working and protection
STM-N interface operate independently from
the MSP protocol and can be individually
enabled or disabled.

• Slaved to MSP — In the transmit direction,
DCC information is bridged over both working
and protection trails of the MSP connection.
At the receive end, the DCC information is
retrieved from the active trail.

Related topic For general information about windows, see “About the main
application window” (2-10).

DCC in MSP Mode Provision window and
procedures
DCC in MSP Mode Provision window
description

Data Communication Channel
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Provisioning a Data Communication Channel in MSP Mode
....................................................................................................................................................................................................................................

Important! This procedure is only used for PSC subracks. Be sure to
check this before proceeding.

Procedure ............................................................................................................................................................

1 Go to the DCC in MSP Mode Provision window at Provision > Data
Communication Channel > DCC in MSP Mode Provision.

............................................................................................................................................................

2 Specify the MSP Group ID by selecting a Subrack and Number, Unit
and Number, and the Port ID.

............................................................................................................................................................

3 Also, if necessary, change the DCC Channel and DCC Mode as
desired.

............................................................................................................................................................

4 Click Apply.

Result:
If the NE is installed and configured correctly,
the command will

be performed. Otherwise, an error message will be
returned.

DCC in MSP Mode Provision window and
procedures

Data Communication Channel
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Querying a Data Communication Channel in MSP Mode
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the DCC in MSP Mode Provision window at Provision > Data
Communication Channel > DCC in MSP Mode Provision.

............................................................................................................................................................

2 Specify the MSP Group ID by selecting a Subrack and Number, Unit
and Number, and the Port ID.

............................................................................................................................................................

3 Also, if necessary, change the DCC Channel and DCC Mode as
desired.

............................................................................................................................................................

4 Click Query.

Result:
A query results window will appear.

DCC in MSP Mode Provision window and
procedures

Data Communication Channel
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Data Communication Channel in MSP Mode query results
....................................................................................................................................................................................................................................

Results field descriptions The following information appears in the Data Communication
Channel in MSP Mode Query Results window.

Column Description

MSP Group ID Displays the MSP Group ID for the Data
Communication Channel

DCC Channel Displays the DCC Channel as either RS or MS for
the Data Communication Channel

DCC Mode Displays the DCC mode as either Independent or
Slave for the Data Communication Channel

Related topic For general information about windows, see “About the main
application window” (2-10).

DCC in MSP Mode Provision window and
procedures

Data Communication Channel
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DCN Neighbor Nodes window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the DCN Neighbor Nodes window to query the NSAP addresses
of neighbor nodes attached to peer DCC channels of the specified
ports or subracks.

Window location Provision > Data Communication Channel > DCN Neighbor Nodes

Organisation This section is organised as follows:

• “DCN Neighbor Nodes” (14-16)

• “Querying DCN neighbor nodes” (14-18)

Data Communication Channel
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DCN Neighbor Nodes
....................................................................................................................................................................................................................................

Illustration The following illustration shows the DCC in DCN Neighbor Nodes
window.

Field descriptions The DCN Neighbor Nodes window has the following fields.

Field name Description

Port ID The Port ID fields specify the physical location of
a port.

For a description of the Port ID options, see
“About physical layer addresses” (3-3).

DCN Neighbor Nodes window and
procedures

Data Communication Channel
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Field name Description

DCC Channel The DCC Channel field specifies the overhead
section that carries the DCC channel.
The following values are available:

• RS (Regenerator Section)

• MS (Multiplex Section)

Related topic For general information about windows, see “About the main
application window” (2-10).

DCN Neighbor Nodes window and
procedures
DCN Neighbor Nodes

Data Communication Channel
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Querying DCN neighbor nodes
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the DCN Neighbor Nodes window at Provision > Data
Communication Channel > DCN Neighbor Nodes.

............................................................................................................................................................

2 Specify the Port ID by selecting a Subrack and Number, Unit and
Number, and the Port number.

............................................................................................................................................................

3 Also, if necessary, change the DCC Channel as desired.

............................................................................................................................................................

4 Click Query Neighbor.

Result:
A query results window will appear.

DCN Neighbor Nodes window and
procedures

Data Communication Channel
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DCN Neighbor Nodes query results
....................................................................................................................................................................................................................................

Results field descriptions The following information appears in the DCN Neighbor Nodes
Query Results window.

Column Description

Port ID The Port ID fields specify the physical location of
a port.

For a description of the Port ID options, see
“About physical layer addresses” (3-3).

DCC Channel The DCC Channel field specifies the overhead
section that carries the DCC channel.
The following values are available:

• RS (Regenerator Section)

• MS (Multiplex Section)

Neighbor Node
NSAP

The Neighbor Node NSAP field specifies the
NSAP address of the peer NE of the DCC channel
in the queried port.

Related topic For general information about windows, see “About the main
application window” (2-10).

DCN Neighbor Nodes window and
procedures
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QLAN Link window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the QLAN Link window to do the following:

• Query QLAN links

Window location Provision > Data Communication Channel > QLAN Link

Organisation This section is organised as follows:

• “QLAN Link window description” (14-21)

• “Querying a QLAN link” (14-22)

Data Communication Channel
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QLAN Link window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the QLAN Link window.

Field descriptions The QLAN Link window has the following fields.

Field name Description

Subrack ID The Subrack ID fields specify the physical
location of a port.

For a description of the Subrack ID options, see
“About physical layer addresses” (3-3).

Related topic For general information about windows, see “About the main
application window” (2-10).

QLAN Link window and procedures Data Communication Channel
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Querying a QLAN link
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Data Communication Channel window at Provision > Data
Communication Channel > QLAN Link.

............................................................................................................................................................

2 Specify the Subrack ID by selecting a Subrack and Number.

............................................................................................................................................................

3 Click Query QLAN Link.

Result:
A query results window will appear.

QLAN Link window and procedures Data Communication Channel
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QLAN Link query results
....................................................................................................................................................................................................................................

Results field descriptions The following information appears in the QLAN Link Query Results
window.

Column Description

Subrack ID Displays the subrack ID

QLAN Port
Status

Displays the QLAN Link Status as either Active
or Inactive

Related topic For general information about windows, see “About the main
application window” (2-10).

QLAN Link window and procedures Data Communication Channel
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Data Communication Network window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Use the Data Communication Network window to do the following:

• Assign a primary area ID or address to a related dSRC for the
specified subrack

• Optionally assign a manual area adress to a related dSRC for the
specified subrack

• Query a computed area address

• Assign an IS-IS level for an NE and the QLAN

• Assign a designated router priority for the QLAN

• Query DCN information for the specified subrack.

Window location Provision > Data Communication Channel > Data Communication
Network

Organisation This section is organised as follows:

• “Data Communication Network window description” (14-25)

• “Provisioning Data Communication Network parameters” (14-27)

• “Querying a Computed Area Address” (14-30)

• “Querying the DCN” (14-28)

Data Communication Channel
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Data Communication Network window description
....................................................................................................................................................................................................................................

Field descriptions The Data Communication Network window has the following fields.

Field name Description

Subrack ID The Subrack ID fields specify the physical
location of a port.

For a description of the Subrack ID options, see
“About physical layer addresses” (3-3).

NSAP Format The NSAP Format field specifies the format of the
network address.
The following values are available:

• Fixed 20 byte

• Fixed 10 byte

• Flexible

Area ID The Area ID field specifies a part of the Area
Address, identifying an address group as specified
by a local addressing authority. The Area Address
is a variable-length quantity consisting of the
entire high-order part of the NSAP, the Network
Protocol Addressing Information, excluding the
SID, the 6–byte System IDentifier, and the SEL,
the Selector.

Additional
Manual Area
Addresses

The Additional Manual Area Addresses specify a
list of synonomous Area addresses associated with
an IS. All of the IS’s manual area addresses, when
combined with the IS’s SID and SEL, are valid
Network Entity Titles for the IS. For a level–1
adjacency between two IS nodes there must be at
least one Area address in common between their
two manual Area address lists. The Area address
of an ES must match an entry in the IS’s manual
Area address list in order to establish an
adjacency.

NE IS–IS Level The NE IS–IS Level field specifies the network
element IS to IS routing.
The following values are available:

• Level 1

• Level 1 + Level 2

• Level 1 + Level 2 + Area Repair Access

Data Communication Network window and
procedures

Data Communication Channel
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Field name Description

LAN IS–IS
Level

The LAN IS–IS Level field specifies the LAN IS
to IS routing.
The following values are available:

• Follow NE IS-IS Level

• Level 2

• None

Designated
Router Priority

The Designated Router Priority is a function of
the IS–IS protocol. It represents a Pseudo or
Virtual node on a LAN subnet which assumes
much of the routing tasks for the LAN circuit.
One of the physical nodes must do the actual
work. This node is the DR. Election of the DR
depends first on the circuit priority and second on
the SID, or MAC address.

Related topic For general information about windows, see “About the main
application window” (2-10).

Data Communication Network window and
procedures
Data Communication Network window
description
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Provisioning Data Communication Network parameters
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Data Communication Network window at Provision > Data
Communication Channel > Data Communication Network.

............................................................................................................................................................

2 Specify the Subrack ID by selecting a Subrack and Number.

............................................................................................................................................................

3 Select a new area ID. Do not use the default value 0000. The 2nd and
3rd additional manual area addresses are optional.

............................................................................................................................................................

4 You can also change the selection for the IS–IS level and the
designated router priority, if desired, based on your particular DCN
design.

............................................................................................................................................................

5 Click Apply.

Result:
If the NE is installed and configured correctly, the

command will
be performed. Otherwise, an error message will be

returned.

Data Communication Network window and
procedures
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Querying the DCN
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Data Communication Channel window at Provision > Data
Communication Channel > Data Communication Network.

............................................................................................................................................................

2 Specify the Subrack ID by selecting a Subrack and Number.

............................................................................................................................................................

3 Click Query DCN.

Data Communication Network window and
procedures
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DCN query results
....................................................................................................................................................................................................................................

Results field descriptions The following information appears in the DCN Query Results
window.

Column Description

Subrack ID Displays the subrack ID

Status Displays the status as either Configured or Not
Configured

Full NSAP Displays the NSAP address of the queried dSRC

NSAP Format Displays the format as Fixed 20 bytes, Fixed 10
bytes, or Flexible

Area Displays the Area address or the Area ID

SID Displays a unique MAC address for the dSRC.
This is programmed at the factory.

NE IS-IS Level Displays Level 1, Level 2, or Level1+Level2+
AreaRepairAccess

LAN IS-IS
Level

Displays Follow NE Level, Level 2, or None

Router Priority Displays a valid value in the range of 0–127

2nd Area Displays the flexible area address format for the
second manual area address

3rd Area Displays the flexible area address format for the
third manual area address

Related topic For general information about windows, see “About the main
application window” (2-10).

Data Communication Network window and
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Querying a Computed Area Address
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Data Communication Channel window at Provision > Data
Communication Channel > Data Communication Network.

............................................................................................................................................................

2 Specify the Subrack ID by selecting a Subrack and Number.

............................................................................................................................................................

3 Click Query Computed Area Address.

Data Communication Network window and
procedures
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Computed Area Address query results
....................................................................................................................................................................................................................................

Results field descriptions The following information appears in the Computed Area Address
Query Results window.

Column Description

Subrack ID Displays the subrack ID

Computed Area
Address

Displays the computed area address

Related topic For general information about windows, see “About the main
application window” (2-10).

Data Communication Network window and
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15 System ID

Overview
....................................................................................................................................................................................................................................

Purpose “System ID” describes how to provision the System ID and other
system parameters.

The System ID is used by network and element management systems
to identify a particular Network Element.

Window location Provision > System ID

Organisation The organisation is as follows:

• “System ID window description” (15-2)

• “Querying system parameters” (15-3)

• “Changing the System ID or the Frame ID” (15-4)
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365–367–512
Issue 2, July 2002

Lucent Technologies 1 5 - 1



System ID window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the System ID window.

Field descriptions The System ID window has the following fields.

Field name Description

System ID The System ID field is optional and specifies the
system identification. The System ID identifies a
particular DACS system when communicating
with a Network Management System.

This field accepts up to 18 alphanumeric
characters. The characters , ; : # { } space are not
allowed. Furthermore, the System ID cannot be
set to -1.

Frame ID The Frame ID field is optional and specifies the
frame identification. This field can be used for
additional system identification. The value
specified for the Frame ID field is not used by the
DACS system or by a Network Management
System.

The values are 0–65535. The default value is 0.

Related topic For general information about windows, see “About the main
application window” (2-10).

System ID
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Querying system parameters
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the System ID window at Provision > System ID.

............................................................................................................................................................

2 Click Query.

System ID query results The following information is displayed in a query results window:

• System ID

• Frame ID

• Date and time of the last database backup

• The maximum system capacity

System ID
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Changing the System ID or the Frame ID
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the System ID window at Provision > System ID.

............................................................................................................................................................

2 Specify a System ID, a Frame ID, or both.

............................................................................................................................................................

3 Click Change.

System ID
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16 Password administration

Overview
....................................................................................................................................................................................................................................

Purpose “Password administration” describes the Change Password window.
Use the Change Password window to change your password for
logging into the system.

Window location Utilities > Change Password

Organisation “Password administration” is organised as follows:

• “Change Password window description” (16-2)

• “Changing your password” (16-3)
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Change Password window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Change Password window.

Field descriptions The Change Password window has the following fields.

Field name Description

Login ID The Login ID field displays the Login ID that was
used to log into the system.

Old Password The Old Password field specifies the current
password associated with the Login ID.

New Password The New Password field specifies a new user
password. The password must be from four to
eight characters in length. There are no
restrictions on what characters can be used in the
password.

Confirm New
Password

You must confirm the password specified in the
New Password field by reentering it in the
Confirm New Password field.

Related topic For general information about windows, see “About the main
application window” (2-10).

Password administration
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Changing your password
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Change Password window at Utilities > Change Password.

............................................................................................................................................................

2 In the Old Password field, enter the current password for the
displayed Login ID.

............................................................................................................................................................

3 In the New Password field, enter a new password.

............................................................................................................................................................

4 In the Confirm New Password field, reenter the new password.

............................................................................................................................................................

5 Click Apply.

Password administration
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17 Login administration

Overview
....................................................................................................................................................................................................................................

Purpose “Login administration” contains information about the Login
Administration window and the step-by-step procedures administrators
use for adding, changing, or deleting a user login. Login
administration also contains information about changing a user’s
password and access class.

Organisation “Login administration”is organised as follows:

• “Background information” (17-2)

• “Login Administration window and procedures” (17-5)
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Background information

Overview
....................................................................................................................................................................................................................................

Purpose This section contains background information about login
administration.

Organisation “Login administration” contains the following information:

• “Access class definitions” (17-3)

• “Access classes and permissions” (17-4)

Login administration
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Access class definitions
....................................................................................................................................................................................................................................

What is an access class? A user’s access class determines the types of operations,
administration, maintenance, and provisioning tasks that a user can
perform. Access classes are set by the system administrator.

Access classes Administrator An administrator can perform the following tasks:

• Suppress alarms

• Control all network element functions

• Query and modify all system data including login and password
information

Supervisor A supervisor can perform the following tasks:

• Suppress alarms

• Control all network element functions

• Query and modify all system data except login and password
information

Operator An operator can only suppress alarms and query all
system data except login and password information.

Background information Login administration
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Access classes and permissions
....................................................................................................................................................................................................................................

Table of access classes An access class determines the types of tasks the system will allow a
user to perform. The following diagram describes each access class
and the permissions.

Tasks Admin 1 Sup 2 Operator

Change system date/time Yes Yes No

Change PC date/time Yes Yes Yes

Administer users and
access classes

Yes No No

Database backup Yes Yes Yes

Change own user
password

Yes Yes Yes

Remove, restore, initialise
controller

Yes No No

Perform safepointing Yes Yes No

Provision equipment Yes Yes No

Change port Yes Yes No

Change path overhead Yes Yes No

Provision performance
monitoring

Yes Yes No

Provision cross connects Yes Yes No

Execute tests Yes Yes No

Provision protection
switching

Yes Yes No

Request protection
switching

Yes Yes No

Provision fault
management

Yes Yes No

Request station alarm
suppress & disconnect

Yes Yes No

Provision timing Yes Yes No

Switch system clock Yes Yes No

Perform queries Yes Yes Yes

Notes:

1. Administrator

2. Supervisor

Background information Login administration
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Login Administration window and procedures

Overview
....................................................................................................................................................................................................................................

Purpose Administrators can use the Login Administration window to query,
add, change, or delete a user login ID. Administrators can also change
a user’s password, name, or access class.

Window location Utilities > Login Administration

Organisation This section is organised as follows:

• “Login Administration window description” (17-6)

• “Querying a user login ID” (17-8)

• “Login Administration query results” (17-9)

• “Adding a user login ID” (17-10)

• “Changing a user login ID” (17-11)

• “Deleting a user login ID” (17-12)

• “Changing a user’s password” (17-13)

• “Changing a user’s access class” (17-14)

General information related
topics

For general information, click on one of the following topics:

• “Login Administration window description” (17-6)

• “Login Administration query results” (17-9)

Login administration
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Login Administration window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Login Administration window.

Field descriptions The Login Administration window has the following fields.

Field name Description

Login ID The Login ID field specifies a user login ID. The
login identification can contain from two to eight
letters or numbers. The first character must be a
letter, and at least one character must be a
lower-case letter. A default login ID is provided
for the system administrator. Only the system
administrator can add, change, or delete a login
ID.

The system allows a maximum of 30 user login
IDs.

Access Class A user’s access class determines the types of
operations, administration, maintenance, and
provisioning tasks that a user can perform. Access
classes are set by the system administrator. If a
user is logged in and the administrator changes
the user’s access class, the change does not
become effective until the user logs off.

Login Administration window and
procedures

Login administration
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Field name Description

User Name The User Name field specifies a user’s name. A
user name can be up to 50 characters. The
characters “#” and “:” must not be used in a user
name. If an Administrator changes a user name,
the change becomes effective immediately.

New Password The New Password field specifies a new password
for the specified login ID. The password must be
from four to eight characters. If an Administrator
changes a user password, the change becomes
effective immediately.

Confirm New
Password

You must confirm the password specified in the
New Password field by reentering it in the
Confirm New Password field.

Related topics For more information, see one of the following topics:

• “About the main application window” (2-10)

• “Access class definitions” (17-3)

• “Access classes and permissions” (17-4)

Login Administration window and
procedures
Login Administration window description

Login administration
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Querying a user login ID
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Login Administration window at Utilities > Login
Administration.

............................................................................................................................................................

2 Specify a Login ID.

Important! You can query all login IDs by leaving the Login ID field
blank.

............................................................................................................................................................

3 Click Query.

Login Administration window and
procedures
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Login Administration query results
....................................................................................................................................................................................................................................

Illustration Use the following illustration only as an example of query results for
the Login Administration window.

Important! The data displayed on this screen may not be typical.

Results field descriptions The following information appears in the Login Administration Query
Results window.

Column Description

Login ID Displays the requested login ID.

User Name Displays the user name associated with the
requested login ID.

Access Class Displays one of the following values:

• Administrator

• Supervisor

• Operator

Related topics For more information, see one of the following topics:

• “About the main application window” (2-10)

• “Access class definitions” (17-3)

• “Access classes and permissions” (17-4)

Login Administration window and
procedures
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Adding a user login ID
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Login Administration window at Utilities > Login
Administration.

............................................................................................................................................................

2 Specify a Login ID.

............................................................................................................................................................

3 Select an Access Class.

............................................................................................................................................................

4 Specify a User Name and a New Password.

............................................................................................................................................................

5 In the Confirm New Password field, reenter the new password.

............................................................................................................................................................

6 Click Create.

Login Administration window and
procedures
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Changing a user login ID
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Login Administration window at Utilities > Login
Administration.

............................................................................................................................................................

2 Specify a Login ID.

............................................................................................................................................................

3 Select an Access Class.

............................................................................................................................................................

4 Change the User Name, New Password, or both.

............................................................................................................................................................

5 If you changed the password, reenter the new password in the
Confirm New Password field.

............................................................................................................................................................

6 Click Change.

Login Administration window and
procedures
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Deleting a user login ID
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Login Administration window at Utilities > Login
Administration.

............................................................................................................................................................

2 Specify a Login ID.

............................................................................................................................................................

3 Click Delete.

Login Administration window and
procedures
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Changing a user’s password
....................................................................................................................................................................................................................................

Procedure Perform the following procedure when a user forgets his or her
password.
............................................................................................................................................................

1 Go to the Login Administration window at Utilities > Login
Administration.

............................................................................................................................................................

2 Specify the user’s Login ID.

............................................................................................................................................................

3 Enter a new password in the New Password field.

............................................................................................................................................................

4 Reenter the new password in the Confirm New Password field.

............................................................................................................................................................

5 Click Change.

Login Administration window and
procedures
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Changing a user’s access class
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Login Administration window at Utilities > Login
Administration.

............................................................................................................................................................

2 Specify the user’s Login ID.

............................................................................................................................................................

3 Enter a new access class in the Access Class field.

Reference: For more information, see one of the following
topics:

• “Access class definitions” (17-3)

• “Access classes and permissions” (17-4)

............................................................................................................................................................

4 Click Change.

When changes become effective

Changes will not become effective until your user logs off and logs
back on again.

Login Administration window and
procedures
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18 Date and time administration

Overview
....................................................................................................................................................................................................................................

Purpose “Date and time administration” describes the Date and Time
Administration window. Use the Date and Time Administration
window to query or change the date and time on a Personal Computer
(PC) that is used for provisioning and maintenance tasks or on the
system (Network Element). You can set the date and time on a PC to
the system date and time, or you can set the system date and time to
the PC date and time.

Window location Utilities > Date and Time Administration

Organisation “Date and time administration” is organised as follows:

• “Date and Time Administration window description” (18-2)

• “Querying the date and time” (18-3)

• “Changing the date and time” (18-4)

• “Setting the PC date and time to the system date and time”
(18-5)

• “Setting the system date and time to the PC date and time”
(18-6)
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Date and Time Administration window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Date and Time Administration
window.

Field descriptions The Date and Time Administration window has the following fields.

Field name Description

Date The Date field displays or sets the current date on
a PC or the system.

The date format is: YYYY/MM/DD, where YYYY
is the year, MM is the month, and DD is the day.

Time The Time field displays or sets the current time
on a PC or the system.

The time format is: HH/MM/SS, where HH is the
hour, MM is the minute, and SS is the second.

Related topic For general information about windows, see “About the main
application window” (2-10).

Date and time administration
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Querying the date and time
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Date and Time Administration window at Utilities > Date
and Time Administration.

............................................................................................................................................................

2 Do one of the following:

• To query the PC date and time, click Query PC Date/Time.

• To query the system (NE) date and time, click Query NE
Date/Time.

Example

The following is an example of a date and time query result.

Date and time administration
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Changing the date and time
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

Important! You cannot change the system date and time from the
Date and Time Administration window if an ITM-SC is connected to
the system.

1 Go to the Date and Time Administration window at Utilities > Date
and Time Administration.

............................................................................................................................................................

2 Query the PC date and time or the system (NE) date and time.

............................................................................................................................................................

3 Change the appropriate Date and Time fields.

............................................................................................................................................................

4 Click Set PC Date/Time or Set NE Date/Time.

Date and time administration
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Setting the PC date and time to the system date and time
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Date and Time Administration window at Utilities > Date
and Time Administration.

............................................................................................................................................................

2 Query the system (NE) date and time.

............................................................................................................................................................

3 Click Set PC Date/Time.

Date and time administration
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Setting the system date and time to the PC date and time
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Date and Time Administration window at Utilities > Date
and Time Administration.

............................................................................................................................................................

2 Query the PC date and time.

............................................................................................................................................................

3 Click Set NE Date/Time.

Date and time administration
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19 Autonomous message indicator
administration

Overview
....................................................................................................................................................................................................................................

Purpose “Autonomous message indicator administration” describes the
Autonomous Message Indicator window. Use the Autonomous
Message Indicator window to enable or disable the audible
autonomous message indicator. When the audible autonomous
message indicator is enabled, the PC bell sounds whenever the system
generates an autonomous message.

Window location Utilities > Autonomous Message Indicator

Organisation “Autonomous message indicator administration” is organised as
follows:

• “What are autonomous messages and events?” (19-2)

• “Autonomous Message Indicator window description” (19-3)

• “Enabling or disabling the audible autonomous message
indicator” (19-4)

....................................................................................................................................................................................................................................
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What are autonomous messages and events?
....................................................................................................................................................................................................................................

Description The system generates an autonomous message for every autonomous
event. Autonomous events are actions that the system initiates
automatically.

Examples of autonomous
events

Alarms, protection-switching events, and system clock reference
changes are examples of autonomous events.

Autonomous message indicator administration
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Autonomous Message Indicator window description
....................................................................................................................................................................................................................................

Illustration The following illustration shows the Autonomous Message Indicator
window.

Field descriptions The Autonomous Message Indicator window has the following field.

Field name Description

Activate
Audible
Autonomous
Message
Indicator

The Activate Audible Autonomous Message
Indicator field enables or disables the Audible
Autonomous Message Indicator feature. When the
Activate Audible Autonomous Message Indicator
field is checked, the feature is enabled. When the
feature is enabled, the PC bell sounds whenever
the system generates an autonomous message.

Related topic For general information about windows, see “About the main
application window” (2-10).

Autonomous message indicator administration
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Enabling or disabling the audible autonomous message indicator
....................................................................................................................................................................................................................................

Procedure ............................................................................................................................................................

1 Go to the Autonomous Message Indicator window at Utilities >
Autonomous Message Indicator.

............................................................................................................................................................

2 Click the box next to Activate Audible Autonomous Message
Indicator. A check mark in the box means that the feature is enabled.

............................................................................................................................................................

3 Click Apply.

Autonomous message indicator administration
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Glossary

A Abnormal alarm
An Abnormal alarm indicates that self tests, manual tests, or maintenance operations are in
progress. The alarm is displayed via a yellow LED located on the User Panel. For example: a
user manually switching the timing to holdover mode will cause an abnormal alarm. This
feature is not yet available.

ACP
See Alarm Connector Panel.

Active
When an entity is duplicated, one of the duplicated entities (the active entity) is currently
providing service, while the other is in standby. Either the working or protection entity could be
active at any time.

Active and standby
These terms refer to the operational state of entities that are part of a protection group. An
active entity is one that is currently providing service; a standby entity substitutes for an active
entity if necessary.

A direction
The A direction is the direction in which the signal travels through the system from the E-END
to the F-END, or the direction in a unidirectional cross connect.

Administrative Unit
An Administrative Unit (AU) is the information structure that provides adaptation between the
higher order path layer and the Multiplex Section layer. The AU consists of a higher order
Virtual Container information payload and an AU pointer. The AU pointer indicates the offset of
the payload frame start relative to the Multiplex Section frame start. An AU-4 consists of a
VC-4 plus an AU pointer. An AU-3 consists of a VC-3 plus an AU pointer.

Administrative Unit 3
An Administrative Unit 3 (AU-3) consists of a Virtual Container 3 (VC-3) plus an AU pointer.

Administrative Unit 4
An Administrative Unit 4 (AU-4) consists of a Virtual Container 4 (VC-4) plus an AU pointer.

....................................................................................................................................................................................................................................
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Administrative Unit 4-4c
An Administrative Unit 4-4c (AU-4-4c) consists of four concatenated AU-4s. Concatenated
means linked together in a series.

Administrative Unit Group
An Administrative Unit Group (AUG) consists of one or more byte-interleaved AUs. For an
STM-1, an AUG can be either a single AU-4 or three byte-interleaved AU-3s.

AIS
See Alarm Indication Signal.

Alarm
An alarm is a visible or audible signal that indicates that an equipment failure or a significant
event has occurred.

Alarm Connector Panel
The Alarm Connector Panel (ACP) is located on the back of the User Panel, below the Main
Controller (MC) subrack. The ACP has connectors for alarm-related cables.

Alarm delay
Alarm delay is the amount of time the system waits after a failure occurs before activating an
alarm.

Alarm Indication Signal
An Alarm Indication Signal (AIS) is a signal sent downstream indicating that an upstream
failure has occurred. AIS is transmitted by the network element that detected the failure to
prevent downstream failures being declared and alarms being raised.

Alarm indicator
An alarm indicator is a visual or audible indication that an alarm is active. One example of an
alarm indicator is the red LED on a unit. The red LED lights if a unit fails.

Alarm Relay Unit
The Alarm Relay Unit (ARU) is located on the Main Controller (MC) subrack and provides
system relay control and non 48V power distribution to the MC subrack.

Alarm severity
Alarm severity is an attribute that defines the priority of the alarm message. The way the
system processes alarms depends on the alarm severity.

Alarm suppression
When you suppress an alarm, you selectively prevent the system from forwarding alarm
messages to the user interface.

ALS
See Automatic Laser Shutdown.
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American National Standards Institute
The American National Standards Institute (ANSI) is a standards-setting, non government
organisation that develops and publishes standards for transmission codes, protocols, and
high-level languages for voluntary use in the United States.

American National Standards Institute, Multiplex Section Protection
American National Standards Institute, Multiplex Section Protection (ANSI MSP) provides
switching similar to unidirectional ITU MSP for STM-16, STM-4, and STM-1 optical interfaces,
and for STM-1 electrical interfaces. ANSI MSP complies with American National Standards
Institute (ANSI) T1–105.01. See International Telecommunications Union — Transmission,
Multiplex Section Protection.

ANSI
See American National Standards Institute.

ANSI MSP
See American National Standards Institute, Multiplex Section Protection.

Apparatus code
Apparatus codes are unit codes used by the factory. For example, IM09 and LAH203 are
apparatus codes.

ARU
See Alarm Relay Unit.

AU
See Administrative Unit.

AU-3
See Administrative Unit 3.

AU-4
See Administrative Unit 4.

AU-4-4c
See Administrative Unit 4_4c.

AUG
See Administrative Unit Group.

Automatic Laser Shutdown
Automatic Laser Shutdown (ALS) is a feature that causes the system to automatically shutdown
the output power of laser transmitters and optical amplifiers. ALS can prevent a technician’s
eyes from being exposed to hazardous laser levels.

Auto-provisioning
Auto-provisioning is the system’s ability to automatically provision equipment.

....................................................................................................................................................................................................................................
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Autonomous
An autonomous command is initiated by the system without direction by a user.

Autonomous messages
Autonomous messages are messages generated automatically by the system.

....................................................................................................................................................................................................................................

B Background Block Errors
Background Block Errors (BBEs) are the number of errored blocks that were detected. A block
is a set of consecutive bits associated with the path; each bit belongs to only one block. An
Errored Block is a block in which one or more bits are in error.

Background test
An equipment diagnostic test is in background test mode when 2-6 diagnostic tests are running
at the same time, and more than one unit is being tested. You can perform other tasks from the
terminal while the system is executing tests in background mode.

Backup
Backup refers to the duplicate hardware, software, or data that can be used in case of failure, or
when the primary system is unavailable.

Bandwidth
Bandwidth is the difference in Hz between the highest and lowest frequencies in a transmission
channel. Bandwidth is also the data rate that can be carried by a given communications circuit.

BCC
See Board Controller Complex.

BCLAN
See Board Controller Local Area Network.

B direction
The B direction is the direction in which the signal travels through the system from the F-END
to the E-END.

Bidirectional
Bidirectional, or two-way cross connects connect two ports so they can communicate in two
directions.

Bit Slice Controller
The Bit Slice Controller (BSC) is located on the Matrix and Synchronisation (MS) subrack. The
BSC works with the System Timing Unit (STU) to provide timing signals for internal
transmission paths. The BSC also provides control information for the Bit Slice Switch Units
(BSSUs). The BSC’s interface module, the Optical Link Unit (OLU), provides the BSC’s optical
links to the switch matrix units, and to the BSC’s duplicate mate. There are two OLUs for each
BSC.

....................................................................................................................................................................................................................................
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Bit Slice Fibre Interface
The Bit Slice Fibre Interface (BSFI) is a control interface between the Bit Slice Controller
(BSC) and Bit Slice Switch Unit (BSSU). The Optical Link Unit (OLU) contains the circuitry
for the BSFI. See also Equipment Core Interface.

Bit Slice Interface Unit
The Bit Slice Interface Units (BSIUs) are located on the port subracks. BSIUs transport data
betwen the Bit Slice Switch Units (BSSUs) and the port units. The BSIU also monitors the
transmission data and provides automatic protection switching for hardware failures.

Bit Slice Switch Unit
The Bit Slice Switch Units (BSSUs) are cross-connect matrix components. The WaveStar DACS
has ten BSSUs. Five BSSUs are located in the bottom of the Matrix and Synchronisation rack,
and five BSSUs are located in the bottom of the Matrix and Control rack. Each BSSU carries
either 256 or 512 slices of Synchronous Digital Hierarchy (SDH) traffic (STM-1 equivalent).

Board Controller Complex
Many units contain Board Controller Complex (BCC) circuitry that allows the unit to talk to
and be controlled by the Subrack Controller (SRC).

Board Controller Local Area Network
The Board Controller Local Area Network (BCLAN) is a subrack backplane communications
link that the SRC uses to communicate with the other units in the subrack.

Boot
A boot transfers the contents of backup memory into working memory. Booting usually occurs
when a unit or controller is inserted, when the system is powered up, or when a subrack is
created.

Bridge cross connect
A bridge cross connect is another name for a multi-point cross connect.

Bridge (SNCP)
An SNCP bridge transmits identical traffic on both the working and protection trails.

Broadband
Broadband is a networking technique for transmitting large amounts of voice, data, image, and
multimedia signals over long distances on coaxial or fibre-optic cables. In digital
communication, signals are transmitted at the 45 Mbps or higher rate.

Broadcast cross connect
A broadcast cross connect is another name for a multi-point cross connect.

BSC
See Bit Slice Controller.

BSFI
See Bit Slice Fibre Interface.
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BSIU
See Bit Slice Interface Unit.

BSSU
See Bit Slice Switch Unit.

....................................................................................................................................................................................................................................

C Central Office
A Central Office (CO) is a building that houses telecommunications equipment.

Circuit pack
See Unit.

CIT
See Craft Interface Terminal.

CO
See Central Office.

Cold start
A cold start initialises or recovers a single unit. A cold start may affect service.

Controller
Controller is another name for the Subrack Controllers (SRCs) and Main Processor Units
(MPUs). Controllers administer the other units on their respective subracks.

Craft Interface Terminal
The Craft Interface Terminal (CIT) is a computer terminal used for provisioning and
maintenance.

Cross connects
Cross connects are the hardware and software used to connect line-terminating equipment,
multiplexers, and other equipment.

Current request
A current request is the current state of the entity with regard to protection switching. A current
request is either the result of a previous user-initiated protection switch request or the result of
a system-initiated switch request that was made due to the condition of the software and
hardware. The current request is called the “current switch state” on the Integrated Transport
Management-Subnetwork Controller (ITM-SC).

....................................................................................................................................................................................................................................

D DACS VI-2000
The Digital Access Cross-Connect System (DACS) VI-2000 was a first generation digital access
cross-connect system with an initial capacity of 64 STM-1 equivalents.

DACScan
The DACScan was a network management system for a Data Communications Network (DCN).
The DACScan is now called the Integrated Transport Management-Subnetwork Controller

....................................................................................................................................................................................................................................
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(ITM-SC).

Default
A default is a value the system automatically provides if the user does not specify a value.

Defect
A defect is a fault that interrupts a specific function. A defect does not affect the performance
of a function. See Failure.

Deferred
Deferred indicates one, or both, of the following:

• A change over to standby equipment has been used to restore service.

• A performance-degrading condition exists, but the condition does not affect service.
Maintenance personnel must take immediate action, but they must resolve any prompt alarms
first.

Degradation
Degradation pertains to the reduced service level available from a computer system when one or
more of its component parts is unavailable due to malfunction or maintenance.

Diagnostic test
Tests the internal hardware on a unit.

Digital cross connect system
A digital cross connect is an electronic switching system that routes digital signals among
multiple paths without the need to demultiplex signals.

Digital Timing Unit
The Digital Timing Unit (DTU) provides timing for the transmission units in a port subrack.
The DTU is always duplicated.

Downstream
The downstream signal points at or towards the destination of the transmission stream. In other
words, the downstream signal looks in the direction of transmission.

Drop and continue
A function within a ring node where traffic is both extracted from the working channels on the
ring (drop), and transmitted onwards on the ring (continue).

DTU
See Digital Timing Unit.

Dual node interconnection
An architecture between two rings where two nodes in each ring are interconnected.

....................................................................................................................................................................................................................................

E ECI
See Equipment Core Interface.
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E-END
E-END is an arbitrary designation used to distinguish one end of a unidirectional, bidirectional,
idle (unmapped), or bridge cross connect as the signal travels through the system. You can
establish test access at either the E-END or the F-END.

EID
See Equipment Identification.

Electrostatic Discharge
Electrostatic Discharge (ESD) is the sudden release of the charge associated with static
electricity. Static charge is generated whenever two materials come into contact with each other
and are then separated.

Entity
Entity is a term used to generically refer to a piece of equipment or to a signal.

Equipment Core Interface
The Equipment Core Interface (ECI) is a data and control interface between the Bit Slice
Switch Unit (BSSU) and Bit Slice Interface Unit (BSIU). This interface also distributes the
timing information between the port subracks and the BSSU. See Bit Slice Fibre Interface.

Equipment Identification
The Equipment Identification (EID) is the address the software uses to identify equipment.

Equipped
An equipped unit is a unit that has been successfully inserted into the subrack and has program
image and configuration data.

Error
An error is any difference between a computed, observed, or measured condition and the
theoretically-correct condition.

Errored
When a diagnostic test displays an errored message, it means that the system could not
complete a diagnostic test.

Errored Seconds
Errored Seconds (ES) is a performance-monitoring parameter that refers to the number of
one-second periods in which one or more Errored Blocks occur.

ESD
See Electrostatic Discharge.

Estimator value
The estimator value is a value that is used in the performance-monitoring calculation process.
The estimator value is the error rate, in errored-blocks-per second, at which the errored seconds
become severely-errored seconds.

....................................................................................................................................................................................................................................
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ETSI
See European Telecommunications Standards Institute.

European Telecommunications Standards Institute
The European Telecommunications Standards Institute (ETSI) is a committee designed to
provide inter-vendor and inter-operator compatibility of Synchronous Digital Hierarchy (SDH)
equipment.

....................................................................................................................................................................................................................................

F F-END
F-END is an arbitrary designation used to distinguish the end opposite the E-END of a
unidirectional, bidirectional, or bridge cross connect as the signal travels through the system.
You can establish test access at either the E-END or the F-END.

Failed
When a diagnostic test displays a failed message, it means that the equipment did not pass a
diagnostic test.

Failure
A failure is a defect that has persisted long enough to be considered a permanent condition. A
failure can affect the performance of a specific function.

Far end
Far end refers to the remote network element. For performance monitoring, the system collects
performance-monitoring data on the local network element from anomalies detected in the
incoming signal by the remote (far-end) network element.

Fatal
A fatal condition means that the system has detected a fatal failure on either the active or the
standby unit. A fatal failure is brought about by a unit being removed or by the loss of power to
the unit.

Fibre-optic cable
Fibre-optic cable is a transmission medium consisting of a core of glass or plastic surrounded
by a protective cladding, strengthening material, and outer jacket. Also called an optical-fibre
cable.

Frame
A frame is the smallest repetitive block of digital data being transmitted.

Frame ID
The Frame ID uniquely identifies a system within the office.

Free-running mode
The system operates in free-running mode when it is initially put into service. In free-running
mode, the system timing is provided by the internal clock. After the system has been
phaselocked to a timing reference, the system will not return to free-running mode.

....................................................................................................................................................................................................................................
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....................................................................................................................................................................................................................................

G G.xxx
G.xxx refers to ITU Standards documents.

Graphical User Interface
A Graphical User Interface (GUI) is a graphics-based user interface that incorporates icons,
pull-down menus, and a mouse.

....................................................................................................................................................................................................................................

H Head end
A Sub-Network Connection Protection (SNCP) node that executes a bridge.

Hold off time
The time (0 to 10 seconds) that the system waits after detecting a failure before initiating a
protection switch. The hold-off time can be used to control switching order when multiple
protection mechanisms are protecting the same service. For example, lower order or higher
order SNCP can be combined with MSP or equipment protection.

Holdover mode
Holdover mode is a backup operational mode that the system enters automatically if all
provisioned timing references have failed. In holdover mode, the internal system clock simulates
the timing that occurred during a previous period in free-running mode or phaselocked mode.
An alarm is raised whenever the system enters holdover mode.

....................................................................................................................................................................................................................................

I Idle
An output port is idle if the port is not cross connected to an input port.

Information
An alarm designated as information means that the alarm requires no immediate action.
Maintenance personnel can perform the required actions on a scheduled basis or after an
accumulation of maintenance events. Information alarms are indicated only on the User Panel.

Initialisation
An initialisation is a restart that synchronises the hardware with the software. Warm and cold
starts are also called initialisations.

Integrated Transport Management Network Module
An Integrated Transport Management Network Module (ITM-NM) is a network management
system for a Data Communications Network (DCN). The ITM-NM was formerly called
DACScan.

Integrated Transport Management Subnetwork Controller (ITM-SC)
The Integrated Transport Management Subnetwork Controller (ITM-SC) is the remote manager
for Synchronous Digital Hierarchy (SDH) network elements in a subnetwork. The ITM-SC is
also referred to as an Element Management System (EMS).

....................................................................................................................................................................................................................................
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Interface Unit
The Interface Unit (IU) provides the SDH Physical Interface (SPI) function for STM-1 electrical
and optical signals. All STM-1 IUs work with the STM-1 port unit.

International Telecommunications Union — Transmission
The International Telecommunications Union — Transmission (ITU) is an international
consultative committee that studies technical, operating, and tariff questions and issues
recommendations on them with a view to standardising telecommmunications on a worldwide
basis. The ITU was formerly called the Consultative Committee for International Telegraph and
Telephone (CCITT).

International Telecommunications Union — Transmission, Multiplex Section Protection
International Telecommunications Union — Transmission, Multiplex Section Protection (ITU
MSP) provides 1+1 unidirectional or bidirectional nonrevertive switching for STM-16, STM-4,
and STM-1 optical interfaces, and for STM-1 electrical interfaces. Two lines carry identical
payloads in a permanent bridged arrangement between network elements. ITU MSP complies
with ITU-T Recommendation G.783, Annex A.

ITM-NM
See Integrated Transport Management Network Module.

ITM-SC
See Integrated Transport Management Subnetwork Controller.

ITU MSP
See International Telecommunications Union — Transmission, Multiplex Section Protection.

ITU-T
See International Telecommunications Union — Transmission.

IU
See Interface Unit.

....................................................................................................................................................................................................................................

K K bytes
K bytes are Automatic Protection Switching (APS) bytes that are used by the Multiplex Section
Protection (MSP) functions at the ends of a multiplex section in making requests for, and giving
acknowledgements of, protection-switching actions.

Kbps
The term Kbps refers to Kilobits per second.

....................................................................................................................................................................................................................................

L LAN hub
See Local Area Network hub.

LAN Hub Unit
The LAN Hub Units (LHUs) are located in the back of Main Controller subrack. The LHUs
provide the hub ports for system LAN connections.

....................................................................................................................................................................................................................................
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LHU
See LAN Hub Unit.

Line
Line refers to a transmission medium, together with the associated high speed equipment that
are required for providing the means of transporting information between two consecutive
network elements. One line originates the line signal, and the other line terminates the line
signal.

Line condition
The line condition is the current state of health of a working or a protection line.

Line restore time
Line restore time is the number of minutes that the system waits, after a failure condition that
caused a protection switch clears, before switching to the line that is not carrying service (the
line where the fault cleared). Line restore time applies only to NTT MSP.

Line-derived timing
Line-derived timing means that the system timing is derived from the signal received from a
transmission port.

Local Area Network hub
A Local Area Network (LAN) hub connects multiple LAN entities.

LOF
See Loss of Frame.

Loopback cross connect
A loopback cross connect is a special unidirectional cross connect that sends the signal from an
input port back to the output port. Loopback cross connects are typically used to isolate trouble
on the port units during installation.

Loopback test access connection
A loopback test access connection loops back one end of a signal onto itself and bridges the
connection to the test access port. Use loopback test access connections to test idle ports.
LOOPE and LOOPF are loopback test access connections.

LOP
See Loss of Pointer.

LOS
See Loss of Signal.

Loss of Frame
A Loss of Frame (LOF) is a failure to synchronise to an incoming signal.

Loss of Pointer
A Loss of Pointer (LOP) is a failure to extract good data from a signal payload.

....................................................................................................................................................................................................................................
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Loss of Signal
A Loss of Signal (LOS) is the complete absence of an incoming signal.

....................................................................................................................................................................................................................................

M Magneto Optical disks
A Magneto Optical (MO) disk is a removable storage medium. MO disks are used for backing
up the system database and for loading software onto the system.

Main Controller Local Area Network
The Main Controller Local Area Network (MCLAN) is a LAN used by the system for
inter-processor communication between the Main Controller (MC) subrack and other system
subracks.

Main Controller subrack
The Main Controller (MC) subrack contains the main processor, memory, Local Area Network
(LAN) hubs, hard disk, removable optical disk, alarm unit, main connector panel, and User
Panel.

Main Processor Unit
The Main Processor Unit (MPU) is located on the front of the Main Controller (MC) subrack.
The MPU provides the central processing function which includes control of the ARU, LHU,
and MSU.

Mass Storage Unit
The Mass Storage Unit (MSU) is located on the front of the Main Controller (MC) subrack. The
MSU contains a hard disk drive and a Magneto-Optical (MO) drive.

Master unit
A master unit is a unit that controls a slave unit by sending messages or writing registers to the
slave. BSC, DTU, and port units are master units.

Matrix and Control rack
The Matrix and Control (MC) rack is an equipment rack that contains the Main Controller
subrack and five Bit Slice Switch Units (BSSUs).

Matrix and Synchronisation rack
The Matrix and Synchronisation (MS) rack is an equipment rack that contains the Matrix and
Synchronisation subrack and five Bit Slice Switch Units (BSSUs).

Mbps
Mbps is a term that refers to Megabits per second. Mega is the Greek prefix for “big.” A
megabit is one million bits.

MCLAN
See Main Controller Local Area Network.

Module
See Subrack.
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Monitor test access connection
A monitor test access connection allows you to connect test equipment in parallel with a digital
signal path while maintaining the digital transmission signal. Even though this test does not
affect service, you will receive a confirmation notice from the user interface when you make a
monitor test access connection. MONE, MONF, and MONEF are monitor test access
connections.

MPU
See Main Processor Unit.

MS
See Multiplex section.

MSP
See Multiplex Section Protection.

MSU
See Mass Storage Unit.

Multiplexing
Multiplexing is the process of transmitting multiple signals over a single communications line
or computer channel by interleaving the messages.

Multiplex section
A multiplex section (MS) is a transmission medium, together with the associated equipment,
required to provide the means of transporting information between two consecutive network
elements. One of the network elements originates the line signal and the other network element
terminates the line signal.

Multiplex Section Protection
1+1 Multiplex Section Protection (MSP) is a transmission protection arrangement. The same
signal is sent and received over two seperate transmission lines. These transmission lines
terminate on separate transmission ports that are logically linked in software. The system
supports three types of MSP: ITU MSP, NTT MSP, and ANSI MSP.

Multiplex Section Protection group
A Multiplex Section Protection (MSP) group is a pair of associated ports on a pair of
physically-adjacent port units. An MSP group, which is also called an MSP pair, provides
transmission line protection between network elements.

Multiplex section terminating equipment
Multiplex section terminating equipment is a network element that originates or terminates
STM-1, STM-4, or STM-16 signals.

Multi-point cross connect
Multi-point cross connects have the following characteristics:

• Connect a single input to two or more outputs

• Provide bridging for restoration, testing, or broadcast

....................................................................................................................................................................................................................................

G L O S S A R Y
G L - 1 4

Lucent Technologies 365–367–512
Issue 2, July 2002



• Can be from any input to any available output signal

• Created using the “Uni-Directional” option on the Cross Connect window

• Can be disconnected in any order

• Can be added to any existing service whether originally created as unidirectional or bidirectional

• Were previously called bridge and broadcast cross connects

....................................................................................................................................................................................................................................

N Near end
Near end refers to the local network element. For performance monitoring, the system collects
performance-monitoring data on the local network element from anomalies detected in the
incoming signal by the local (near-end) network element.

Network element
A network element is a piece of equipment that provides a component function in a network.
Examples are: channel banks, digital cross-connects, and multiplexers.

Network Interface Chip
A Network Interface Chip (NIC) is a DEC 21140-A device capable of both 10BaseT or
100BaseT operations.

NIC
See Network Interface Chip.

Nippon Telephone and Telegraph, Multiplex Section Protection
Nippon Telephone and Telegraph, Multiplex Section Protection (NTT MSP) provides switching
similar to bidirectional International Telecommunications Union, Multiplex Section Protection
(ITU MSP) for STM-1 optical interfaces, and for STM-1 electrical interfaces. NTT MSP
complies with ITU-T Recommendation G.783, Annex B, and a set of recommendations provided
by NTT. See International Telecommunications Union — Transmission, Multiplex Section
Protection.

Nonrevertive
Nonrevertive is a protection-switching operation type. When a protection group is nonrevertive,
the protection entity will continue to operate as the active entity even after a failure clears on
the working entity.

NTT MSP
See Nippon Telephone and Telegraph, Multiplex Section Protection.

....................................................................................................................................................................................................................................

O OLU
See Optical Link Unit.

Optical disk
An optical disk is a storage medium that contains digital data readable by optical techniques.

....................................................................................................................................................................................................................................
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Optical Link Unit
The Optical Link Unit (OLU) is part of the internal transmission path. It provides interfaces for
the optical-fibre cables that carry transmission data between the Bit Slice Controllers (BSCs)
and the Bit Slice Switch Units (BSSUs). The OLU also provides interfaces for the optical-fibre
cables that carry timing information between the duplicated BSCs in the Matrix and
Synchronisation subrack.

OOS
See Out-of-service.

Optical-fibre cable
See Fibre-optic cable.

Out-of-service
Out-of-service is a controller state that means that the MPU and SRC controllers are in
firmware mode. No application or system base is running.

Overhead
Overhead (OH) is the term for auxiliary bytes used for everything but customer payload (for
example: signalling) carried with Synchronous Digital Hierarchy (SDH) signals.

....................................................................................................................................................................................................................................

P Pack
See Unit.

Parameter
Parameters are the output of the performance-monitoring calculation process. For example:
background block errors, errored seconds, severely-errored seconds, and unavailable seconds are
all parameters.

Partial Passed
When a diagnostic test displays a Partial Passed message, it means that the system tested and
passed all the equipment available for the test in the current configuration. The screen will
display this result if one or more units that could have been tested were not present, and
therefore, were not tested.

Passed
When a diagnostic test displays a passed message, it means that the system tested all the
equipment available for the test, and all of the equipment passed the diagnostic test.

Path terminating equipment
Path terminating equipment is a network element that multiplexes or demultiplexes the VC-4
payloads.

Path selector
Within an Sub-Network Connection Protection (SNCP) architecture, the node function that
selects a tributary which is extracted from the working channels arriving from one side of the
node or from the other side of the node, according to path level criteria.

....................................................................................................................................................................................................................................
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Path Trace Identifier
The purpose of the Path Trace Identifier (PTI) is to transmit a path access point identifier so
that a receiving terminal can verify that the receiving terminal is connected to the intended
transmitter.

Performance monitoring
Performance monitoring (PM) measures the quality of service and identifies degrading or
marginally operating systems before an alarm is generated.

Phaselocked mode
Phaselocked mode is the normal mode of operation. In this mode, the system clock is slaved to
an external timing reference such as a transmission port or a station clock input.

Plug-in
See Unit.

PM
See Performance monitoring.

Port subrack
Port subrack is a generic term that refers to either the PSA or the PSC subracks.

Port subrack A
Port Subrack A (PSA) houses the STM-1 electrical and optical interfaces.

Port subrack C
Port Subrack C (PSC) houses the STM-4 or STM-16 optical interfaces.

Port unit
A port unit and an interface unit work together to transmit and receive optical or electrical
signals. The STM-1, STM-4, and STM-16 units are port units.

Power Supply
The Power Supply (PSP) supplies DC power for the midplane, fans, and units in the Main
Controller (MC) subrack. The PSP is located below the fan trays at the bottom of the MC
subrack.

Power Terminal Module
The Power Terminal Module (PTM) filters incoming station power from two separate power
sources and distributes power across the midplane.

Prompt
A prompt alarm indicates that maintenance personnel must repair the defective equipment or
take whatever corrective action is necessary to restore good service. Alarms for conditions that
affect service are always classified as prompt.

Protection
When an entity is duplicated, one of the duplicated entities is designated as the protection
entity, while the other is designated as the working entity. If the status of the protection entity

....................................................................................................................................................................................................................................
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changes from standby to active, the entity still retains its designation as the protection entity.

Protocol
Protocol is a formal set of conventions governing the format and relative timing of message
exchange between two communicating processes.

Provisioning
Provisioning refers to the user’s ability to create, change, view, and delete system information.

PSA subrack
See Port Subrack A.

PSC subrack
See Port Subrack C.

PSP
See Power Supply.

PTM
See Power Terminal Module.

....................................................................................................................................................................................................................................

R Rack
A rack is a mechanical assembly that houses the system equipment.

Revertive
Revertive is a protection-switching operation type. When a protection group is revertive, the
system will automatically switch service from the protection entity back to the working entity
when a failure clears and the Wait-To-Restore time has elapsed.

Rollover (Roll)
A roll is used to replace the input of an existing cross connect. All outputs specified in the
original connection are moved to the new input. You can roll a unidirectional cross connect, one
or both directions of a bidirectional cross connect, or a multi-point cross connection. When
performing a roll, you can specify a specific output or all multi-point outputs.

....................................................................................................................................................................................................................................

S SCSI
See Small Computer System Interface.

SDH
See Synchronous Digital Hierarchy.

Secondary line (NTT MSP only)
The secondary line is the line in an NTT MSP arrangement that provides service when there is
an active protection request.

....................................................................................................................................................................................................................................
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Severely-Errored Seconds
Severely-Errored Seconds (SES) refers to the number of one-second periods in which the
number of Errored Blocks equals or exceeds the estimator value.

Single node interconnection
An architecture between two rings where one node in each ring is interconnected.

Slave unit
A slave unit is a unit that is controlled by a master unit. BSSUs, BSIUs, and IUs are slave
units.

Slot
A slot is the space in a subrack that is designed to hold a unit.

Small Computer System Interface
A Small Computer System Interface (SCSI) is a hardware interface that allows for the
connection of peripheral devices to a computer.

SNCP
See Sub-Network Connection Protection.

Split test access connection
A split test access connection splits the digital transmission path so that you can perform tests
in both directions. SPLTA, SPLTB, SPLTAB, SPLTE, SPLTF, and SPLTEF are split test access
connections.

Squelch
A squelched signal means that no signal is being transmitted.

SRC
See Subrack Controller.

Standby
When an entity is duplicated, one of the duplicated entities, the active entity, is currently
providing service while the other entity is in standby. Either the working or protection entity
can be in standby at any time.

State
State indicates whether an entity is defective or normal, in service or out of service, etc.

Station alarm
A station alarm is an alarm that appears visually or audibly anywhere other than on the User
Panel or on a unit.

Station clock input
The station clock input (2048 kHz or 64 kHz) depends on the type of System Timing Unit
(STU) that is installed in the system.

....................................................................................................................................................................................................................................

365–367–512
Issue 2, July 2002

Lucent Technologies G L O S S A R Y
G L - 1 9



STM
See Synchronous Transport Mode.

STU
See System Timing Unit.

Sub-Network Connection Protection
Sub-Network Connection Protection (SNCP) is a transmission protection feature that provides
protection for all or part of a trail through a network. At the head end of the protected
subnetwork connection, a bridge is created. The bridge sends two identical copies of the
protected trail toward the tail end over different routes. The tail end selects which copy of the
trail to take as input based on manual and automatic switching criteria. For bidirectional traffic,
each end of the connection provides both the head end (bridging) and the tail end (selector)
functions.

Subrack
A subrack is a mechanical assembly that houses plug-in units, also referred to as circuit packs,
that contain the circuitry for the system. All subracks conform to European Telecommunications
Standards Institute (ETSI) equipment practices for transmission products. Subracks have a
midplane or a backplane that interconnects the units in the subrack.

Subrack Controller
The Subrack Controller (SRC) routes messages back and forth from the Main Controller (MC)
to the units in the Matrix and Synchronisation subrack.

Suite
A suite is an equipment aisle or set of frames.

Synchronous
Synchronous is a method of transmitting data in which discrete signal elements are transmitted
at a fixed and continuous rate. Synchronous data transmission requires that the timing of the
transmission be synchronised between the sending and receiving devices.

Synchronous Digital Hierarchy
Synchronous Digital Hierarchy (SDH) is a hierarchical set of digital transport structures,
standardised for the transport of suitably-adapted payloads over physical transmission networks.

Synchronous Transport Mode
The Synchronous Transport Mode (STM) is a transport and switching method that depends on
information occurring in regular and fixed patterns with respect to a reference such as a frame
pattern.

Synchronous Transport Module, level 1
Synchronous Transport Module, level 1 (STM-1) is a 155.52 Mbps data stream in a
Synchronous Digital Hierarchy (SDH) frame format. This is the lowest level SDH signal.

....................................................................................................................................................................................................................................
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Synchronous Transport Module, level n
Synchronous Transport Module, level “n” (STM-n) is a Synchronous Digital Hierarchy (SDH)
standard for transmission over optical fibre by multiplexing “n” times the basic rate (STM-1).

• STM-4 = 622.08 Mbps

• STM-16 = 2.488 Mbps

System
System refers to groups of software and hardware that operate as a whole.

System clock input reference
System clock input references can be derived from transmission ports (STM-1, STM-4, STM-16
ports or MSP pairs) or from external timing references (station clock inputs). External
references can be derived from one or two 2048 kHz timing inputs or from one or two 64 kHz
composite clock inputs.

System Timing Unit
The System Timing Unit (STU) provides system timing and synchronisation. The STU-64 has an
extra 64 KHz clock input for external timing purposes.

....................................................................................................................................................................................................................................

T Tail end
A Sub-Network Connection Protection (SNCP) node that requests the bridge.

TCA
See Threshold Crossing Alert.

Test access ports TP1 and TP2
Test access ports TP1 and TP2 are the software addresses for the test access ports. Test access
ports are located on the port units.

Threshold
A threshold is the level of a parameter count at which the system sends a Threshold Crossing
Alert.

Threshold Crossing Alert
The system reports a Threshold Crossing Alert (TCA) whenever a performance-monitoring
parameter exceeds a specified threshold.

Trail
A trail is the logical transmission path between two path termination points.

Tributary Unit
A Tributary Unit (TU) is an information structure that provides adaptation between the lower
order path layer and the higher order path layer. A TU consists of an information payload, also
referred to as a lower order Virtual Container, and a TU pointer. The TU pointer indicates the
offset of the payload frame start relative to the higher order Virtual Container frame start.

Tributary Unit 3
A Tributary Unit 3 (TU-3) consists of a Virtual Container 3 (VC-3) plus a TU pointer.

....................................................................................................................................................................................................................................
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Tributary Unit 12
A Tributary Unit 12 (TU-12) consists of a Virtual Container 12 (VC-12) plus a TU pointer.

Tributary Unit Group
A Tributary Unit Group (TUG) consists of one or more TUs occupying fixed, defined positions
in a higher order Virtual Container payload.

Tributary Unit Group 2
A TUG-2 is 12 columns of an STM-1 frame that can contain four TU-11s, three TU-12s, or one
TU-2.

Tributary Unit Group 3
A TUG-3 is 86 columns of an STM-1 frame that can contain either one TU-3 or seven TUG-2s.

TU
See Tributary Unit.

TU-12
See Tributary Unit 12.

TU-3
See Tributary Unit 3.

TUG
See Tributary Unit Group.

TUG-2
See Tributary Unit Group 2.

TUG-3
See Tributary Unit Group 3.

....................................................................................................................................................................................................................................

U Unassigned alarm indicator
Unassigned alarms are customer-designed alarm interfaces. They consist of eight output relays
for devices such as burglar alarms and fire detectors. Check office records for more details.

Unavailable Seconds
Unavailable Seconds is the number of one-second periods when performance-monitoring data is
unavailable due to prolonged severely-errored conditions. The Unavailable Seconds count begins
when the system detects ten or more consecutive Severely-Errored Seconds. The system will
count these severely-errored seconds as an unavailable second instead. The Unavailable Seconds
count stops when the system detects ten or more consecutive, nonseverely errored seconds. All
other counts stop during Unavailable Seconds.

Unidirectional
A unidirectional, or one-way cross connect connects two ports so that they can communicate in
one direction. Even though most cross connects are bidirectional, the system also allows cross
connects in only one transmission direction between all port combinations. Unidirectional cross
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connects are used mostly for test access.

Unit
A unit is the hardware that is inserted into an equipment shelf. A unit is also called a plug-in,
circuit pack, or pack.

Upstream
The upstream signal points at or towards the source of the transmission stream. In other words,
the upstream signal looks in the direction opposite to the direction of transmission.

....................................................................................................................................................................................................................................

V VC-4-4c
See Virtual Container 4_4c

VC
See Virtual Container.

VersaModule Europe
VersaModule Europe (VME) is a 1 through 21 slot, mechanical and electrical bus standard.
VME is also known as the InterExchange Carrier (IEC) 821 bus.

Virtual Container
A Virtual Container (VC) is the information structure used to support path layer connections in
the Synchronous Digital Hierarchy (SDH).

Virtual Container 4-4c
A Virtual Container 4-4c (VC-4-4c) consists of four concatenated VC-4s. Concatenated means
linked together in a series.

VME
See VersaModule Europe.

....................................................................................................................................................................................................................................

W Wait-To-Restore time
The Wait-To-Restore (WTR) time is the amount of time (in minutes) that the system waits, after
a failure condition that caused a protection switch clears, before switching back to the
previously-active equipment (matrix slice or port unit).

Warm start
A warm start initialises or recovers a single unit or a group of units without affecting service.

Wideband
Wideband is one type of voice, data, or video rate that transmits digital rates between 1.5 Mbps
and 45 Mbps.

Working
When an entity is duplicated, one of the duplicated entities is designated as the working entity,
while the other is designated as the protection entity. If the status of the working entity changes
from active to standby, the entity still retains its designation as the working entity. The working
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entity is the preferred active entity.

WTR
See Wait-To-Restore time.
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Numerics

2nd Area field

DCN Query Results
window, 14-29

3rd Area field

DCN Query Results
window, 14-29

256 system capacity

addressing, 3-10

information about, 1-5

512 system capacity

addressing, 3-10

information about, 1-5
........................................................

A ABNORMAL LED on User
Panel, 1-20

Accepted PSL field

High Order Path Query
Results window, 8-29

Low Order Path Query
Results window, 8-36

Accepted PTI field

High Order Path Query
Results window, 8-29

Low Order Path Query
Results window, 8-36

Access Class field, 17-6

access classes

changing, 17-14

definitions, 17-3

list of permissions, 17-4

ACP, 1-22

Activate Audible
Autonomous Message
Indicator field, 19-3

Active Reference field,
13-21

adding

multi-points
(bridges/broadcast) to
cross connects, 4-11

user ID, 17-10

adding equipment

process for adding a
subrack to an existing
rack, 6-7

process for adding units
to an existing rack and
subrack, 6-7

addresses

256 and 512 system
capacity, 3-10

about entity, 3-2

about physical layer,
3-3

about Signal ID, 3-4

equipment protection
group, 3-16

fibre, 3-19

INTFcEQ, CABLEcEQ,
and CABLEcTIM
alarms, 3-19

Main Controller, 3-11

Matrix and
Synchronisation, 3-12

MSP, 3-17

PSA, 3-13

PSC, 3-14

rack top, 3-18

wildcards, 3-9

Administrator class, 17-3

AIS

provisioning, 4-36

querying, 4-35

AIS Active field, 5-14

AIS alarm reporting

information about, 5-3

turning on or off, 5-20

AIS Inactive field, 5-14

AIS Only field, 5-16

AIS Signal field, 4-9

Alarm Clear Delay field,
12-12

alarm clear delay timers,
11-4

Alarm Connector Panel,
1-22
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alarm indicators

definition, 11-8

descriptions, 11-9

information about
disconnecting and
suppressing, 11-12

Alarm Panel

information about, 11-5

alarm reporting

information about AIS
or RDI, 5-3

querying, 5-15

turning on or off AIS or
RDI, 5-20

Alarm Suppress Control
window

field descriptions, 12-17

graphic of, 12-17

alarm suppress status

changing, 12-19

querying, 12-18

alarm tallies, 11-5

Alarm Unit
See: ARU

alarms

alarm and defect
reports, 11-3

alarm-clear delay
timers, 11-4

changing severity
levels, 12-9

changing suppress
status, 12-19

changing timers, 12-15

conditions that affect
service, 11-7

consequent actions, 11-3

correlating defects, 11-3

defect-to-alarm delay
timers, 11-4

defects and failures,
11-3

definitions, 11-2

delay timers, types of,
11-4

differences between
transmission and
equipment defects or
failures, 11-3

querying severity levels,
12-5

querying suppress
status, 12-18

querying timers, 12-14

restoring default
severity levels, 12-10

alarms and PM, 10-6

Alarms menu, 2-10

alignment of PC and MC
clocks, 2-3

All Alarms field, 5-16

ALL, using in address, 3-9

ALM connector on the port
rack fan tray connector
panel, 1-32

ALS field, 8-12

ANSI MSP, information
about, 9-7

Apparatus Code field, 6-39

Apply button, 2-17

Area field

DCN Query Results
window, 14-29

arrows used for navigation,
2-20

ARU

in MC, 1-19

ARU ALARM 1 connector
on the ACP, 1-23

ARU ALARM 2 connector
on the ACP, 1-23

ARU ALT 1 connector on
the ACP, 1-22

ARU ALT 2 connector on
the ACP, 1-23

ARU RELAY 1 connector
on the ACP, 1-22

ARU RELAY 2 connector
on the ACP, 1-22

Assigned Priority (Internal
Clock) field, 13-15

Assigned Priority (System
Clock Input Reference)
field, 13-15

assigning

AU, HP, TU, and LP
signal monitoring,
5-19

port monitoring values
for monitoring control
mode, 5-11

RS and MS signal
monitoring, 5-18

station clock as
reference for system
clock, 13-22

system clock as
reference for station
clock, 13-32

transmission port as
reference for station
clock, 13-33

transmission port as
reference for system
clock, 13-23

AU signal monitoring
provisioning, 5-19

AUTO field, 5-8

automatic laser shutdown

enabling, 8-15

autonomous events, 11-5

Autonomous Events button,
2-17
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Autonomous Message
Indicator window

field descriptions, 19-3

graphic of, 19-3

autonomous message
indicator, disabling and
enabling, 19-4

autonomous messages

definition, 19-2
........................................................

B bandwidth and MSP
groups, 9-10

Bi-Directional field

Connect Roll window,
4-16

Cross Connect window,
4-6

bidirectional SNCP
configurations, 9-14

Bit Slice Controller
See: BSC

Bit Slice Interface Unit
See: BSIU

Bit Slice Switch Unit
See: BSSU

block diagram

control system, 1-6

system, 1-3

board controllers, 1-7

booting the PC, 2-2

bridge cross connect
provisioning, 4-11

bridges for SNCP, 9-26

broadcast cross connect
provisioning, 4-11

BSC

information about, 1-13

BSIU

in PSA subrack, 1-29

BSIU128, 1-31

BSSU, 1-26

information about, 1-15

buttons, description of,
2-17

........................................................

C cable addresses, 3-19

cable connections for
station clock, 13-3

CABLEcEQ alarm

example of fibre
address, 3-19

CABLEcTIM alarm

addresses, 3-19

Cancel Test button, 2-17

Change button, 2-17

Change Password window

field descriptions, 16-2

graphic of, 16-2

changing

access class, 17-14

administrators changing
a user’s password,
17-13

alarm indicators,
information about,
11-13

alarm severity levels,
12-9

alarm suppress status,
12-19

alarm timer values,
12-15

date and time, 18-4

EOW, 7-7

frame ID, 15-4

higher order path, 8-30

information about
changing signal type,
8-5

Line Restore Time, 9-35

lower order path, 8-37

multiplexing structure
of transmission port,
8-22

port transmission
parameters, 8-14

priority of internal
clock, 13-26

priority of timing
reference for system
clock, 13-24

rack, 6-20

signal type, 8-22

system ID, 15-4

TCA threshold values
for performance
monitoring, 10-44

timing reference for
station clock, 13-34

user channel, 7-8

user ID, 17-11

Wait-To-Restore timer
for matrix protection,
9-55

Wait-To-Restore timer
for STM-1 protection,
9-54

your password, 16-3

Channel field

Data Communication
Channel Query Results
window, 14-8

Clear AIS button, 2-17

Clear button, 2-17

Clear Records button, 2-17

clearing counters for
performance monitoring,
10-24

clock alignment, 2-3

Close button, 2-17
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Computed Area Address

querying, 14-30

Computed Area Address
field

Computed Area Address
Query Results window,
14-31

Computed Area Address
Query Results window

field descriptions, 14-31

conditions that affect
service, 11-7

Configuration field

SNCP Group Query
Results window, 9-40

SNCP Group window,
9-38

configurations for SNCP
groups, 9-14

configurations, subrack

PSA dual-fibre port
subrack, 6-10

PSA single-fibre port
subrack, 6-9

PSC dual-fibre port
subrack, 6-12

PSC quad-fibre port
subrack, 6-13

PSC single-fibre port
subrack, 6-11

Confirm New Password
field

Change Password
window, 16-2

Login Administration
window, 17-7

Connect button, 2-17

Connect Roll window

field descriptions, 4-16

graphic of, 4-16

Connect Station Alarms
button, 2-17

connecting

bridge and broadcast
cross connects, 4-11

cross connects, 4-10

loopback cross
connects, 4-13

multi-point cross
connects, 4-11

Connector panel, fan tray
in port rack, 1-32

consequent actions, 11-3

control system, 1-6

controllers

information about
subrack and board
controllers, 1-6

copying information in a
field, 2-20

correlating defects, 11-3

count control provisioning

clearing counters, 10-24

inhibiting counts, 10-23

querying, 10-17

starting counts, 10-20

Count Control Query
Results window

field descriptions, 10-18

graphic of, 10-18

Count Control window

field descriptions, 10-15

graphic of, 10-15

Create button, 2-17

creating

MSP groups, 9-32

rack, 6-19

SNCP group, 9-42

subrack, 6-30

cross connect provisioning

adding and removing
bridge and broadcast,
4-11

adding and removing
multi-point, 4-11

and SNCP groups, 9-26

bidirectional roll of
bidirectional cross
connect, 4-23

connecting, 4-10

connecting a loopback,
4-13

disconnecting, 4-10

disconnecting a
loopback, 4-13

querying, 4-8

rolling in a network
with service, 4-27

rolling service in a
network with no active
service, 4-24

unidirectional roll of
bidirectional cross
connect, 4-20

unidirectional roll of
unidirectional cross
connect, 4-19

cross connect status of
SNCP groups, 9-26

Cross Connect Type field

Connect Roll window,
4-16

Cross Connect window,
4-6

Cross Connect window

field descriptions, 4-6

graphic of, 4-6

Cross Connects Query
Results window

field descriptions, 4-9

graphic of, 4-9
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cross-connect provisioning,
information about

definitions, 4-4

list of all tasks, 4-3

cross-couple link, 13-3

Current Alarms button,
2-17

cutting information in a
field, 2-20

........................................................

D DACS

control system, 1-6

functional description,
1-3

setting DACS to PC
date and time, 18-6

setting PC to DACS
date and time, 18-5

Data Communication
Channel

enabling or disabling,
14-6

querying, 14-7

Data Communication
Channel in MSP Mode

provisioning, 14-12

querying, 14-13

Data Communication
Channel in MSP Mode
Query Results window

field descriptions, 14-14

Data Communication
Channel Query Results
window

field descriptions, 14-8

Data Communication
Channel window

field descriptions, 14-4

graphic of, 14-4

Data Communication
Network parameters

provisioning, 14-27

Data Communication
Network window

field descriptions, 14-25

database

backup queries, 15-3

Date and Time
Administration window

field descriptions, 18-2

graphic of, 18-2

date and time
synchronisation warning,
2-3

Date field

Date and Time
Administration
window, 18-2

date provisioning

changing, 18-4

querying, 18-3

setting DACS to PC,
18-6

setting PC to DACS,
18-5

DCC Channel field

Data Communication
Channel in MSP Mode
Query Results window,
14-14

DCC in MSP Mode
Provision window

field descriptions, 14-10

graphic of, 14-10

DCC Mode field

Data Communication
Channel in MSP Mode
Query Results window,
14-14

DCC Status field

Data Communication
Channel Query Results
window, 14-8

DCN

querying, 14-28

DCN neighbor nodes

querying, 14-18

DCN Neighbor Nodes
Query Results window

field descriptions, 14-19

DCN Neighbor Nodes
window

field descriptions, 14-16

graphic of, 14-16

DCN Query Results
window

field descriptions, 14-29

Default Multiplexing field,
6-25

Defect to Alarm Delay
field, 12-12

defect to alarm delay
timers, 11-4

defects

information about, 11-3

DEFERRED LED on User
Panel, 1-20

degrade inhibit
See: subrack degrade

inhibit

Degrade Inhibit field, 6-23

delay timers, 11-4

Delete button, 2-17

deleting

MSP groups, 9-34

port units, 6-40

rack, 6-21

SNCP groups, 9-48

....................................................................................................................................................................................................................................
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subrack, 6-32

subracks and racks, the
process for, 6-7

timing reference for
system clock, 13-25

units, information about,
6-6

units, the process for,
6-7

user ID, 17-12

Digital Timing Unit
See: DTU

disabling

automatic laser
shutdown, 8-15

autonomous message
indicator, 19-4

subrack degrade inhibit,
6-34

Disconnect button, 2-17

Disconnect Station Alarms
button, 2-17

DISCONNECT switch on
User Panel, 1-21

disconnectable station
alarm indicators, 11-9

disconnecting

alarm indicators,
information about,
11-12

bridge and broadcast
cross connects, 4-11

cross connects, 4-10

loopback cross
connects, 4-13

multi-point cross
connects, 4-11

drop and continue
protection SNCP
configurations, 9-16

drop and continue working
SNCP configurations,
9-16

DTU

PSA subrack, 1-28

PSC, 1-30

dual node interconnection,
9-18

dual-fibre PSA subrack
configurations, 6-10

dual-fibre PSA subracks
and MSP groups, 9-10

dual-fibre PSC subrack
configurations, 6-12

........................................................

E Edit menu, 2-15

editing with keys, 2-20

EIDs
See: entity addresses

Enable (Automatic Laser
Shutdown) field, 8-10

enabling

automatic laser
shutdown, 8-15

autonomous message
indicator, 19-4

subrack degrade inhibit,
6-34

enabling or disabling

Data Communication
Channel, 14-6

end-of-suite alarm
indicators, 11-9

Engineering Order Wire
See: EOW

entity addresses

general information
about, 3-2

Main Controller, 3-11

Matrix and
Synchronisation, 3-12

PSA, 3-13

PSC, 3-14

Signal ID, 3-4

EOS 1 connector on the
ACP, 1-23

EOS 2 connector on the
ACP, 1-23

EOW

changing, 7-7

querying, 7-5

EOW / User Channel
Query Results window

field descriptions, 7-6

graphic of, 7-6

EOW / User Channel
window

field descriptions, 7-3

graphic of, 7-3

EOW concepts, 7-2

EOW field, 7-3

equipment alarms

changing severity
levels, 12-9

querying severity levels,
12-5

restoring default
severity levels, 12-10

equipment defects or
failures, 11-3

Equipment field, 12-3

Equipment ID field

Signal Type Query
Results window, 8-20

equipment protection group
addresses, 3-16

equipment provisioning

about adding or deleting
equipment, 6-7

information about, 6-3

....................................................................................................................................................................................................................................
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equipment terms, 1-11

Execute button, 2-17

Expected PTI field

High Order Path Query
Results window, 8-29

High Order Path
window, 8-26

Low Order Path Query
Results window, 8-36

Low Order Path
window, 8-33

Expected PTI Mode field

High Order Path Query
Results window, 8-29

High Order Path
window, 8-26

Low Order Path Query
Results window, 8-36

Low Order Path
window, 8-33

........................................................

F FAIL LED on the port rack
fan tray connector panel,
1-32

Failure Condition field

Severity Levels Query
Results window, 12-7,
12-8

Severity Levels window,
12-3

failures, 11-3

Fan Connector Panel, 1-25

Fan tray connector panel in
port rack, 1-32

Far End fields, 10-27

Far End Thresholds fields,
10-40

FCP, 1-25

FE_BBE field, 10-43

FE_ES field

TCA Control Query
Results window, 10-30

TCA Thresholds Query
Results window, 10-43

FE_SES field

TCA Control Query
Results window, 10-30

TCA Thresholds Query
Results window, 10-43

FE_UAS field

TCA Control Query
Results window, 10-30

TCA Thresholds Query
Results window, 10-43

Fibre 1 field

Subrack Query Results
window, 6-28

Subrack window, 6-24

Fibre 2 field

Subrack Query Results
window, 6-28

Subrack window, 6-24

Fibre 3 field

Subrack Query Results
window, 6-29

Subrack window, 6-25

Fibre 4 field

Subrack Query Results
window, 6-29

Subrack window, 6-25

fibre addresses, 3-19

field descriptions

Alarm Suppress Control
window, 12-17

Autonomous Message
Indicator window, 19-3

Change Password
window, 16-2

Computed Area Address
Query Results window,
14-31

Connect Roll window,
4-16

Count Control Query
Results window, 10-18

Count Control window,
10-15

Cross Connect window,
4-6

Cross Connects Query
Results window, 4-9

Data Communication
Channel in MSP Mode
Results window, 14-14

Data Communication
Channel Results
window, 14-8

Data Communication
Channel window, 14-4

Data Communication
Network window,
14-25

Date and Time
Administration
window, 18-2

DCC in MSP Mode
Provision window,
14-10

DCN Neighbor Nodes
Query Results window,
14-19

DCN Neighbor Nodes
window, 14-16

DCN Query Results
window, 14-29

EOW / User Channel
Query Results window,
7-6

EOW / User Channel
window, 7-3

High Order Path Query
Results window, 8-28

....................................................................................................................................................................................................................................
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High Order Path
window, 8-24

Insert AIS window, 4-33

Login Administration
Query Results window,
17-9

Login Administration
window, 17-6

Login window, 2-4

Low Order Path Query
Results window, 8-35

Low Order Path
window, 8-32

MSP Group Query
Results window, 9-31

MSP Group window,
9-28

Port Monitoring Query
Results window, 5-10

Port Monitoring
window, 5-7

Port Query Results
window, 8-12

Port window, 8-9

QLAN Link Query
Results window, 14-23

QLAN Link window,
14-21

Rack Query Results
window, 6-17

Rack window, 6-15

Severity Levels Query
Results window, 12-7

Severity Levels window,
12-3

Signal Monitoring
Query Results window,
5-16

Signal Monitoring
window, 5-13

Signal Type Query
Results window, 8-20

Signal Type window,
8-17

SNCP Group Query
Results window, 9-40

SNCP Group window,
9-37

Station Clock Query
Results window, 13-30

Station Clock window,
13-28

STU Status Query
Results window, 13-20

Subrack Query Results
window, 6-27

Subrack window, 6-23

System Clock Query
Results window, 13-17

System Clock window,
13-14

System ID window,
15-2

TCA Control Query
Results window, 10-29

TCA Control window,
10-26

TCA Thresholds Query
Results window, 10-42

TCA Thresholds
window, 10-38

Timers window, 12-12

Unit Query Results
window, 6-38

Unit window, 6-36

Wait To Restore Timer
window, 9-50

fields, editing information
in, 2-20

File menu on application
menu bar, 2-10

File menu on query results
menu bar, 2-14

forcing the selection of
system clock input
reference, 13-10

Frame ID field, 15-2

frame ID provisioning

changing, 15-4

querying, 15-3

free-running mode, 13-5

From ID field, 4-7

From Port ID field, 4-9

From Signal ID field, 4-9

Full NSAP field

DCN Query Results
window, 14-29

functional description of
system, 1-3

........................................................

H hardware for
synchronisation and
timing, 13-3

Help, 2-23

Help button, 2-18

Help menu on application
menu bar, 2-12

Help menu on query results
menu bar, 2-15

Help Topics window, 2-23

hierarchy of user interface,
2-8

High Order Path Query
Results window

field descriptions, 8-28

graphic of, 8-28

High Order Path window

field descriptions, 8-24

graphic of, 8-24

high order trails

inherently-monitored
trails, 9-23

....................................................................................................................................................................................................................................
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nonintrusively-
monitored trails, 9-24

with SNCP, 9-22

higher order path
provisioning

changing, 8-30

querying, 8-27

Hold Off Time field, 9-41

Hold Off Timer field, 9-38

hold-off timer

and TSF and TSD
conditions, 9-13

using with other
protection types, 9-25

holdover mode, 13-5

HP signal monitoring
provisioning, 5-19

........................................................

I

icons, shortcut, 2-12

INFORMATION LED on
User Panel, 1-20

inherent SNCP monitoring,
9-13

inherently-monitored trails,
9-23

Inhibit Status field, 6-29

inhibiting

counts for performance
monitoring, 10-23

TCA reporting for
performance
monitoring, 10-35

Initialise button, 2-18

input references for
synchronisation and
timing, 13-4

Insert AIS button, 2-18

Insert AIS window

field descriptions, 4-33

graphic of, 4-33

interface mixing

information about, 6-3

PSA dual-fibre port
subrack, 6-10

PSA single-fibre port
subrack, 6-9

PSC dual-fibre port
subrack, 6-12

PSC quad-fibre port
subrack, 6-13

PSC single-fibre port
subrack, 6-11

Interface Unit
See: IU

interfaces, system, 1-8

internal clock

information about,
13-10

provisioning, 13-26

International
Telecommunications
Union
See: ITU MSP

Interval field

TCA Control Query
Results window, 10-29

TCA Control window,
10-27

TCA Thresholds Query
Results, 10-42

TCA Thresholds
window, 10-39

INTFcEQ alarm

addresses, 3-19

IT% field

High Order Path Query
Results window, 8-28

High Order Path
window, 8-25

Low Order Path Query
Results window, 8-35

Low Order Path
window, 8-33

Port window, 8-9

IT% Threshold field, 8-12

ITU MSP, information
about, 9-7

IU

in PSA subrack, 1-29

IU types and MSP groups,
9-10

........................................................

K keys used for editing,
navigating, and shortcuts,
2-20

........................................................

L LAN Hub Unit
See: LHU

LAN IS-IS Level field

DCN Query Results
window, 14-29

Laser field, 8-13

laser shutdown

enabling or disabling,
8-15

Layer field, 5-14

LEDs

on User Panel, 1-20

LHU

MC subrack, 1-19

Line Restore Time, 9-9

Line Restore Time
changing, 9-35

Line Restore Time field

MSP Group Query
Results window, 9-31

MSP Group window,
9-28

link failure message, 2-2

....................................................................................................................................................................................................................................
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logging off the system, 2-6

logging on to the system,
2-4

Login Administration
Query Results window

field descriptions, 17-9

graphic of, 17-9

Login Administration
window

field descriptions, 17-6

graphic of, 17-6

Login ID field

Change Password
window, 16-2

Login Administration
Query Results window,
17-9

Login Administration
window, 17-6

Login window, 2-4

Login ID provisioning

changing your
password, 16-3

querying, 17-8

Login window

field descriptions, 2-4

graphic of, 2-4

loopback cross connect
provisioning, 4-13

Low Order Path Query
Results window

field descriptions, 8-35

graphic of, 8-35

Low Order Path window

field descriptions, 8-32

graphic of, 8-32

low order trails

inherently-monitored
trails, 9-23

nonintrusively-
monitored trails, 9-24

with SNCP, 9-22

lower order path
provisioning

changing, 8-37

querying, 8-34

LP signal monitoring
provisioning, 5-19

........................................................

M M (seconds) field, 8-12

M field

High Order Path Query
Results window, 8-28

High Order Path
window, 8-25

Low Order Path Query
Results window, 8-35

Low Order Path
window, 8-33

Port window, 8-9

main application window,
2-10

Main Controller

entity addresses, 3-11

information about
control system, 1-6

information about
provisioning, 6-3

Main Controller subrack,
1-17

Main Processor Unit
See: MPU

Maintenance menu, 2-11

Manual Restart button,
2-18

Manual Restart for Test
button, 2-18

Mass Storage Unit
See: MSU

Matrix and Control rack
description, 1-16

Matrix and Synchronisation

entity addresses, 3-12

information about
provisioning, 6-3

Matrix and Synchronisation
rack, 1-12

Matrix and Synchronisation
subrack, 1-13

Matrix Protection field,
9-50

MC and PC clock
alignment, 2-3

MC subrack
See: Main Controller

MCLAN hub ports, 6-4

MD IN connector on the
FCP, 1-25

MD inputs and outputs,
11-10

MD OUT connector on the
FCP, 1-25

MDI 1 through 4
connectors on the FCP,
1-25

MDIs and MDOs, 11-10

menu bar

on main application
window, 2-10

on query results
windows, 2-14

messages, general
information about, 2-22

MISC DISCRETES
connector on the ACP,
1-24

miscellaneous discrete
alarm

indicators, 11-10

Mode field, 5-10

model queries, 15-3

....................................................................................................................................................................................................................................
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MON field

Port Monitoring
window, 5-7

Signal Monitoring
window, 5-14

monitoring control
provisioning

general information
about, 5-3

provisioning process,
5-5

Monitoring Control…
button

from Port, Signal Type,
and High Order Path
windows, 8-4

general information
about, 2-18

Monitoring Mode field

SNCP Group Query
Results window, 9-41

SNCP Group window,
9-38

MPU

in MC subrack, 1-18

MS PM threshold values,
10-12

MS signal monitoring
provisioning, 5-18

MSP addresses, 3-17

MSP Group ID field, 9-28

Data Communication
Channel in MSP Mode
Query Results window,
14-14

MSP group provisioning

changing the Line
Restore Time, 9-35

creating, 9-32

deleting, 9-34

information about, 9-10

querying, 9-30

MSP Group Query Results
window

field descriptions, 9-31

graphic of, 9-31

MSP Group window

field descriptions, 9-28

graphic of, 9-28

MSP groups

about MSP types, 9-7

information about, 9-5

terms, 9-3

MSU

in MC subrack, 1-18

multi-point cross connect
provisioning, 4-11

Multiplex Section
Protection group
See: MSP groups

Multiplexing field, 6-29
........................................................

N navigating with keys, 2-20

NE IS-IS Level field

DCN Query Results
window, 14-29

Near End fields, 10-27

Near End Thresholds
fields, 10-39

Network Element field, 2-4

Network Interface Chip
TM, 1-19

network interfaces, 1-8

New From ID field, 4-17

New Password field

Change Password
window, 16-2

Login Administration
window, 17-7

NE_BBE field

TCA Control Query
Results window, 10-30

TCA Thresholds Query
Results window, 10-43

NE_ES field

TCA Control Query
Results window, 10-30

TCA Thresholds Query
Results window, 10-43

NE_SES field

TCA Control Query
Results window, 10-30

TCA Thresholds Query
Results window, 10-43

NE_UAS field

TCA Control Query
Results window, 10-30

TCA Thresholds Query
Results window, 10-43

Nippon Telephone and
Telegraph MSP,
information about, 9-7

NMON field

Port Monitoring
window, 5-7

Signal Monitoring
window, 5-14

No Change field, 12-17

Non-Service-Affecting
Severity field, 12-4

Non-Suppressible field,
12-17

nondisconnectable station
alarm indicators, 11-9

None field, 13-28

nonintrusive SNCP
monitoring, 9-13

nonintrusively-monitored
trails, 9-24

normal signal, 8-25

....................................................................................................................................................................................................................................
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NSAP Format field

DCN Query Results
window, 14-29

NTT MSP

information about, 9-7
........................................................

O OAM and P interfaces, 1-8

Old Password field, 16-2

OLU

in Matrix and
Synchronisation
subrack, 1-14

Operations, Administration,
Maintenance, and
Provisioning interfaces,
1-8

Operator class, 17-3

optical fibre cable
addresses, 3-19

Optical Link Unit
See: OLU

........................................................

P password

administrator changing
a user’s, 17-13

changing your
password, 16-3

Password field, 2-4

pasting information in a
field, 2-20

PC and MC clock
alignment, 2-3

PC booting, 2-2

PC connected to name,
displaying, 2-7

PC for user interface, 2-2

PC information, 2-2

PC provisioning

setting DACS to PC
date and time, 18-6

setting to DACS date
and time, 18-5

performance monitoring

definitions, 10-4

frequently-asked
questions, 10-6

list of tasks, 10-3

monitored signals and
differences between
them, 10-8

MS threshold values,
10-12

process flowchart, 10-7

RS threshold values,
10-11

VC-12 threshold values,
10-10

VC-3, VC-4, and
VC-4-4c threshold
values, 10-9

performance monitoring
and protection switching,
10-6

permissions for access
classes, 17-4

phaselocked mode, 13-5

physical layer addresses,
3-3

PM Count Control field

Count Control Query
Results window, 10-18

Count Control window,
10-16

Port field

Station Clock window,
13-28

System Clock window,
13-14

Port ID field

Data Communication
Channel Query Results
window, 14-8

Port ID, information about,
3-3

port monitoring
provisioning

assigning values for
monitoring control
mode, 5-11

querying, 5-9

Port Monitoring Query
Results window

field descriptions, 5-10

Graphic of, 5-10

Port Monitoring window

field descriptions, 5-7

graphic of, 5-7

Port Query Results window

field descriptions, 8-12

graphic of, 8-12

port rack, description and
illustration, 1-27

port subracks

PSA, 1-28

PSC, 1-30

port transmission
provisioning

changing, 8-14

querying, 8-11

Port window

field descriptions, 8-9

graphic of, 8-9

POWER LED on User
Panel, 1-20

Power Terminal Modules
See: PTMs

Pre-Service Timer field,
12-13

preventing the selection of
system clock input
reference, 13-10

....................................................................................................................................................................................................................................
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Primary ID field

SNCP Group window,
9-37

Primary Port ID field, 9-40

Primary Signal ID field,
9-40

Print button, 2-18

priorities and
synchronisation, 13-10

Priority field, 13-18

PROMPT LED on User
Panel, 1-20

Protect STU Input field,
13-30

Protect STU Output field,
13-31

protection bridge for SNCP,
9-26

Protection menu, 2-11

Protection Switch Control
button

general information
about, 2-18

Protection Switch Status
field, 13-20

protection switching
information

and performance
monitoring, 10-6

and synchronisation,
13-10

definitions for
provisioning MSP, 9-3

definitions for
provisioning SNCP,
9-12

provision

Data Communication
Channel in MSP Mode,
14-12

Provision menu, 2-10

provisioning

Data Communication
Network parameters,
14-27

PSA dual-fibre port
subrack configurations,
6-10

PSA entity addresses, 3-13

PSA port subrack, 1-28

PSA single-fibre port
subrack configurations,
6-9

PSC dual-fibre port
subrack configurations,
6-12

PSC entity addresses, 3-14

PSC port subrack, 1-30

PSC quad-fibre port
subrack configurations,
6-13

PSC single-fibre port
subrack configurations,
6-11

PTMs

in Matrix and
Synchronisation
subrack, 1-14

in PSA subrack, 1-29

in PSC subrack, 1-31

PWR connector on the port
rack fan tray connector
panel, 1-32

........................................................

Q QLAN link

querying, 14-22

QLAN Link Query Results
window

field descriptions, 14-23

QLAN Link Status field

QLAN Port Query
Results window, 14-23

QLAN Link window

field descriptions, 14-21

graphic of, 14-21

quad-fibre PSC subracks

and MSP groups, 9-10

configurations, 6-13

Query Active button, 2-18

Query button, 2-18

Query From ID button,
2-18

Query NE Date/Time
button, 2-18

Query PC Date/Time
button, 2-18

Query Port button, 2-18

query results, general
description of, 2-14

Query Standby button, 2-18

Query To ID button, 2-18

querying

AIS, 4-35

alarm severity levels,
12-5

alarm suppress status,
12-18

alarm timer values,
12-14

Computed Area
Address, 14-30

count control for
performance
monitoring, 10-17

cross connects, 4-8

Data Communication
Channel, 14-7

Data Communication
Channel in MSP Mode,
14-13

database backup, 15-3

date and time, 18-3

....................................................................................................................................................................................................................................
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DCN, 14-28

DCN neighbor nodes,
14-18

EOW and user channel,
7-5

frame ID, 15-3

higher order path, 8-27

Login ID, 17-8

lower order path, 8-34

model, 15-3

MSP groups for
provisioning, 9-30

multiplexing structure
of transmission port,
8-19

port monitoring, 5-9

port transmission
parameters, 8-11

QLAN link, 14-22

rack, 6-16

signal monitoring and
alarm reporting, 5-15

signal type, 8-19

SNCP groups, 9-39

station clock, 13-29

status of STUs, 13-19

subrack, 6-26

system clock, 13-16

system ID, 15-3

TCA reporting for
performance
monitoring, 10-28

TCA threshold values
for performance
monitoring, 10-41

unit, 6-37

Wait-To-Restore timer
for matrix protection,
9-53

Wait-To-Restore timer
for STM-1 protection,
9-52

........................................................

R Rack ID field

Rack Query Results
window, 6-17

Rack window, 6-15

Subrack Query Results
window, 6-27

Subrack window, 6-23

Rack Location field

Rack Query Results
window, 6-17

Rack window, 6-15

rack provisioning

changing, 6-20

creating, 6-19

deleting, 6-21

process for deleting, 6-7

querying, 6-16

Rack Query Results
window

field descriptions, 6-17

graphic of, 6-17

RACK TOP 1 connector on
the ACP, 1-23

RACK TOP 2 connector on
the ACP, 1-23

rack top addresses, 3-18

Rack window

field descriptions, 6-15

graphic of, 6-15

rack-top alarm indicators,
11-9

racks

Matrix and Control
description, 1-16

Matrix and
Synchronisation
description and
illustration, 1-12

port rack description
and illustration, 1-27

RDI Active field, 5-14

RDI alarm reporting

information about, 5-3

turning on or off, 5-20

RDI Inactive field, 5-14

RDI Only field, 5-17

record update procedure,
2-16

record updates, 2-15

records, general
information about queries,
2-14

Reference ID field, 13-30

Reference Number field

System Clock Query
Results window, 13-17

System Clock window,
13-15

Remove button, 2-19

removing

multi-points
(bridges/broadcast)
from cross connects,
4-11

Reports menu, 2-11

Restore All button, 2-19

Restore button, 2-19

restoring

default severity levels,
12-10

ring architectures for
SNCP, 9-18

Roll button, 2-19

....................................................................................................................................................................................................................................
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rolling a cross connect

bidirectional roll of
bidirectional cross
connect, 4-23

in a network with active
service, 4-27

in a network with no
active service, 4-24

unidirectional roll of
bidirectional cross
connect, 4-20

unidirectional roll of
unidirectional cross
connect, 4-19

Router Priority field

DCN Query Results
window, 14-29

RS PM threshold values,
10-11

RS signal monitoring
provisioning, 5-18

........................................................

S Save Error Message button,
2-19

SCSI TM

in MC, 1-19

SDH Layer field, 5-16

Secondary ID field, 9-37

Secondary Port ID field,
9-40

Secondary Signal ID field,
9-40

Serial Number field

Unit Query Results
window, 6-39

Serial TM

in MC, 1-19

Series and Vintage field,
6-39

Service Affecting Severity
field

Severity Levels Query
Results window, 12-7

Severity Levels window,
12-4

service-affecting
conditions, 11-7

Set NE Date/Time button,
2-19

Set PC Date/Time button,
2-19

setting

DACS date and time to
PC, 18-6

PC date and time to
DACS, 18-5

severity level provisioning

changing severity
levels, 12-9

querying, 12-5

restoring default
severity levels, 12-10

Severity Levels Query
Results window

field descriptions, 12-7

graphic of for
equipment alarms,
12-6

graphic of for
transmission alarms,
12-7

Severity Levels window

field descriptions, 12-3

graphic of, 12-3

shortcut keys, 2-20

shortcuts to user interface
windows, 2-12

SID field

DCN Query Results
window, 14-29

Signal field

High Order Path Query
Results window, 8-28

High Order Path
window, 8-25

Signal ID field

general information
about, 3-4

graphical representation
of wideband signal,
3-8

table of signal layer
addresses, 3-4

signal layer addresses, 3-4

signal monitoring
provisioning

assigning AU, HP, TU,
and LP, 5-19

assigning RS and MS,
5-18

querying, 5-15

Signal Monitoring Query
Results window

field descriptions, 5-16

graphic of, 5-16

Signal Monitoring window

field descriptions, 5-13

graphic of, 5-13

signal type and entity ID
combinations for
specifying multiplexing,
3-4

Signal Type field

Connect Roll window,
4-17

Cross Connect window,
4-7

High Order Path
window, 8-24

Insert AIS window, 4-33
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Low Order Path
window, 8-32

Signal Type Query
Results window, 8-20

Signal Type window,
8-17

SNCP Group window,
9-37

signal type provisioning

changing, 8-22

general information
about, 8-4

information about
changing, 8-5

querying, 8-19

Signal Type Query Results
window

field descriptions, 8-20

graphic of, 8-20

Signal Type window

field descriptions, 8-17

graphic of, 8-17

signals, supervisory
unequipped and normal,
8-25

single node
interconnection, 9-18

single-fibre PSA subracks

and MSP groups, 9-10

configurations, 6-9

single-fibre PSC subrack
configurations, 6-11

SNCP

dual node
interconnection, 9-18

single node
interconection, 9-18

SNCP group provisioning

creating, 9-42

deleting, 9-48

querying, 9-39

SNCP Group Query Results
window

field descriptions, 9-40

graphic of, 9-40

SNCP Group window

field descriptions, 9-37

graphic of, 9-37

SNCP groups

and cross connect
provisioning, 9-26

configurations, 9-14

cross connect status for
provisioning, 9-26

higher order and lower
order trails, 9-22

hold-off timer, 9-25

information about, 9-13

inherent and
nonintrusive
monitoring, 9-13

protection bridge, 9-26

ring architectures, 9-18

terms, 9-12

TSF and TSD
conditions for
nonintrusively-
monitored trails, 9-24

TSF conditions for
inherently-monitored
trails, 9-23

what trails can be
protected, 9-21

SNCP/I
See: inherent SNCP

monitoring

SNCP/N
See: nonintrusive SNCP

monitoring

socket failure message, 2-2

sorting query records, 2-14

SRC

in Matrix and
Synchronisation
subrack, 1-13

in PSA subrack, 1-28

in PSC subrack, 1-30

starting

counts for performance
monitoring, 10-20

TCA reporting when
parameters are
enabled, 10-33

TCA reporting when
parameters are
inhibited, 10-31

STATION ALARM
connector on the ACP,
1-23

station alarm indicators

information about, 11-9

Station Clock 1 field,
13-14

Station Clock 2 field,
13-14

station clock information

about assigning output
timing references, 13-8

cable connections, 13-3

station clock provisioning

assigning system clock
as timing reference
for, 13-32

assigning transmission
port as timing
reference for, 13-33

changing timing
reference for, 13-34

querying, 13-29

Station Clock Query
Results window

field descriptions, 13-30

graphic of, 13-30
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Station Clock window

field descriptions, 13-28

graphic of, 13-28

Status field

DCN Query Results
window, 14-29

System Clock Query
Results window, 13-18

STM-1

in PSA subrack, 1-28

STM-16, 1-30

STM-4, 1-30

STM1 Protection field,
9-50

structure of user interface,
2-8

STU

in Matrix and
Synchronisation
subrack, 1-13

STU field, 13-20

STU status queries, 13-19

STU Status Query Results
window

field descriptions, 13-20

graphic of, 13-20

STUs, types of, 13-7

Sub-Network Connection
Protection
See: SNCP groups

Subrack Configuration field

Subrack Query Results
window, 6-28

Subrack window, 6-24

subrack configurations

PSA dual-fibre, 6-10

PSA single-fibre, 6-9

PSC dual-fibre, 6-12

PSC quad-fibre, 6-13

PSC single-fibre, 6-11

Subrack Controller
See: SRC

subrack controllers, 1-6

subrack degrade inhibit

enabling or disabling,
6-34

information about, 6-5

Subrack Degrade Inhibit
button, 2-19

Subrack ID field

Computed Area Address
Query Results window,
14-31

DCN Query Results
window, 14-29

QLAN Link Query
Results window, 14-23

Subrack Position field

Rack Query Results
window, 6-18

Subrack Query Results
window, 6-28

Subrack window, 6-24

subrack provisioning

creating, 6-30

deleting, 6-32

process for adding to an
existing rack, 6-7

process for deleting, 6-7

querying, 6-26

Subrack Query Results
window

field descriptions, 6-27

Subrack Type field

Rack Query Results
window, 6-17

Subrack Query Results
window, 6-27

Subrack window

field descriptions, 6-23

graphic of, 6-23, 6-27

subracks

Main Controller
description and
illustrations, 1-17

Matrix and
Synchronisation
description and
illustrations, 1-13

PSA port subrack
description and
illustrations, 1-28

PSC port subrack
description and
illustrations, 1-30

Supervisor class, 17-3

supervisory unequipped
signal, 8-25

SUPPRESSED switch on
User Panel, 1-21

Suppressible field, 12-17

suppressing

alarm indicators,
information about,
11-12

Switching Mode field

SNCP Group Query
Results window, 9-41

SNCP Group window,
9-38

Switching Type field

MSP Group Query
Results window, 9-31

MSP Group window,
9-29

synchronisation and timing

about assigning
priorities, 13-10
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about assigning station
clock output timing
references, 13-8

about assigning system
clock input timing
references, 13-7

about changing a timing
reference, 13-11

capabilities, 1-9

cross-couple link, 13-3

hardware, 13-3

how it works, 13-6

input references, 13-4

process, 13-12

station clock cable
connections, 13-3

timing modes, 13-5

system capacities, 1-5

system capacity, displaying,
1-5

system clock

about assigning input
timing references, 13-7

about assigning
priorities, 13-10

about changing a timing
reference, 13-11

System Clock field, 13-28

system clock provisioning

assigning station clock
as timing reference
for, 13-22

assigning transmission
port as timing
reference for, 13-23

changing priority of
timing reference for,
13-24

deleting timing
reference, 13-25

querying, 13-16

System Clock Query
Results window

field descriptions, 13-17

graphic for the active
STU window, 13-17

graphic for the standby
STU window, 13-17

System Clock window

field descriptions, 13-14

graphic of, 13-14

system clock, forcing or
preventing selection of
timing reference, 13-10

system description, 1-3

System ID field, 15-2

system ID provisioning

changing, 15-4

querying, 15-3

System ID window

field descriptions, 15-2

graphic of, 15-2

system interfaces, 1-8

system messages, general
information about, 2-22

system name, displaying,
2-7

........................................................

T TCA Control Query Results
window

field descriptions, 10-29

graphic of, 10-29

TCA Control window

field descriptions, 10-26

graphic of, 10-26

TCA reporting provisioning

inhibiting, 10-35

querying, 10-28

starting when
parameters are
enabled, 10-33

starting when
parameters are
inhibited, 10-31

TCA threshold value
provisioning

changing, 10-44

querying, 10-41

TCA Thresholds Query
Results window

field descriptions, 10-42

graphic of, 10-42

TCA Thresholds window

field descriptions, 10-38

graphic of, 10-38

TCP/IP, 1-8

thresholds

choosing meaningful
PM, 10-6

MS values, 10-12

RS values, 10-11

VC-12 values, 10-10

VC-3, VC-4, and
VC-4-4c values, 10-9

Time field

Date and Time
Administration
window, 18-2

time out messages, 2-22

time provisioning

changing, 18-4

querying, 18-3

setting DACS to PC,
18-6

setting PC to DACS,
18-5

timers (alarm) provisioning

changing, 12-15
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querying, 12-14

Timers window

field descriptions, 12-12

graphic of, 12-12

timing
See: synchronisation and

timing

Timing Mode field, 13-20

timing modes

information about, 13-5

priorities and, 13-10

timing reference
provisioning

assigning station clock
for the system clock,
13-22

assigning system clock
for the station clock,
13-32

assigning transmission
port for system clock,
13-23

assigning transmission
port for the station
clock, 13-33

changing for the station
clock, 13-34

changing priority of,
13-24

deleting for the system
clock, 13-25

timing references

about assigning
priorities, 13-10

about assigning station
clock output, 13-8

about assigning system
clock input, 13-7

about changing, 13-11

forcing or preventing
selection of, 13-10

Timing Source field, 13-18

To ID field

Connect Roll window,
4-17

Cross Connect window,
4-7

Insert AIS window, 4-33

To Port ID field, 4-9

To Signal ID field, 4-9

toolbar

Help Topics window,
2-23

Main Application
window, 2-12

trail of lights, 11-8

Trail Signal Degrade

and SNCP, 9-13

conditions for
nonintrusively-
monitored trails, 9-24

Trail Signal Fail

and SNCP, 9-13

conditions for
inherently-monitored
trails, 9-23

conditions for
nonintrusively-
monitored trails, 9-24

Trail Type field

Count Control window,
10-15

TCA Control window,
10-26

TCA Thresholds
window, 10-38

trails

information about, 9-13

monitoring for SNCP,
9-13

what can be protected,
9-21

Transition Module, 1-19

transmission alarms

changing severity
levels, 12-9

querying severity levels,
12-5

restoring default
severity levels, 12-10

transmission defects or
failures, 11-3

Transmission field, 12-3

transmission port
multiplexing structure

changing, 8-22

querying, 8-19

transmission provisioning

definitions, 8-3

provisioning parameters,
8-7

Transmit PTI field, 8-29

Transmit PTI Mode field,
8-29

Transmitted PTI field, 8-26

Transmitted PTI Mode
field, 8-25

TSD
See: Trail Signal Degrade

TSF
See: Trail Signal Fail

TU signal monitoring
provisioning, 5-19

turning on or off

AIS or RDI alarm
reporting, 5-20

audible autonomous
message indicator,
19-4

........................................................

U Uni-Directional field

Connect Roll window,
4-17

....................................................................................................................................................................................................................................

365–367–512
Issue 2, July 2002

Lucent Technologies I N D E X
I N - 1 9



Cross Connect window,
4-7

unidirectional SNCP
configurations, 9-14

unit provisioning

deleting port units, 6-40

process for adding to an
existing rack and
subrack, 6-7

process for deleting, 6-7

querying, 6-37

Unit Qualifier field, 6-39

Unit Query Results window

field descriptions, 6-38

graphic of, 6-38

Unit Status field

Unit Query Results
window, 6-38

Unit window

field descriptions, 6-36

graphic of, 6-36

units

BSSU information, 1-15

in Main Controller
subrack, 1-17

in Matrix and Control
rack, 1-16

in Matrix and
Synchronisation
subrack, 1-13

in PSA subrack, 1-28

in PSC subrack, 1-30

Update button, 2-19

Update button and menu
item on query results,
2-15

updating records, 2-15

updating records from a
query procedure, 2-16

user channel

changing, 7-8

querying, 7-5

user channel concepts, 7-2

User Channel field, 7-4

user ID

adding, 17-10

changing, 17-11

deleting, 17-12

user interface structure, 2-8

User Name field

Login Administration
Query Results window,
17-9

Login Administration
window, 17-7

User Panel

description and
illustration, 1-20

LEDs, switches, and
connectors on, 1-20

USER PANEL connector
on the ACP, 1-24

user-interface PC, 2-2

users interface sessions,
number of, 2-2

Utilities menu, 2-11
........................................................

V V.28 connections, 1-8

V.28 connectors on User
Panel, 1-21

VC-12 PM threshold
values, 10-10

VC-3, VC-4, and VC-4-4c
PM threshold values, 10-9

View Results button, 2-19
........................................................

W Wait To Restore Time field,
9-50

Wait to Restore Time field

SNCP Group Query
Results window, 9-41

SNCP Group window,
9-38

Wait To Restore Timer
window

field descriptions, 9-50

graphic of, 9-50

Wait-To-Restore timer

changing for matrix
protection, 9-55

changing for STM-1
protection, 9-54

querying for matrix
protection, 9-53

querying for STM-1
protection, 9-52

wildcard addresses, 3-9

windows

Alarm Suppress
Control, 12-17

Autonomous Message
Indicator, 19-3

Change Password, 16-2

Connect Roll, 4-16

Count Control, 10-15

Count Control Query
Results, 10-18

Cross Connect, 4-6

Cross Connects Query
Results, 4-9

Data Communication
Channel, 14-4

Date and Time
Administration, 18-2

DCC in MSP Mode
Provision, 14-10

DCN Neighbor Nodes,
14-16
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EOW / User Channel,
7-3

EOW / User Channel
Query Results, 7-6

High Order Path, 8-24

High Order Path Query
Results, 8-28

Insert AIS, 4-33

Login, 2-4

Login Administration,
17-6

Login Administration
Query Results, 17-9

Low Order Path, 8-32

Low Order Path Query
Results, 8-35

main application
window, information
about, 2-10

MSP Group, 9-28

MSP Group Query
Results, 9-31

paths to all, 2-8

Port, 8-9

Port Monitoring, 5-7

Port Monitoring Query
Results, 5-10

Port Query Results,
8-12

QLAN Link, 14-21

Rack, 6-15

Rack Query Results,
6-17

Severity Levels, 12-3

Severity Levels Query
Results for equipment
alarms, 12-6

Severity Levels Query
Results for
transmission alarms,
12-7

shortcuts to, 2-12

Signal Monitoring, 5-13

Signal Monitoring
Query Results, 5-16

Signal Type, 8-17

Signal Type Query
Results, 8-20

SNCP Group, 9-37

SNCP Group Query
Results, 9-40

Station Clock, 13-28

Station Clock Query
Results, 13-30

STU Status Query
Results, 13-20

Subrack, 6-23, 6-27

System Clock, 13-14

System Clock Query
Results for the active
STU, 13-17

System Clock Query
Results for the standby
STU, 13-17

System ID, 15-2

TCA Control Query
Results, 10-29

TCA Control Tests,
10-26

TCA Thresholds, 10-38

TCA Thresholds Query
Results, 10-42

Timers, 12-12

Unit, 6-36

Unit Query Results,
6-38

Wait To Restore Timer,
9-50

Working STU Input field,
13-30

Working STU Output field,
13-31

WS1 and WS2 connectors
on User Panel, 1-21

WTR Timer button, 2-19
........................................................

X XC-CIT, 2-2
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